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1. About

1.1. Purpose of the document

This document contains detailed information about features of the PHOTOMOD system.
This document contains general information about system, instructions for installing
and setting up, and also preparing to work with the system. There are hardware require-
ments, projects workflow and brief description of modules and additional programs. It
describes work with additional tools for work in stereo mode, features of distributed
processing and also setting up of hotkeys.

1.2. Set of documentation

Besides this document there are user manuals in the set of documentation. These user
manuals contain instructions of different processes while working in the system.

Table 1. Full set of documentation for the system

Document Filename Function
Index contents.pdf the list of user manuals and their correspondence to system
modules and programs
General information this documents which contains detailed information about
about system system capabilities
The GeoCalculator geocalc.pdf description of program to recalculate geodetic coordinates of
program points from one coordinate system to another and also to
create and edit coordinate systems or its parameters
General system’s settings.pdf description of the Parameters window which allows to setup
parameters general system'’s parameters
Creating project project.pdf description of project creation stage: adding of images in a

project, their radiometric correction, forming and editing of
images block, manage of images in the system

Aerial triangulation | measurement.pdf |description of aerial triangulation stage, includes interior orient-
ation of block images, measurement of tie points coordinates
on images, relative orientation of block images, as well as input
of ground control points (GCP) coordinates to catalogue and
measurement of these points coordinates images or their im-
port and using exterior orientation data

Block adjustment solver.pdf description of block adjustment stage: features of central pro-
jection and satellite scanner imagery blocks adjustment, ad-
justment accuracy control

Vectorization vectorization.pdf |description of project processing stage — vectorization: pro-
cessing of vector layers with/without classifier, features of
creating and editing of vector layers, topology verifying and
also import/export of vector objects

DTM Generation DEM.pdf description of project processing stage — DTM creation: pro-
cessing of points layers, TIN, contours and DEM, features of
DTM creation based on these layers



1_Contents.pdf
1_Contents.pdf
geocalc.pdf
geocalc.pdf
geocalc.pdf
settings.pdf
settings.pdf
settings.pdf
project.pdf
project.pdf
measurement.pdf
measurement.pdf
solver.pdf
solver.pdf
vectorization.pdf
vectorization.pdf
DEM.pdf
DEM.pdf
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Document Filename Function
Three-dimensional 3d-mod.pdf description of project processing stage — 3D-modeling: creation
modeling of 3D-models based on vector objects, their export and editing
LIDAR data pro- lidar.pdf description of the lidar data processing: loading of lidar data,
cessing view modes, cutting for sheets and creation of DTM based on
lidar data
Neural processing neural.pdf description of the module installation, representative sampling
of LIDAR data from the total data set, point cloud classifier learning, point
cloud classification
Processing of UAS uas.pdf description UAS data processing: creation of UAS project,
data image block forming, interior orientation of block images,
automatic measurement of tie points coordinates on images,
relative orientation of block images, and also image block ad-
justment
Orthorectification ortho.pdf description of project processing stage — orthomaps building,
accuracy control of orthomap creation and also export of ob-
tained data
Orthophotomaps geomosaic.pdf |description of project processing — merge the georeferenced
creation orthorectified imagery: creation of mosaic project, loading of
source images, image block forming, image brightness adjust-
ment, creation of cutlines, stitching images using tie points,
building orthophoto and its accuracy control
ScanCorrect sccor.pdf description of compensation of metric errors occurred when
scanning graphical data on flatbed polygraphic scanners
Hotkeys hotkeys.pdf description of hotkeys available to use in the system
EGM2008 Geoid in-| install_egm.pdf |description of the Geoid EGM2008 installation to use it in the
stallation system
StereoMeasure | stereomeasure.pdf |description of the StereoMeasure software module and
Forestinterpretation program
1.3. Help

User Manual is available in the system.

User Manual is a set of documents with detailed information of project processing stages
and about working of additional programs and modules.

To use the help system, choose the Help » Help index in the main system’s window
or press F1. The Use Manual opens. It is a PDF-file contains a table with available

files.

A

To view the documentation set any software with support of PDF-file is required.

Some windows of the system contains tool tips. To obtain additional information, move
the mouse to one of the following icons:

« [@ — tool tip — additional information;
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install_egm.pdf
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« ¥ —warning — important note about process or function.

To obtain additional information in the information window, click on one of the following
icons:

« & — error — incorrect result of any process:

« ¥ — warning — information about available processes;

« Lii—important information — note or tip;

. — additional information -- e.g., elapsed time of operation.

1.4. Abbreviations and acronyms

Through this User Manual the following abbreviations and acronyms are used:

2D and 3D (2/3 dimensional) — object/window which has tow or three dimensions (co-
ordinates);

DEM - Digital Elevation Model;

DLT - Direct Linear Transformation;

dpi — dots per inc;

GPS - Global Positioning System;

GSD (Ground Sample Distance) — a pixel size on ground;

GCP (Ground Control Point) — a point with known geodetic coordinates and which is a
source point in aerial triangulation;

HSV - color model, Hue, Saturation, Value;

HTML (HyperText Markup Language) — is the standard markup language used to create
web pages.

ID — unique identifier;

IP-address (Internet Protocol Address) — is a numerical label assigned to each device
(e.g., computer, printer) participating in a computer network that uses the Internet Pro-
tocol for communication.

LZW (Lempel-Ziv-Welch) — is a lossless data compression algorithm;

RGB - color model based on three colors: Red, Green, Blue;
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RPC (Rational Polynomial Coefficients) —is a sensor model commonly used to determine
the ground coordinates of pixels in high resolution satellite imagery;

TIN — Triangulation Irregular Network;
WGS - is a standard the World Geodetic System;

WMS — Web Map Service, is a standard protocol for serving georeferenced map images
over the Internet that are generated by a map server using data from a GIS database;

DB — data base;

UAS - Unmanned Aircraft Systems;
GIS - geoinformation system;

RSD - remote sensing data;

pix — pixels;

CS - coordinate system;

RMS - root mean square;

DTM — Digital Terrain Model.

1.5. Main conventions and terms

Through this User Manual various conventions and terms are used to describe processes
and objects, which are used in the system.

There are the following terms on a step of data collection for aerial triangulation:
» Workstation — personal computer (operators place) with installed system;

* Aerial triangulation — is the mathematical process of establishing precise and accurate
relationships between the individual image coordinate systems and a defined datum
and projection (ground);

» Block layout — approximate scheme of terrain, obtained using projecting of matched
images of a block on specified surface (Earth surface) considering images overlaps,
relative position, rotation by angles in a space.

* In-strip stereopair is formed by two adjacent images in a strip;

* Inter-strip stereopair is formed by two adjacent images from different strips;




PHOTOMOD 8.1 General information about the system (Windows x64)

The active image — image displayed in the window selected by mouse click. The
active image window is highlighted by blue frame;

The ’left’ image — a status assigned to one of opened windows, that is considered
during stereopair opening and is used to correlate other images with this one during
measurement of tie points using correlator.

Exterior orientation parameters of image are geometric parameters of image, that
specify its position and orientation in relation to object of photogrammetric survey in
a moment of the survey. There are linear and angular exterior orientation parameters:

o Linear exterior orientation parameters of image — coordinates of center of optical
image projection in coordinate system of photogrammetric survey object;

o Angular exterior orientation parameters of image — parameters that define image
angular orientation in coordinate system of photogrammetric survey object, slope
and rotation angles of image.

Tie points — the same points on the terrain on adjacent block images needed to build
single models from stereopairs and then to merge them into triangulation networks.

Ground control point — a point with known geodetic coordinates and which is a source
point in aerial triangulation.

There are the following terms of vectorization on the project processing stage:

Vectorization is a process of creation vector objects on a vector layer;

Stereovectorization — an operation of terrain objects vectorization in stereo mode
using stereo model, that allows to create digital elevation models and 3D topographic
maps;

Stereo mode — a mode when each eye can see only one of two images, with stereo-
scopic effect as a result. It is used for stereo viewing of stereo model, and it is provided
by hardware devices and monitor technical features.

Pseudo-stereo — is a stereo mode, where orthogonal projection is used for left eye,
and for right eye — parallel projection with some angle to normal line. This mode allows
to display to raster layers as one stereo image;

Stereo model is generated using block stereopairs during adjustment operation;

Stereopair — two images of one object with overlap (for aero survey — near to 60%),
obtained from slightly different positions — with different positions of their centers of
optical image projection;
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Vector object — 2D or 3D-object of vector graphics, described by mathematical function
and belongs to one of the following objects types in the system:

o Point — a point object, which is determined by XY coordinates in the plane and by
XYZ coordinates in space;

o Polyline — a broken line or a curve, containing a set of vertices, joined by straight
or curve line pieces called segments;

o Polygon — an areal object, which boundaries are closed polyline;

CAD-objects — standard geometric figures, for example, ellipse, circle, rectangle, arc,
that are polylines or polygons;

Vertex — a point, connecting polyline or polygon segments;
Segment — a straight or curve line, connecting two vertices;

Fragment — a part of polyline/polygon, a set of adjacent vertices/segments of poly-
line/polygon;

The topology is referred to as set of functions and operations, that define mutual
location of vector objects and are used to create topologically correct vector data.

There are the following terms of DTM creation on the project processing stage:

Metadata — structured information about data in the image file;

DEM (Digital Elevation Model) — is digital cartographic representation of the earth’s
surface in the form of a regular grid of height values;

Triangulation Irreqular Network (TIN) — one of the models of spatially coordinated
data, used during designing of digital terrain model as elevation points in nodes of
irregular network of triangles, that corresponds to Delaunay triangulation;

Contour lines — vector lines, that connect points with the same terrain altitude;
Quasi-contours — isolines with specified step, which cross sides of TIN triangles;
Points — point vector objects, located on relief surface;

Pre-regions — vector layer which consists of polygons, drawn by images block;

Surges — all points not lying on the relief surface (average smoothed terrain surface);

There are the following terms on a orthophoto creation step:

10
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» Orthoimage is a georeferenced image prepared from a perspective photograph or
other remotely-sensed data in which displacement of objects due to sensor orientation
and terrain relief have been removed;

* Orthomosaic is an image created from source images during brightness adjustment
and merging georeferenced orthoimages;

+ Cutline is the boundaries of the specified area from the source image, which will be
included in the output mosaic.

» Sheet is an area of output mosaic to save in separate file (in output format). The
vector polygons are used for the cutlines creation;

» Global brightness adjustment means transformation equally applied to all pixels of
each source image;

» Local brightness adjustment is a transformation applied along cutlines of images that
are merged into mosaic with a smoothing going down to the image central point and
mosaic edges.

1.6. The table of symbols

Through this User Manual are used the following symbols to highlight one or other in-
formation.

Table 2. Symbols used in this documentation

Symbol Description

tip about capabilities of system

ﬁ notes from theory

warning with information about uncritical, but important consequences of actions

T caution with information about critical and important consequences of actions

1.7. About Racurs company

The Racurs company was founded in 1993. The main fields of application include
photogrammetric production, cadastral mapping, cartography and remote sensing,
academic photogrammetry, mining, architecture and construction.

PHOTOMOD was one of the first digital photogrammetric systems on the market that
was designated for working on PHOTOMOD PCs. At the present time PHOTOMOD is

11
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the most popular digital photogrammetric software in Russia and well known all over
the world.

Racurs company’s business mission is to provide the world-wide geospatial community
with advanced and cost-effective digital photogrammetry solutions and services for
creation of wide range of output products from the available remote sensing data.

The official web-site of the Racurs company www.racurs.ru contains the following in-
formation:

» the latest news;

* recent activity;

* report about software development;

* information about provided RSD;

* list of photogrammetric service;

« training courses schedule and contents;
+ free products and training data;

« articles and presentations;

1.8. Technical Support

The Racurs company technical support provides the actual information about system
functionality, characteristics, price and services.

For technical support use one of the following ways:

* e-mail: support@racurs.ru;

« phone: +7 (495) 720-51-27;

» mail: RACURS Co., Ul. Yaroslavskaya, 13-A, office 15, Moscow, Russia.

2. About system

2.1. Purpose of the system

Digital photogrammetric system PHOTOMOD (further — system) is a digital system
providing full photogrammetric production line from the aerial triangulation to output di-
gital terrain models, vector maps and orthomosaics.

12
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The system allows to obtain spatial information by images from different sensors, as
digital and plane cameras, satellite scanner systems, lidar and SAR.

The system has module structure. It allows to find the best set of modules to solve
current tasks.

One of the system features is possibility of distributed processing with additional work-
stations to speedup of different project processing steps.

2.2. Brief description of system features
The system provides the following main features:
 preliminary preparing of source images;

* images interior orientation;

* relative orientation of images;

* input and measurement of GCP coordinates;

* images exterior orientation;

» vectorization;

» stereo vectorization;

* building DEM;

 creating orthomosaic;

 creating digital map;

+ creating 3d-models.

3. Logical structure of the system

3.1. Workflow of project processing

The system has flexible structure, so it allows to find a module set to solve current type
of tasks.

Each system module is used to perform number of tasks in appropriate stage of project
processing.

13
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INPUT DATA
Camera parameters Import triangualation
Film images Digital images Scanner images Ground control points points, import
GPS data exterior orientation
| Scanned images |
| PHOTOMOD ScanCorrect |
v + Y h 4
l PHOTOMOD Raster Converter ‘
v v - v v v
‘ PHOTOMOD Core
Phototriangulation
h A
‘ PHOTOMOD Core
Adjustment
I PHOTOMOD Solver A I ‘ PHOTOMOD Solver § ‘

Project processing

PHOTOMOD DTM | l PHOTOMOD dDSM ‘ | PHOTOMOD StereoDraw PHOTOMOD Mosaic PHOTOMOD StereoMeasure GIS Panorama Mini

h 4 b4 v v v
TIN, DTM, DSM, 3D vector objects Orthophotomaps, Stereo interpretation L
contour lines Dense DSM with classifier TrueOrtho forest taxation Digital maps

OUTPUT DATA
Export

GIS, CAD, BIM, VR/AR and other systems

Fig. 1. Workflow of project processing
3.2. Brief description of modules and additional programs

The system consist of main program shell, main modules, additional modules and also
stand-alone programs.

PHOTOMOD Core is the main program shell. Main features of PHOTOMOD Core are
creating and managing of project, image block forming, managing of project cameras
(see details in the “Project creation“User Manual).

The system consist of the following main modules:

* PHOTOMOD Raster Converter — allows to convert raster images to an inner MS-
TIFF format without or with JPEG or LZW compression and also to convert MS-TIFF
files to another formats (see Section 10).

* PHOTOMOD AT — allows to collect data for aerial triangulation workflow. The data
collection process in the module consists of the following stages:

14
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o images interior orientation;
o input and measurement of GCP coordinates;
o measurements of tie points in areas of forward and lateral overlap;

o parameters of images interior orientation calculation (see detailed description in
the “Aerial triangulation” User Manual).

« PHOTOMOD SolverA — allows to adjust central projection image blocks, view results
and perform an accuracy control (see the “Block adjustment” User Manual).

« PHOTOMOD SolverS — allows to adjust scanner image blocks, view results and
perform an accuracy control (see the “Block adjustment” User Manual).

* PHOTOMOD Geomosaic — is used to merge the georeferenced orthorectified aero
and space images and create the orthomosaic from them, cutting it for sheets and
saving output files.

Output data could be in TIFF, BMP, RSW, GeoTIFF, ERDAS Imagine, NITF, JPEG,
PNG, DGN, JP2, PIX or PRF files. Georeference file could be saved in PHOTOMOD
Geo, TWF and Mapinfo TAB formats (detailed description see in the “Orthophotomaps
creation” User Manual).

+ PHOTOMOD ScanCorrect — allows to correct metric errors occurred when scanning
graphical data on flatbed polygraphic scanners. Transformation of raster data consid-
ering scanner’s disturbances field is used for errors compensation. Scanner’s disturb-
ances field is created using raster data obtained by scanning calibrated material
(regular grid or regular set of crosses).

Input and output data are raster images in TIFF or BMP files. Detailed description
see in the “ScanCorrect program” User Manual.

* PHOTOMOD StereoDraw — allows to create and edit 3d-vector objects in stereomode
with classifier. These 3D vector objects could be used to create digital maps, as a
base-layer for DTM creation in the PHOTOMOD DTM module (detailed description
see in the “Vectorization” User Manual)

« PHOTOMOD 3D-Mod — allows to create and edit 3D terrain models by vectors with
classifier (see the “3D-modeling” User Manual).

« PHOTOMOD DTM, PHOTOMOD dDSM — are used to create DTM by points, TIN,
DEM and contours, edit it in mono and stereo modes and export for other formats
(see the “DTM Generation” User Manual).

Besides, the system includes the following service module:
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* PHOTOMOD System Monitor— allows to launch PHOTOMOD Core with double-click
on the £ icon in the Windows system tray and also allows to launch Explorer, Control
Panel module, Raster Converter, GeoMosaic and 3D-Mod program with the right-
click menu. The right-click menu also allows to start the distributed processing control
center, to choose an active profile (to the next work session), to setup mouse config-
uration and to obtain information about system version, serial number,build date and
contains of the system (list of used modules) (see Section 9.5).

« PHOTOMOD Control Panel — allows to manage system resources, to organize of
local or network processing (see Section 9.2.1).

* PHOTOMOD Explorer— allows to change active profile resources of the system (see
Section 9.4).

* PHOTOMOD ParProc — is an extra license for distributed computing on 1 PC (see
Section 12);

g The limit on the number of computers used in distributed computing is no more than one. To
use more than one PC, user need an extra PHOTOMOD ParProc license.

If PHOTOMOD ParProc licenses are available, the number of computers simultaneously in-
volved in distributed computing increases by the number of PHOTOMOD ParProc licenses.

* PHOTOMOD DiPro — is an extra license for distributed computing for 20 cores (see
Section 12);

The limit on the number of processor cores used in distributed computing is no more than
20. To use more than 20 cores, user need an extra PHOTOMOD DiPro license.

If an extra PHOTOMOD DiPro license is available, the number of workstation cores simultan-
eously involved in distributed processing increases by another 20.

* PHOTOMOD ImageWizard is used to matching project images with raster files, as
well as control of correctness of this matching, allows to build pyramids, and perform
images radiometric correction (see the “Project creation” User Manual).

» Camera editor — allows to define passport data for digital or film camera to use them
in a project.

é To launch the module choose Start » Programs » PHOTOMOD 8 x64 > Camera editor.

Besides, the system includes the following stand-alone programs used for work with
coordinate systems and georeferencing:
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PHOTOMOD GeoCalculator — allows to recalculate geodetic coordinates of points
from one coordinate system to another and also to create and edit coordinate systems
or its parameters (see the details in the “GeoCalculator” User Manual).

@ The GeoCalculator program also allows to edit coordinate systems, to create new ones, to
perform import and export of coordinate systems.

Calculation of datum parameters — allows to calculate parameters of datum using
two set of identical points in different coordinate system. In each set should be at
least 3 points. These parameters include scale, 3 angular rotation parameters, 3 linear
offset parameters.

Calculation of projection parameters — allows to determine the unknown parameters
of the Gauss-Krueger projection. It is necessary that the initial data be assigned to
the same ellipsoid with the same orientation.

Direct Georeferencing — allows to estimate accuracy assessment of terrain measure-
ments based on information about survey (flying altitude, overlap, camera parameters)
and specified accuracy of exterior orientation parameters.

And also, the system includes the software products used for solving forest taxation
tasks (see the “StereoMeasure software module” User Manual):

PHOTOMOD StereoMeasure software module — a software product, created on basis
of PHOTOMOD digital photogrammetric system, and used for stereo interpretation
and solving of forest taxation tasks. PHOTOMOD StereoMeasure software module
includes PHOTOMOD Core (control shell of the digital photogrammetric system that
is used to create, edit, import/export of vector objects without a classifier), and
PHOTOMOD StereoWindow module (a window used to view, interpret, measure and
vectorize objects in stereo mode by space and airborne data).

The Forestinterpretation program extends the range of options of the PHOTOMOD
system and the PHOTOMOD StereoMeasure module in analyzing the most meaningful
interpretation patterns of forest species based on probabilistic approach. It is designed
to specialists in sphere of remote sensing of forestry. The program is based on stat-
istical analysis of interpretation patterns, meaning that features of a particular tree
are correlated to those of a certain set that identifies a particular tree species and
age group.

To classify lidar point clouds using neural network algorithms, a special task-oriented
neural processing of LIDAR data module (PHOTOMOD Neuro) is developed. Itis to be
installed separately and designed to operate together with PHOTOMOD (see the
“Neural processing of LIDAR data” User Manual).

é PHOTOMOD version and build numbers must match the neural processing module number

exactly. Before the neural processing module installation, an automatic search for the folder
where PHOTOMOD is installed as well as the interoperability check are carried out.
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Clouds to be classified must contain the information on lidar point colors.

data (see the “Processing of UAS data” User Manual).

3.2.1.

7

Distribution info windows opens.

PHOTOMOD modules and PHOTOMOD licenses

Choose License info in the right-click menu of the System Monitor module (the & icon in the
Windows system tray). Process of licences checking starts. After checking, the PHOTOMOD

Table 3. PHOTOMOD licenses correspond to PHOTOMOD modules

PHOTOMOD module or Main features Licenses
program
PHOTOMOD Core |Creating and managing of project, data input, PHOTOMOD MD
operations with image’s block
PHOTOMOD AT Images interior orientation, input and measure- PHOTOMOD AT
ment of GCP coordinates, relative orientation
PHOTOMOD StereoWindow
PHOTOMOD SolverA |Adjustment of central projection image blocks PHOTOMOD SolverA

PHOTOMOD SolverS

Adjustment of scanner image blocks, pro-
cessing of ADS40/80/100 data

PHOTOMOD SolverS

PHOTOMOD DTM  |Creation DTM by points, TIN, DEM and con- PHOTOMOD DTM
tours
PHOTOMOD StereoWindow
PHOTOMOD dDSM |Generation of dense digital elevation model, PHOTOMOD Dense
LIDAR data processing DSM/DTM
PHOTOMOD Mosaic |Orthorectification images and orthoimages PHOTOMOD Mosaic
creation, image georeference, data transform- '
ation from one projection to another PHOTOMOD GeoMosaic
PHOTOMOD StereoDraw|Creation and editing vector objects in stereo-| PHOTOMOD StereoDraw
mode
PHOTOMOD StereoWindow

PHOTOMOD 3D-Mod

Creation and editing 3D terrain models

PHOTOMOD 3D-Mod

PHOTOMOD Stereo-

Interpretation patterns of forest species, forest

PHOTOMOD Forestinterpreta-

1PC

Measure taxation tion
PHOTOMOD StereoWindow
PHOTOMOD Neuro |Neural processing of LIDAR data PHOTOMOD Neuro
PHOTOMOD DiPro |An extra license for distributed computing for PHOTOMOD DiPro
20 cores
PHOTOMOD ParProc |An extra license for distributed computing on | PHOTOMOD ParProc 5.2
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PHOTOMOD module or Main features Licenses
program

PHOTOMOD GeoMosaic |Orthorectification images and orthoimages PHOTOMOD GeoMosaic
creation, merging the georeferenced orthorec-
tified aero and space images to create the or-
thomosaic from them, image georeference,
data transformation from one projection to an-
other

PHOTOMOD UAS |The complete cycle of unmanned aircraft sys- PHOTOMOD UAS
tem’s data processing. There is a limit on using
of the source data — only central projection
images with size not more than 100 Mpix.
Contains the following modules: Core, AT,
SolverA, DTM, dDSM, Mosaic, StereoDraw,
3D-Mod

3.3. Input and output data
3.3.1. Input data

During the project creation, aerial triangulation and block adjustment, the following
source data is used:

» Camera passport with interior orientation parameters to process central projection
images — image focal length and principal point coordinates.

For film cameras, depends on camera’s type, principal point coordinates could be
calculated by fiducial marks coordinates.

For digital cameras principal points coordinates are set in relation to center or corner
of image. Besides image focal length and principal points coordinates, the camera
passport also could consist data about lens distortion, which should be considered.

* The list of GCP coordinates is necessary for block adjustment. The system provides
opportunity to measure GCP coordinates manually and also to perform import of
GCP list from a text file.

* The list of projection centers coordinates to process central projection images. The
program also provides the ability to import on-board data (coordinates) about projection
centers from CSV files.

% Block adjustment could be process only by projection centers without using ground control
points. It is recommended to use GCP coordinates to increase adjustment accuracy.

* Raster images
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For working with images in program , it is recommended to use MS-TIFF internal
raster format, which is the TIFF format with overview pyramid (set of subsampled
images copies) for higher image display performance.

The Raster Converter module. It is possible to convertimage into internal format both
manually, before creating project, and on the stage of adding images into project with
saving converted images into active profile resources.

The following image formats are available to process central projection images:

o Tag Image File Format (TIFF) — images of TIFF, BigTIFF and GeoTiff formats, in-
cluding tags for saving of georeferenced information;

o Windows Bitmap File (*.bmp);

o VectOr Raster Maps (*. rsw) — images of Panorama software;
o ERDAS IMAGINE (*.1img) ERDAS system raster format;

o NITF (*.nitf);

o JPEG (*.]jpeg);

o GIF (*.gif);

o PNG (*.png);

o PCIDSK (*.pix) — raster format with georeference in the heading developed by
PCI Geomatics company;

o Phase One Intelligent Image Quality RAW format (*.11q);

o JPEG2000 (*.jp2) — raster format with JPEG compression and georeference in
the heading developed.

& The limitation on output file size of JPEG2000 format — no greater then 500 Mb.

* Information about coordinate system and map projection — during project creation it
is necessary to define coordinate system of GC points. By default there is an Interna-
tional coordinate system database and map projection (see the details in the 'Geo-
Calculator’ User Manual);

 also it is possible to use the following exterior data:

o import of triangulation points from PAT-B and X-POINTS;
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o import of ground control points from text files (*.txt, *.csv);

o import of interior and exterior orientation data from metadata;
o import of exterior orientation data from PAT-B and CSV-files;
o GPS data;

o import additional data from different formats.

To process satellite data in the system, ERS products with different processing level
are supported.

Table 4. Generic (DLT and it's modifications)

Satellite Format Processing | Stereo processing
level
ALOS (AVNIR-2) CEOS 1B2 No
Landsat 8 TIFF T No
Landsat7/ETM+ TIFF/GeoTIFF, HDF 1R, 1G No
IRS-1C, 1D/PAN Super Structured, HDF, Fast C 1A, 1B Yes, from the adjacent
passes
Resourcesat-1(IRS P6) Super Structured, HDF, Fast C 1,2 Yes
Resours-DK TIFF/GeoTIFF 0 No
Table 5. Rigorous algorithm
Satellite Format Processing | Stereo processing
level
EROS A, B RAW, TIFF 1A Yes
FORMOSAT-2 DIMAP 1A No
KazEOSat-1 DIMAP V2 1A Yes
KazEOSat-2 TIFF/GeoTIFF 1R, 1G Yes
KOMPSAT-2 TIFF/GeoTIFF 1R, 1G Yes
Resours-DK TIFF/GeoTIFF 0 Yes, from the adjacent
passes
SPOT 1-5 CEOS (SISA, CAP), DIMAP 1A Yes, same-pass
TERRA/ASTER HDF 1A Yes, same-pass
VNREDSAT1 TIFF 1A Yes
Table 6. RPC-algorithm
Satellite Format Processing | Stereo processing
level
ALOS (PRISM) CEQOS, GeoTIFF 1B1, 1B2 Yes, from the adjacent
passes
Armsat-1 TIFF/GeoTIFF 1D No
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Satellite Format Processing | Stereo processing
level
Cartosat-1, 2 (IRS P5) TIFF/GeoTIFF Orthokit Yes
Deimos 1 TIFF/GeoTIFF 1R, 2R -
Deimos 2 TIFF/GeoTIFF 1B Yes, from the adjacent
passes
DubaiSat-2 TIFF/GeoTIFF Radio Yes
GaoFen-7 TIFF+XML SC Yes
GeoEye-1 TIFF/GeoTIFF, NITF 2A, OR2A, Yes, same-pass
OR2A Stereo
GF-1, 2 TIFF/GeoTIFF 1A No
IKONOS TIFF/GeoTIFF, NITF 2A, OR2A, Yes, same-pass
OR2A Stereo
Jilin 1 TIFF/GeoTIFF Standard Stat- Yes
ic Level 1
Kanopus-V TIFF/GeoTIFF 1,2,3 Yes, from the adjacent
passes
KazEOSat-1 TIFF/GeoTIFF 2A Yes
KOMPSAT-2 TIFF/GeoTIFF 1R, 1G Yes
KOMPSAT-3 TIFF/GeoTIFF 1R, 1G Yes
KOMPSAT-3A TIFF/GeoTIFF 1R, 1G, 10 Yes
OrbView-3 TIFF/GeoTIFF Basic Yes, same-pass
Planetscope TIFF/GeoTIFF 1B No
Pleiades DIMAP V2 Primary Yes
PeruSat-1 DIMAP Sensor Yes, same-pass
QuickBird TIFF/GeoTIFF, NITF 2A, OR2A, Yes, same-pass
OR2A Stereo
RapidEye GeoTIFF, NITF 1B No
Resours-P TIFF/GeoTIFF 1A, 2A Yes, from the adjacent
passes
SkySat TIFF+json+RPC Basic Yes, same-pass
SPOT6, 7 DIMAP V2 (JPEG2000 unu Primary Yes
GeoTIFF)
StilSat-1 TIFF/GeoTIFF L1 No
SuperView-1 TIFF/GeoTIFF 1B, 2A Yes
SuperView Neo TIFF/GeoTIFF 1B, 2A Yes
TripleSat TIFF/GeoTIFF 1A, 2A Yes
TH-1 TIFF/GeoTIFF 1A, 1B Yes
WorldView-1, 2, 3, 4 TIFF/GeoTIFF, NITF 2A, OR2A, Yes, same-pass
OR2A Stereo
ZY-3 TIFF/GeoTIFF - Yes
ZORKIY-2M TIFF/GeoTIFF 1A No
ANCT TIFF/GeoTIFF 1A, 2A No
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3.3.2. Output data

The program allows to process UAS data and acquire all types of value added photo-
grammetric products: DEM, 2D and 3D-vectors, orthomosaics.

There are the main output products:

Digital Terrain Model (DTM) — digital cartographic presentation of terrain surface both
as regular grid of elevations (DEM) and as triangulated irregular network (TIN). They
are used for solving applied research problems.

3D vector objects — used for creating a topographical base for cartographic production
or as source data for a mathematical representation of a scene in three-dimensional
digital terrain modeling;

orthophoto production — single raster images in the form of a single frame or a set of
sheets in a selected map projection with marginalia. In the resulting image, geometric
and photometric distortions are corrected, creating seamless, color-balanced ortho-
photos with uniform brightness as an output;

3D models of terrain — can be used to solve applied research problems, as well as
for creation of multimedia presentations and commercials.

§ There is opportunity to export all photogrammetric products to various formats.

4. System requirements

Recommended configuration for comfortable work:

System component Recommended configuration
CPU Intel Core i7 or present-day Intel Xeon (2.8 GHz or
equivalent)
Memory (RAM) 32 GB (minimum 16 GB)
Video adapter * NVidia GeForce RTX 3060 (or better), if it is not

supposed to work in stereo mode

* NVidia Quadro T1000 (or better), if it is supposed
to work in stereo mode

SATA (HDD/SSD) 47TB
Operating system Microsoft Windows 10, Microsoft Windows 11
Display Professional stereomonitors (or monitors, supporting

NVidia 3D Vision Ready, with NVidia 3D Vision
glasses), if it is supposed to work in stereo mode
(see Section 6)
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For the security key, an USB port is required (to use local) or network connection (to
use system by network).

CPU

It is currently recommended to use systems based on Intel Core i7 (or better) or present-
day Intel Xeon, 2.8 GHz or equivalent.

RAM

It is recommended at least 16 GB RAM for stable work in the system. If less, processes
could take rather more time.

Video adapter
Recommended GPU memory not less than 4 GB.
* NVidia GeForce RTX 3060 (or better), if it is not supposed to work in stereo mode;

* NVidia Quadro T1000 (or better), if it is supposed to work in stereo mode (P, K, M
and RTX series can also be used).

ﬁ Videocards NVidia GeForce series do not support page-flipping stereo mode.

Hard disk drive
It is recommended to use SSD-devices for the better performance.

% The system provides possibility to place project data for several hard disks automatically. In
case of using distributed processing system (for several hard disks) it is recommended to use
hard disks not less than 1 TB size.

& If it is supposed to process projects with more than 1000 GB of data volume please consult with
our Technical Support service (see Section 1.8).

The PHOTOMOD system requires 2 GB of free hard disk space.
Operating system

Work in the program is possible only on PCs with 64-bit operating systems (Windows
XP, Windows Vista, Windows 7, Windows 8.1, Windows 10 or Windows 117).

Network adapter

For project processing using network it is recommended to connect server to hub using
at least 1 Gbit/s network interface.
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5. System installation

5.1. Distribution kit

License software distribute in a branded box.

The company name is place on the front. On the reverse side are placed address,
technical support service phone and e-mail, web-site of company.

The system distribution kit includes:
* CD-ROM containing the system setup files and the documentation files in PDF format;
» 'System installation Manual;

» Hardware lock key (see Section 5.3.1).

5.2. PHOTOMOD installation

Prior to the system installation it is desirable to insert Sentinel HL security key into the
USB-socket of the workstation.

The system requires 2 GB of free hard disk space.

To start the system installation, launch the setup.exe file or input the installation software
and launch the autorun.exe file. The PHOTOMOD window opens.
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E&rHoTOMOD P ] [ |

PHOTOM
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PHOTOMOD 4
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PHOTOMOD StereoACAD /
PHOTOMOD Rada K{f”
v
WWW.racurs.ru = Exit

Fig. 2. The PHOTOMOD installation window

Click Install » PHOTOMOD. The Installation PHOTOMOD 8 window opens.

The system initial installation process consists of a sequence of steps with instructions.

@ In case of cancel at any step, installed program files and data are not removed. To complete
the system installation, restart the autorun.exe or setup.exe file and go through all steps again.

5.2.1. Preparation stage

1. Choose the installation language. Click OK;

i ™
Installer Language ﬁ

@ Please select a language

| English -

[ OK ] [ Cancel ]
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2. Read the welcome and warning messages. Click the Next button.

i '
(2 PHOTOMOD 8 x64 Setup [

Welcome to
PHOTOMOD 8 x64
Setup

Setup will guide you through the installation of PHOTOMOD 8
X564,

ommended that y all other applications
rtin tu
stem files without having t oot your
computer.

Click Mext to continue.

3. Read the license agreement. If you agree with it, set the | accept the terms in the
License Agreement checkbox on and click the Next button.

i '
(® PHOTOMOD 8 x64 Setup [EEREER

RACURS oonse Agreement

Please review the license terms before instaling PHOTOMOD 8
1904 — 2024 x64.

Press Page Down to see the rest of the agreement.

Please read this End User License Agreement (public offer) carefully ~
before purchasing and using the “PHOTOMOD” software. L4

“PHOTOMOD” SOFTWARE
END USER LICENSE AGREEMENT

If you accept the terms of the agreement, dick the check box below. You must accept the
agreement to install PHOTOMOD 8 x64. Click Next to continue.

[7]1 accept the terms of the License Agreement
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4. Define the folder to install the program files of the system. Click the Next button.

c It is strongly not recommended to install the system in folder with name, which contains
letters, different from Latin. By default for the program files the C:\Program Files\PHOTO-

MOD_8 x64 is used.

€h PHOTOMOD 8 x64 Setup = i

Choosze Install Location
@ R'Ac u Rs Choose the folder in which to install PHOTOMOD 8 x64.

1994 — 2024

Setup will install PHOTOMOD & x64 in the following folder. To install in a different folder, dick
Browse and select another folder. Click Next to continue.,

Destination Folder

C:\Program Files\PHOTOMOD_8_x64|

Space required: 2.7 GB
Space available: 81.9 GB

[ < Back ][ Mext = ][ Cancel l

5. [optional] Enter a folder name for the PHOTOMOD program in the Windows Start
menu. A shortcuts in the Windows Start menu will be created by default. Otherwise —
clear the appropriate checkbox. Click the Install button.

€ PHOTOMOD 8 x64 Setup = e

Choose Start Menu Folder

RAc u Rs Choose a Start Menu folder for the PHOTOMOD 28 x64 shortouts,

1994 — 2024

Select the Start Menu folder in which you would like to create the program'’s shaortcuts. You
can also enter a name to create a new folder,

PHOTOMOD 8 xo4

»

7-Zip

Accessaories
Administrative Tools
AIMP3
ComputeGridStep
ComputeSevenParams
CorelDRAVW Graphics Suite X3
Cygwin

Dr.Explain

EMNVI 4.5

EPSOMN Scan

|:| Do not create shortcuts in Start Menu

l.m

< Back ][ Install ] [ Cancel
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5.2.2. File copy stage

1.  Wait until the installation is complete;

i ™y
€ PHOTOMOD 8 x64 Setup E‘_‘ﬂj

Installing
@ RACURS Please wait while PHOTOMOD 8 x54 is being installed.
1994 — 2024

Create folder: C:'\Program Files\PHOTOMOD_&_x&<\Postgres\pgAdmin H\python'Lib\site-pack
. |

Show details

L >,

2. When installation complete perform one of the following actions:

' ™y
3 PHOTOMOD 8 x64 Setup E‘_IH__J

Completing
PHOTOMOD 8 x64
Setup

PHOTOMOD 8 x64 has been installed on your computer,

Click Finish to dose Setup.

Create shortcuts on Windows desktop

Run PHOTOMOD 8 x64

< Back Cancel

L A

* [optional] clear the Run PHOTOMOD 8 x64 checkbox and click the Finish button
to complete the installation process without program launch,;
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* [optional] leave the Run PHOTOMOD 8 x64 checkbox set and click the Finish
button to proceed to the system configuration stage.

% The Create shortcuts on Windows desktop checkbox is set on by default. Clear it if
needed.

é If the Run PHOTOMOD 8 x64 checkbox is set, the PHOTOMOD program will launch
automatically.

If the security key or security key drivers (they must be installed automatically during
the program installation) were not found, the error message displays.

If the Sentinel HL hard lock key and file PhConsts50.d11l do not congruity, the error
message from protection system also displays.

Make sure that the Sentinel HL security key is inserted into the USB-socket of the
workstation. Install the security key drivers manually. Copy the licence file PhConsts50.d11
to the system folder (by default C:\Program Files\ PHOTOMOD _8_ x64) manually and
restart the system.

In case of problems contact the Racurs company technical support service (see Sec-
tion 1.8).

5.2.3. System configuration stage

During the first launch of the system, the message about the required detailed configur-
ation appears. The initial setup of the program can be performed in various ways, de-
pending on the circumstances of the system installation on a particular workstation.
The most common situations are the following:

* The system was installed on this workstation for the first time. The user needs to
create a folder for storing settings, a resource system, and profiles for organizing
local and/or network work. This procedure will be discussed in detail below in this
chapter.

* If other Racurs software products (PHOTOMOD Conveyor, PHOTOMOD UAS) are
already installed and configured on the workstation, the user can quickly connect the
installed program to existing profiles and resource systems.

If the connection did not occur automatically during the first launch of the installed
program, then in the Initial setup window that opens (see below), an already existing
settings folder used by previously installed software products is indicated;

* The system is installed and configured on several workstations connected to each
other via a local network. A new computer is added to the local network where this
program was installed for the first time. Connecting such a workstation to an existing
network profile is described in Section 9.2.5.
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@ More details about program resources, recommendations on organizing of local or network
work, and about creating profiles and virtual folders connecting see in Section 9.2.

System initial setup
To do this, perform the following:

1. Click OK, close the Warning window.

r. Warning @ﬁ

PHOTOMOD configuration is not set up or it is incorrect,
! % The PHOTOMOD initial setup module will be started.

Fig. 3. Information message

2. The Initial setup window opens:

Initial setup @

Settings folder
C:\PHOTOMODS. VAR, (o]

For all users on this computer @ Only for me

Centralized profile management

] use

Centralized management folder

Ok ] [ Cancel

Fig. 4. The Initial setup window

In Settings folder section is displayed path to the PHOTOMODS8. VAR folder, that
is used to store configuration and temp files. Click the _... | button to change path
to configuration folder.

@ If other Racurs software products (PHOTOMOD Conveyor, PHOTOMOD UAS) are already
installed and configured on the workstation, the system provides for connecting the program
to existing profiles and resource systems.
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For this, the settings folder is to be specified which is used by these software products.
In this case, the user will not be required to perform the steps described below to create a
new local profile.

@ Choose For all users on this computer to use one configuration folder for all users of
current workstation, otherwise choose Only for me.

[optional] To Use the centralized profile management set the appropriate
checkbox and define the centralized management folder. Click OK.

@ Creation of a local profile is described in this Chapter. Network profiles management is

described below.

3. The Control Panel module opens. An info message that at least one local profile
must be created appears. Click OK.

Control Panel | )

Profiles Resource tree
+ + X
NeS8% g e & &
Profile . Free MNode Path Free
5| Information @

At least one profile must be created

Managing network profile is available only in network profiles management mode Manage network profiles ]

[ oK ] l Apply ] [ Close ]

Fig. 5. Information message

@ The Control Panel module is used to configure detailed system settings during the further
work.

4. Specify a local profile name in the New profile window and click OK.
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B Input new profile name @Iﬂ—hj

Mew profile

Local profile 1

QK ] [ Cancel

Fig. 6. Local profile name setup

5. The window allowing to connect virtual folder opens:

i !
Connect virtual folder l&

Virtual folder name

Folder

[...]

Ok ” Cancel ]

Fig. 7. The Connect virtual folder window

Input a virtual folder name — arbitrary text is used to identify data in folder. In
Folder field click the _... | button to choose a physical space for connecting as a
virtual folder. Click OK to close the connect virtual folder window.

. It's impossible to use logical disk root folder.

@ To connect folder only read access for this folder is required.

ﬁ Local profile folder could be placed both on a workstation, where the system runs, and on
any workstation of the network.

6. Click OK. Local profile creates and also defined virtual folder connects to this profile:
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Control Panel Iﬁ
Profile Resources Service Help
Profiles Resource tree
+ + X
N eS8 Y e o &
Profile b Free MNode Path Free
Local profile 1 93.66 GB /2 Chdatal 93.66 GB

T e

Fig. 8. Control Panel window

7. Click OK in the Control panel window to finish system configuration. Leftward to
profile name is shown the ¥ red mark. It marks an active profile. An info message
that the system should be restarted appears. Click OK to restart PHOTOMOD
program.

5| Information ﬁ

For the changes to take effect it is necessary to restart all PHOTOMOD medules
currently running.

Fig. 9. Information message

5.2.4. System deinstallation

To remove the system from computer, close all modules of the system and choose
Start > Programs > PHOTOMOD 8 x64 > Uninstall PHOTOMOD 8 x64 or use standard
tools in Control panel of Windows operation system.

@ The PHOTOMODS8. VAR folder is not removed during uninstallation.

34



PHOTOMOD 8.1 General information about the system (Windows x64)

5.3. Protection of the system

5.3.1. Local security hardlock key

The distribution kit includes the unique hard lock key from Sentinel HL (previous called
HASP), to protect the system and data from software piracy and unauthorized dissem-
ination. During the PHOTOMOD installation drivers of security key are installed auto-
matically.

Also, during the PHOTOMOD installation the PhConsts50.d11 file is copied to the system
folder. This file is necessary to correct work of the system and it is a file of hard lock
key from Sentinel HL.

If the Sentinel HL hard lock key, hard lock key drivers and/or file PhConsts50.d11l are
not found, the error message of protection system displays.

In case of problems with PhConsts50.d11 file, copy it manually from the installation CD
or contact the Racurs company technical support service (see Section 1.8), to obtain
this license file. After obtain the licence file copy it to the system folder (by default
C:\Program Files\ PHOTOMOD_8 x64).

In case of problems with installation of security key drivers, install it manually. To do
this open the Hasp\Sentinel HASP_Run-time_setup folder from the installation CD and
launch the HASPUserSetup.exe file. Install security key drivers with default parameters.
You can also download the last version of security key drivers on this link.

To check congruity of hard lock key and its file perform the following:

1. Choose License info in the right-click menu of the System Monitor module (the 3
icon in the Windows system tray). Process of licences checking starts. After
checking, the PHOTOMOD Distribution info windows opens.
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ra it
PHOTOMOD Distribution Info - 23
2 & =
Purchased wversion : 5.23.141% -
Purchzase date - 07.11_2023
Technical support expiration date : 31.12_.20Z25
Current wversion - B8.0.5135
Version date : 24 _08.2025
Owner : Bacurs
Serial number : BEH3T70385RCRS
Frotection type : Hetwork
Flag -1
PHOTOMOD key id : 173847722
Modulea liat and licenace count - 3
FHOTOMOD DiPro b -1
FHOTOMOD DTHM z 50
EHOTOMOD SterscDraw z 50
FHOTOMOD AT z 50
EHOTOMOD GeoMosaic z 50
FHOTOMOD Mosaic : 50
FHOTOMOD Solweri : 50 TS
FHOTOMOD SolwerS : B0
FHOTOMOD Core : B0
FHOTOMOD 3D-Mod : B0
FHOTOMOD ParPFroc : B0
FHOTOMOD Conwveyor Pro : B0
FHOTOMOD dDEM : B0
FHOTOMOD MNeuro : B0
EHOTOMOD UAS : B0 -
L5 A

Fig. 10. Distribution Info

2. Compare the unique number of security key in the Serial number line with the
number on hard lock key.

3. Click the [E] button in PHOTOMOD Distribution info window toolbar. Wait until
the operation is complete.
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s Y
PHOTOMOD Distribution Info [
B BE
PHOTOMOD information: >
Purchased wversion : 5.23.141% L
Purchzse date . 07.11.2023 3
Technical support expiration date : 31.12_2025
Current wersion : B.0.5135
Versicn date : Z4.08.2025
Cwner : Racurs
Serial number : PH370385RCRS
Brotection type : Network
Flag -1
PHOTOMOD key_id - 1735477Z2Z

HASP information:

HASF key id : 173347722
Maxnimzl tasks per node 128
Licenses from HASPE : h=50

Modulea liat and licenace count -
FHOTOMOD DTM (2):
=50 / h=50

PHOTOMOD StereoDraw (3):
=50 / h=50

Fig. 11. Distribution Info

@ The |%] button allows to refresh the window content.

? The B button allows to save window content into the file with *. txt extension.

4. Compare quantity of license for modules in each line below the name of module.
Quantity of licence in the hard lock key and in its file should be equal.

QA h is quantity of licence in the hard lock key, p is quantity of licence in the PhConsts50.d11

file.

5. If number are not equal contact the RACURS company technical support service.

To use network system version, security key drivers should be installed on every stand
alone workstation. During the PHOTOMOD installation drivers of security key are in-
stalled automatically.

5 Itis recommended to install the security key on computer which is not used to project processing,
recording CD/DVD, etc.

. If there is not enough RAM or resource-intensive tasks are performed on workstation with the
= secure key, The protection system failure or loss of data are possible.
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5.3.2. Network security hardlock key

A network version of the Sentinel HL hard lock key is intended to protect the system,
using the network (floating) licences.

g Floating licensing is a software licensing approach in which a limited number of licenses (seats)
are shared among a number of users larger than the number of available licenses.

When a user requests a license from a license server, the server allows the application to run
if there is an available license. When the application shuts down, the license is reclaimed by
the license server and made available to another user.

The license server can manage licenses over a local network (LAN), an intranet, virtual private
network (VPN), or the Internet. Floating licenses are also known as concurrent licenses or network
licenses and often used by corporate users.

To use network system version, security key drivers should be installed on every stand
alone workstation. The network Sentinel HL security key should be inserted into the
USB-socket of the one of workstations. This workstation should be accessible to all
network nodes.

When using multiple hard lock keys in a LAN, it is possible that start over of the system’s
modules on a separate computer could be slow. It is also possible that the hard lock
key is inaccessible. In such a case it is recommended to change the hard lock key
settings.

? This situation can occur when several different versions of PHOTOMOD system are used in
local network.

To set access to a proper hard lock key or to speed up start of the system modules,
perform the following actions:

C To set access to a hard lock key it is necessary to posses administrator’s privileges.

Perform the following procedure on each node supposed to be used for processing.

1. Open a browser on a computer where the PHOTOMOD and hard lock key drivers
are installed;

2. Input the following into browser address line http://localhost:1947. The Sentinel
Admin Control Center window opens:
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. =

/) SafeNet Sentinel ACC: Hel x|

<« C' | [ localhost:1947/_int_/ACC_help_index.html ey =

I‘

I
@afeNet Sentinel Admin Control Center

Admin Control Center Help

Sentinel Ki .
erine Bers Admin Control Center Help
Products
Features
Fzs oo Welcome to the Admin Centrel Center. This application enables you to manage access to scftware licenses and Features, to control

detachable licenses, to control sessions, and te diagnese problems.

Update/Attach Note: You can select the language in which Admin Centrol Center is displayed by clicking the country flag appropriate to the required
language, which is displayed at the bottom of the Options pane). To view all available languages, or to download other language packs

click the More Languages link.

Access Log
Configuration The Admin Centrol Center enables you to monitor the following:
Diagnestics « All the Sentinel protection keys that are currently available on the network server, including their identity, type, and loc ation
« The number of users currently logged in to a protection key. and the maximum number of users allowed te be simultanecusly
Heln legged inte that specific key
o + The Features to which each protection key allows access. and any restrictions that apply to the Feature
About » The users who are currently logged inte a specific protection key. including detailed login information
You can perform actions, such as:
« Detaching a license frem the network and attaching it to your machine or a different recipient machine
+ Cancelling a detachable license prematurely
« Installing an update to a license
You can make basic cenfiguration changes, including
« Setting the display refresh time

« Configuring access permissions from a client machine te a remote server, and configuring a server to allow it to be remotely

More Languages accessed
= Defining values for Products with detachable licenses

The Diagnestics page enables you to view system information related to the current Sentinel License Manager, and to generate reports.

Fig. 12. Sentinel Admin Control Center

3. [optional] To obtain information about hard lock keys in local network, click Sentinel
Keys. The table containing detailed information about hard lock keys opens:
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BB Safebies Semtined ACC: S 3 )

[3 localhost-1947

ST |

“ c
|
| @ifeﬂet

Sentinel Admin Control Center

Products.
Features
Setieer

Updateifnach

Accass Log

Dhagrecestics

£

Sentinel Keys Available on

¥ Location Vendor Hey ID

1 ACTIVATOR 8081 1Frarrn
2 LOCKER B8  AFORINE
3 SVETA BROBT  13533EIM

Eey Typs Configuration Wersion Sessions Actions

HASF HL het 50 S - 325 T8 [ SiBrowse | Mat Fesun
HASPFHL Met 50 i - 325 B = [T T
Sentinel HL Met 10 Sl[J HASP 427 « [EVBrowss | Mel Featune

Help Top

Fig. 13. Local Hard Lock Keys

4. Click Configuration. The Basic Settings tab of the Configuration for Sentinel

License Manager window opens;

5. Select the Access to Remote License Managers tab:
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10.

1.

BB Satetiet Semmnel 800 o %
« L5 lozalhast
|

@\fal’\let
[ Opbons_|

Sentined Keys
Products
Featwes
Sengnen
Lipdata/Aniach
Arcass Log
Diagnostics

Hailp
About

Configuration for Sentinel Licensa Manager on

Basic Semings l Users. Access io Remote License Managers

Allow Access to Remole Licenses L4
Broade aat Search for Remobe Licensas
Aggreasive Search for Femete Lizermes

Remcts Licerse Search Parameters sctivator

Access from Remote Clients

ol | 201 Defaums

Fig. 14. Access configuration to remote license managers

Make sure that the Allow Access to Remote Licenses checkbox is set on;

Clear the Broadcast Search for Remote Licenses checkbox to turn off broadcast
keys search;

Clear the Aggressive Search for Remote Licenses checkbox;

In the Remote License Search Parameters field input a computer network name
(activator in the given example) where the proper hard lock key is inserted;

Click the Submit button;

é Settings save operation could take a few minutes.

Click Sentinel Keys. The table containing the hard lock key on the selected com-
puter is displayed:
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| )

BB Satebier Semnnel 800 S0 x ]
s [ £ localhost - —]

|

| | |

@n‘el‘qet
m Sentinal Keys Available on

# Location WVemudar Ky I Ky Typs Caonfiguration WVersicn Sessions Actions
Products 1 ACTIVATOR ALDEY REEFF L FF] HASE HL Mot 20 g 1% 5 Bewwse
Features
Sessas

Update/Asiach

Arcess Log
Configuration

Diagnosiics

Halp
About

Fig. 15. Hard Lock Key on selected computer

12. Create the PhConsts50.dl1.host file. Open the file in any text editor and input
computer network name to the last row (activator in the given example);

13. Put the PhConsts50.dll.host file to PHOTOMOD installation folder (by default
C:\Program Files\ PHOTOMODY x64).

6. Tools for work in stereo

6.1. Graphic cards, stereomonitors and glasses

If it is supposed to work in stereo mode, the professional stereomonitors (or monitors,
supporting NVidia 3D Vision Ready) and special video adapters are required.

ﬁ, The system also support the anaglyph stereo mode. This mode does not required special
videoadapters and monitors and also configuration of videocard driver. To work in anaglyph
stereo are used glass or plastic anaglyph glasses with red and blue filters.

42



PHOTOMOD 8.1 General information about the system (Windows x64)

6.1.1. General information

It is important to configure video card drivers correctly for effective project processing
in stereomode. It is recommended to use the following NVidia video cards to work in
stereomode:

* NVidia Quadro T:
* NVidia Quadro P;
* NVidia Quadro RTX.

§ To use videocard not from the lists above, additional setup and testing in stereomode are re-
quired.

ﬁ Videocards NVidia GeForce series do not support page-flipping stereo mode.

Depending on the monitor type there are some ways to setup drivers of videocard:

 Detailed information about setup drivers of Planar, Omnia Technologias S.L., TRUE3Di
and StereoPixel of the LcReflex-20 series StereoMirror monitors, see in the Sec-
tion 6.1.2.

» Information about setup drivers of high-frequency monitors supported NVidia 3D
Vision Ready see in the Section 6.1.3

Work with StereoMirror monitor

To show stereoimage on a LcReflex 3D monitor are used special polarized glasses.

Fig. 16. Polarized glasses
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- N

Fig. 17. IcReflex 3D monitors

Work with high-frequency displays

To use the high-frequency monitor are required a special shutter glasses GeForse 3D
Vision series. The glasses are wireless, and require recharging through USB port. The
glasses are provided with USB IR-emitter.
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Fig. 18. Shutter 3D Vision glasses

LCD MONIT@R

VG235

Fig. 19. Asus VG236H 3D-Ready LCD Monitor with NVidia 3D Vision Ready

Work in anaglyph stereo mode

The system also support the anaglyph stereo mode. This mode does not required
special videoadapters and monitors and also configuration of videocard driver. To work
in anaglyph stereo are used glass or plastic anaglyph glasses with red and blue filters.
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Fig. 20. Anaglyph glasses

6.1.2. Videoadapter driver settings for StereoMirror monitors

Perform the following to setup videoadapter driver for stereo monitors:

é This example of setting up the NVidia Quadro 600 videocard, v. 306.97. Windows could be
slightly different to example, it depends on version and series of videocards.

1. Right click on a Windows desktop to open a context menu.
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View ]
sort by F
Refresh

Paste
Paste sharbcut

B nvinia control Panel

Mew ]

-4 nView Desktop Manager

= Screen resolution

[ Gadgets

EPersnnaliIe

Fig. 21. Context menu

2. Choose NVIDIA Control Panel. The NVIDIA Control Panel window opens.

| NVIDIA Control Panel -0l x|
Fle Edit Desktop Help
Q-0 |
s .
Select a Task... @ R =
= sty £=.] Set Up Stereoscopic 3D
--Adjustimage settings with preview ~
-~Manage 3D settings Stereoscopic 3D allows you to view 3D content with visible depth. Use this page to change stereoscopic 30 settings.
-Set PhysX Configuration
[=I-Display
-Change resolution
—-Adjust desktop color settings Apply the following stereoscopic 3D settings:
--Rotate display
View HDCP status 1 Enable stereoscopic 30
-5et up digital audio Depthy
Adjust desktop size and position
--Set up multiple displays win —— | Max 15 %
I [ v v " i " v " 1
Set up ste |
H View compatibility with games Default
£l Video
: Adjust video color settings Stereascopic 30 display type:
. ~Adjust video image settings K 30-ancnneiiBenQ 120 Tt |7
- Workstation
~-View system topalogy
Set up Mosaic
-Manage GPU Utiization Change 20Laser Sight | Set Keyboard Shortcuts
I™ Hide stereoscopic 30 effacts when game starts
Test stereoscopic 30... |
System Information i =
2| | Mz

Fig. 22. Disable stereoscopic 3D
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3. Onthe Stereoscopic 3D » Set up stereoscopic 3D tab in the Apply the following

stereoscopic 3D settings set the Enable stereoscopic 3D checkbox off.

4. Move to 3D Settings » Manage 3D settings. The Manage 3D settings on the
Global settings tab opens.

c=| NVIDIA Control Panel
Fle Edit Desktop 3D Settings Help

=10lx|

@Emvo | _;j

Select a Task...

13D Settings
--Adjust image settings with preview

ings
-.5et PhysX Configuration

[} Display

--Change resolution

—-Adjust desktop color settings
--Rotate display

--View HDCP status

--Set up digital audio

--Adjust desktop size and position
~Set up multiple displays

[=1- Stereoscopic 30

{ L.Setup stereoscopic 30

i LeView compatibility with games
=l Videa
H Adjust video color settings
¢ -Adjust video image settings
- Workstation

~iew system topology

Set up Mosaic
-Manage GPU Utiization

System Information

g Manage 3D Settings

You can change the global 3D settings and create ovemdes for specific programs. The ovemides will be used automatically each time the

specified programs are launched

1 would like to use the following 3D settings:

Global Settings | Program Settings

Global presets:

Basce profile j 3 Restore
Settings:

Feature ‘ Setting |:|

Maximum pre-rendered frames
Multi-display mixed-GPU acceleration
OpenGL rendering GPU

Optimize for sparse texture performance
Power management mode

Preferred refresh rate (BenQ XL24112)
Shader Cache

Stereo - Display mode

Stereo - Enable

Stereo - Swap eyes

Stereo — swap mode

Use the 3D application setting

Multiple display performance mode
Auto-select

None

NVIDLA driver-controlled
Application-controlled

On

Generic active stereo {with NVIDIA 30 Visi...

on

off

Application-controlled

=

=

Description:

Thig ligthox containg all of the features you can adjust on your NVIDIA GPU-based graphics card. You can change the

setting of a feature using the dropdown listbox beside the feature name.

Fig. 23. Configuration of stereo mode

5. Set On to the Stereo — Enable line and set nView clone mode to the Stereo —

display mode line.

6. Choose Display > Set up multiple displays.
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7.

=|NYIDIA Control Panel o[]S

File Edit ¥iew Display Help

GBackvO ‘ _;_\J

Seleck a Task, ..

-Adjust image settings with preview
‘Manage 30 settings

-Set PhysY configuration

Display

Change resolution

-Adjust desktop color settings
-Adjust desktop size and position
-Ratate display

up multiple di

= Stereoscopic 30

Set up stereoscopic 30

L. Niew compatibility with games
- ¥iden

- Adijust video color sethings

L Adjust videa image settings
[ Workstation

- Migw system topology

i..5et up Mosaic

System Information

e [l Set Up Multiple Displays T

p—a

MHYIDIA nview technalogy allows vou to specify how you waould like to use multiple displays.

1. Select the displays you want to use.

|7 Samsung SyncMaster {1 of 2) [ 1]
¥ samsung SyncMaster (2 of 2) H

My dizplay iz not shown...

2. Drag the icons to match your display configuration.

IMake this the Windows main display

® Extend desktop on this display
Duplicate displays (use Samsung SyncMaster (1 of 2) as primary clone)
Duplicate displays (use Samsung SyncMaster (2 of 2) as primary clone)

Identify display _I

Apply Cancel |

Fig. 24. Setting multiple displays — step 1

In the 2. Verify your display configuration section right click on a block with ’1’

to open a context menu.
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NYIDIA Control Panel =1olx]

File Edit ¥iew Display Help

- ‘\
O Back = o ‘ ol
Seleck a Task, .. =

I =) . 1
[=]- 30 Settings @ Set Up Mu Itlple Dlsplays
-Adjust image settings with preview —
‘Manage 30 settings
...5et Physy corfiguration
[=]- Display
i..Change resalution

idiust desktap colar settings 1. Select the displays you want to use.

[+

MHYIDIA nview technalogy allows vou to specify how you waould like to use multiple displays.

--Adjust desktop size and position
-Rotate display

-iew HDCP status |7 Samsung SyncMaster (1 of 2) [ 1]
£ up multiple displays [V Samsung Synchaster (2 of 2) H

Quadro FX 580

= Stereoscopic 30

Set up stereoscopic 30

L. Niew compatibility with games
- ¥iden

- Adijust video color sethings

L Adjust videa image settings
[ Workstation

- Migw system topology

i..5et up Mosaic

My dizplay iz not shown...

2. Drag the icons to match your display configuration.

Extend desktop on this display
@ Duplicate displays {use Samsung SyncMaster (1 of 2) as primary clane)
Duplicate displays {use Samsung SyncMaster (2 of 2) as primary clone)

Identify display

Systern Information Apply Cancel |

Fig. 25. Display context menu

8. Choose Clone > 2 in the right-click menu. As a result both monitors are equal.

9. Click the Apply button to save changes.

6.1.3. Videoadapter driver settings for high-frequency displays

Perform the following to setup videoadapter driver:

é This example of setting up the Nvidia Quadro 2000 videocard, v. 331.82. Windows could be
slightly different to example, it depends on version and series of videocards.

1. Right click on a Windows desktop to open a context menu.
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View ]
sort by F
Refresh

Paste
Paste sharbcut

B nvinia control Panel

Mew ]

-4 nView Desktop Manager

= Screen resolution

[ Gadgets

EPersnnaliIe

Fig. 26. Context menu

2. Choose NVIDIA Control Panel. The NVIDIA Control Panel window opens.

| NVIDIA Control Panel -0l x|
Fle Edit Desktop Help
Q-0 |
s .
Select a Task... @ R =
= sty £=.] Set Up Stereoscopic 3D
--Adjustimage settings with preview ~
-~Manage 3D settings Stereoscopic 3D allows you to view 3D content with visible depth. Use this page to change stereoscopic 30 settings.
-Set PhysX Configuration
[=I-Display
-Change resolution
—-Adjust desktop color settings Apply the following stereoscopic 3D settings:
--Rotate display
View HDCP status 1 Enable stereoscopic 30
-5et up digital audio Depthy
Adjust desktop size and position
--Set up multiple displays win —— | Max 15 %
I [ v v " i " v " 1
Set up ste |
H View compatibility with games Default
£l Video
: Adjust video color settings Stereascopic 30 display type:
. ~Adjust video image settings K 30-ancnneiiBenQ 120 Tt |7
- Workstation
~-View system topalogy
Set up Mosaic
-Manage GPU Utiization Change 20Laser Sight | Set Keyboard Shortcuts
I™ Hide stereoscopic 30 effacts when game starts
Test stereoscopic 30... |
System Information i =
2| | Mz

Fig. 27. Disable stereoscopic 3D
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3. Onthe Stereoscopic 3D » Set up stereoscopic 3D tab in the Apply the following

stereoscopic 3D settings set the Enable stereoscopic 3D checkbox off.

4. Click the Apply button to save changes.

5. Move to 3D Settings » Manage 3D settings. Move to the Global Settings tab.

c=| NVIDIA Control Panel
Fle Edit Desktop 3D Settings Help

=10lx|

@Emvo | _;j

Select a Task...

13D Settings
--Adjust image settings with preview
MManage 3D settings
-.5et PhysX Configuration
[} Display
--Change resolution
—-Adjust desktop color settings
--Rotate display
--View HDCP status
--Set up digital audio
--Adjust desktop size and position
--Setup multiple displays
[=1- Stereoscopic 30
{ L.Setup stereoscopic 30

~View compatibility with games
=l Videa
H Adjust video color settings
¢ -Adjust video image settings
- Workstation

~iew system topology

Set up Mosaic
-Manage GPU Utiization

System Information

g Manage 3D Settings

You can change the global 3D settings and create ovemdes for specific programs. The ovemides will be used automatically each time the

specified programs are launched
1 would like to use the following 3D settings:

Global Settings | Program Settings

Global presets:
Base profile j <] Restore
Settings:
Feature ‘ Setting |:|
Maximum pre-rendered frames Use the 3D application setting
Multi-display mixed-GPU acceleration Multiple display performance mode
OpenGL rendering GPU Auto-select
Optimize for sparse texture performance Mone
Power management mode MNVIDIA driver-controlled
Preferred refresh rate (BenQ XL24112) Application-controlled
Shader Cache on
Stereo - Display mode Generic active stereo {with NVIDIA 30 Visi...
Stereo - Enable on LI
Stereo - Swap eyes oOff
Stereo — swap mode Application-controlled ;I

Description:

Thig ligthox containg all of the features you can adjust on your NVIDIA GPU-based graphics card. You can change the

setting of a feature using the dropdown listbox beside the feature name.

Fig. 28. Configuration of stereo mode

6. Set On to the Stereo — Enable mode.

7. Choose Generic active stereo (with NVIDIA 3D Vision) to the Stereo — Display

mode feature.

8. Choose Display » Change resolution.

52




PHOTOMOD 8.1 General information about the system (Windows x64)

| NVIDIA Control Panel =101 x|

Fle Edit Desktop Display Help

GEE‘*'O | _;j

|»

Select a Task... =
I :
e [l Change Resolution
~-Adjustimage settings with preview — R
-~-Manage 3D settings You can adjust the amount of information appearing on the screen and reduce flickering. You can also choose the high-defintion (HD') format if y
-.5et PhysX Configuration are using an HOTV and set a courtry-specific signal for your standard-definition (SO TV.
[} Display

B Change resolution

—-Adjust desktop color settings
--Rotate display

--View HDCP status

--Set up digital audio

--Adjust desktop size and position -

~5et up multiple displays BenQ XL24117
[=1- Stereoscopic 30

{ L.Setup stereoscopic 30

1. Select the display you would like to change.

~View compatibility with games

i Video 2. Apply the following settings.
Adjust video color settings
¢ -Adjust video image settings Connector:
- Workstation VI - PC display
~View system topology
Setup Mosaic Resgolution: Refresh rate:
--Manage GPU Utilization oo
g PC < [r2me =l
1920 = 1080 (native)
1680 1050 e
1600 = 1024 IH\ghEst (32-bit) i
1600 = 900
1440 = 900
1366 = 7568 _I
-

4| i Bl
System Information Ppply Cancel |

Fig. 29. Configuration of refresh rate

9. Inthe 2. Apply the following settings section choose 120 Hz in the Refresh rate
list.

@ It is recommended to set the refresh rate not more than 120 Hz.

10. Click the Apply button to save changes.

6.2. Using of special mice, hand wheels and foot pedals in the
system

6.2.1. Setup of mouse driver

To optimize the vectorization process it is possible to both use hotkeys, buttons on
toolbars, menu items and also to program mouse buttons for different actions.

The system supports mice with 3 and 5 keys and also 3D-mice, hand wheels and foot
pedals. The system provides possibility to customize any type of mice that supports
emulation of standard five-button mouse.

To setup mouse choose Service > Mouse setup. The Mouse setup window opens.
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- N
® C:\PHOTOMODT.VAR\Config\MouseConfig.x-mcf - Mouse setup -
O e &.. [
Driver active
Macros list Available buttons Standard mouse

Mouse L
Mouse R
Mouse M
Mouse X1
Mouse X2

3D snapping

m| »

Activate ve..,
Cancel sele...
Correlate
Delete
Delete seg...
Drag =
4 m

<MNo macro selected >
+ -—

Close

Fig. 30. Mouse setup window

The Mouse setup window is used to setup standard or special mice, hand wheels and
foot pedals, connected to a computer.

By default driver with standard mouse settings is loaded. It could be used to create
customer settings.

? All actions with mouse in this User Manual are described for a standard mouse.

In the head of the window is shown path to configuration file of mouse. By default it is
PHOTOMODS.VAR\Config\Mouse Config.x-mcf.

In the Macro list is displayed a list of commands that could be added to selected mouse
button or action of wheels/pedals. The list of buttons of selected mouse is displayed in
the Available buttons.

In the right part of window are displayed tabs to choose devices for adjust. By default
only Standard mouse is displayed.

é If standard mouse and special devices are connected to a computer at the same time, all tabs
of these devices are displayed in the Mouse setup window.

The toolbar of the Mouse setup window contains buttons used to perform the following
operations:

» [4 — to create new configuration of settings for selected mouse;

* = —to load existed mouse driver from a file;
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— to save changes in mouse configuration and re-write current driver;

— to save new mouse configuration or changes in current configuration in a new
file;

[l — to open the Macro editor window;

- #. — to open the Mouse configuration window to choose and adjust special mice
or devices.

@ The Mouse configuration window also could be open from right-click menu of the System
Monitor module (the &3 icon in the Windows system tray).

To add current bind for a mouse button perform the following:

1. Choose an action for a button in the Macros list.

. Changes in the Mouse configuration window work on all operation system, while the
System Monitor module is launched.

2. [optional] To create macros for action not from the list and add it to a mouse button,
click the [ button (description of macros creation see in the Section 6.2.3).
3. Choose button to add an action in the Available buttons section.

4. Click the + button at the bottom of the window to add selected action to a list of
actions for clicking of chosen mouse button. To delete action from this list, click the
= button.

§ To bind another action for selected button, repeat steps 1-3.

5. Repeat steps 1-3 to add actions for other mouse buttons.
6. [optional] To save macros configuration click the =5 button.

7. Close the Mouse setup window.

6.2.2. Mouse configuration

The system allows to use special mice, hand wheels and foot pedals for stereovector-
ization.

The Mouse configuration window is used to choose mouse and setup its parameters.
To open the Mouse configuration window, click the .. button in the Mouse setup
window.
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e 1
. Mouse configuration Lé]

Changes made in this window define how selected painting device works for all applications on this computer

Used mice

Standard mouse and: | <No additional devices > - |

Standard mouse button actions assignment

Standard mouse button actions can not be
assigned to the buttons of this device

Device parameters

COM-port XY plane sensitivity - + [] Invert Z motion

Baud rate Z sensitivity - + Swap X and Y

[ QK ]| Cancel || Apply

Fig. 31. The Mouse configuration window
The list of available devices is displayed in the Used mice section:
* No additional devices — is used standard tree- or five-button mouse only;

* Immersion SoftMouse — specialised mouse from Immersion company that is used
for stereovectorization;

+ Immersion compatible hand wheels/foot pedals — additional devices to use with
Immersion SoftMouse, distributed from 'Geosystem’ company;

* GeoMouse (EOMZ) — photogrammetric 3D-mouse that is used to move and precise
marker positioning by XYZ axis and to use buttons as hotkeys for most use functions.

* Hand wheels/foot pedals 'Vector-A’ (EOMZ) — hand wheels and foot pedals, de-
veloped by EOMZ, that could be used to 3D processing data in the system.
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« Stealth 3D Mouse devices — Stealth 3D Mouse S1-U, Stealth 3D Mouse S2-U,
Stealth 3D Mouse S1-Z or Stealth 3D Mouse S2-Z;

» Atlas 3D mouse — specialised mouse from Uzman Engineering Co., Ltd company
that is used for stereovectorization.

Type of chosen device, scheme and names of buttons are also displayed in the window.

For specialized mice or wheels in the Device parameters section could be adjusted
the following parameters:

@ Set of parameters to adjust depends on chosen device.

* COM-port — allows to choose a port number used to connect device;

* Baud rate — allows to change rate of used COM-port (in kb/s);

% It is recommended to use the default value.

+ XY plane sensitivity — allows to change sensitivity of marker when moving special
mouse or wheel rotation by X and Y axis;

« Z plane sensitivity — allows to change sensitivity of marker when moving special
mouse or wheel rotation by Z-axis;

* Invert Z motion — allows to invert moving marker by Z-axis when using mouse or
wheel rotation;

+ Swap X and Y - allows to invert moving marker by XY-axis when using mouse or
wheel rotation;

* Invert X motion — allows to invert moving marker by X-axis only, when using mouse
or wheel rotation;

* Invert Y motion — allows to invert moving marker by Y-axis only, when using mouse
or wheel rotation.

In the Standard mouse button actions assignment section is displayed table of buttons
of chosen device and action for clicking this button.

A Changes in the Mouse configuration window work on all operation system, while the System
Monitor module is launched.

To detach action for buttons of standard mouse, double-click on row with button’s action.
Double-click allows to attach clicking of left mouse button, L is displayed in the row.
Two double-clicks — right mouse button (R), three — middle mouse button (M).
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To use device choose it in the list and click the Apply button to save changes.

The Mouse setup window is used to setup other buttons of special mice or
wheels/pedals.

Immersion SoftMouse

Immersion SoftMouse — specialised mouse from Immersion company that is used for
stereovectorization. Distribution kit includes power adapter and an interface device for
connecting a mouse to the COM-port.

c Connect Immersion SoftMouse to a computer when it is switched off!

Immersion SoftMouse has 10 custom buttons, any three of them could be used as buttons of
standard mouse (see below).

é Immersion SoftMouse and standard mouse could be used at the same time.

To choose Immersion SoftMouse and setup its parameters perform the following:

1. After installation of Immersion SoftMouse to your PC, turn PC on and run PHO-
TOMOD program;

2. To setup mouse choose Service > Mouse setup. The Mouse setup window opens;

3. Inthe Mouse setup window click the &.. button. The Mouse configuration window
opens;

4. Inthe Used mice section select the Immersion SoftMouse device from the drop-
down list;
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- ~
. Mouse configuration &J
Changes made in this window define how selected pointing device works for all applications on this computer

Used mice
Standard mouse and: | Immersion SoftMouse v]

Standard mouse button actions assignment

Button Assignment

BL
B2
/ B3
B2 7 B3 a
< \Adf . 2
A3 ) (A1 ij ]
LM Aﬁ RM M X

K B (B4

SoftMouse buttons may be assigned standard mouse button actions. Such assignment as well as moving mouse cursor with SoftMouse will work for all applications on this
computer while PHOTOMOD System Monitor is running.

Device parameters

COM-port |4 * | XY plane sensitivity - rJ + |:| Invert Z motion

Baud rate [ 115200 | Z sensitivity - rJ + ] swap ¥ and ¥

[ oK H Cancel H Apply

Fig. 32. Immersion SoftMouse chosen in the Mouse configuration window

5. Set the Device parameters (see Section 6.2.2 above);

6. [optional] Perform the Standard mouse button actions assignment (see Sec-
tion 6.2.2 above);

7. Click the Apply button to save changes;

8. Click OK to return to the Mouse setup window, to setup other buttons of special
mice or wheels/pedals;

Q The rightmost part of Mouse setup window now consists of two tabs, one of which (Standart
Mouse) allows to setup standard mouse buttons, and the second one (Immersion Soft-
Mouse) — other buttons of special mice or wheels/pedals.

59




PHOTOMOD 8.1

General information about the system (Windows x64)

-
& C\PHOTOMODT.VAR\ConfigiMouseConfig.x-mef - Mouse setup

]

Driver active
Macros list

L= &,

Available buttons

Standard mouse

3D snapping
Activate ve..,
Cancel sele...
Correlate
Delete
Delete seg...

Drag
b

Mouse L
Mouse R
Mouse M
Mouse X1
Mouse X2
Immersion B1
Immersion B2
Immersion B3
Irmmersion B4

Immersion SoftMouse

B2 /53

\{3\4.
AP “@A1

<No macro selected> Immersion AL

+ - Immersion A2 LM Az RM

Immersion 43

Immersion Ad i

Immersion LM B1‘ kB4
Immersion RM . \ :

Close

Fig. 33. Configuration of Immersion SoftMouse

9. [optional] click the [ff] button in Mouse setup window, to open the Macro editor
and create new macro, if needed.

Immersion compatible hand wheels/foot pedals

Immersion compatible hand wheels/foot pedals — additional devices to use with
Immersion SoftMouse, distributed from 'Geosystem’ company. Distribution kit includes
right and left hand wheels, (to move marker by ne), foot wheel (to move marker by Z)
and three foot pedals (for mouse button customized functions). Devices connect to
computer with Immersion Interface box (see hardware installation details in equipment
User Manual).

é Connect Immersion compatible hand wheels/foot pedals to a computer when it is switched
off!

To choose Immersion compatible hand wheels/foot pedals and setup its parameters
perform the following:

1. Afterinstallation of Immersion compatible hand wheels/foot pedals to your PC,
turn PC on and run PHOTOMOD program;

2. To setup mouse choose Service > Mouse setup. The Mouse setup window opens;

3. Inthe Mouse setup window click the &.. button. The Mouse configuration window
opens;
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4.

In the Used mice section select the Immersion compatible hand wheels/foot
pedals device from the drop-down list;

- ~
. Mouse configuration @
Changes made in this window define how selected pointing device works for all applications on this computer

Used mice
Standard mouse and: |Immersion compatible hand wheelsffoot pedals v]

Standard mouse button actions assignment

Standard mouse button actions can not be
assigned to the buttons of this device

Moving mouse cursor with the wheels will work for all applications on this computer while PHOTOMOD System Monitor is running.

Device parameters

COM-port XY plane sensitivity - rJ + |:| Invert Z motion
Baud rate Z sensitivity - rJ + ] swap ¥ and ¥
Invert X motion Invert Y motion
[ oK ] [ Cancel ] [ Apply ]

"

Fig. 34. Immersion compatible hand wheels/foot pedals chosen in the Mouse configuration window

Set the Device parameters (see Section 6.2.2 above);
Click the Apply button to save changes;

Click OK to return to the Mouse setup window;

Q The rightmost part of Mouse setup window now consists of two tabs, one of which (Standart
Mouse) allows to setup standard mouse buttons, and the second one (Immersion com-
patible hand wheels/foot pedals) — marker’s actions after pressing each of three pedals.
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Activate vertex
Cancel selection
Correlate

Delete

Delete segment
Drag

Enter

Insert

Left

<No macro selected>

+ -

Insert before active vert...

Mouse R
Mouse M
Mouse X1

m

Mouse X2

Irmmersion Pedal 1
Irmmersion Pedal 2
Irmmersion Pedal 3

f )
& C\PHOTOMOD6.VAR\Config\MouseConfig.x-mcf - Mouse setup = | G S
bhe &%
Drriver active
Macros list Available buttens Standart mouse | Immersion compatible hand wheels/foot pedals
3D snapping - Mouse L

Close

Fig. 35. Configuration of Immersion compatible hand wheels/foot pedals

8. [optional] click the f] button in Mouse setup window, to open the Macro editor
and create new macro, if needed.

GeoMouse (EOMZ)

GeoMouse (EOMZ) — photogrammetric 3D-mouse that is used to move and precise
marker positioning by XYZ axis and to use buttons as hotkeys for most use functions.

ﬁ Connect GeoMouse (EOMZ) to a computer when it is switched off! Connect mouse USB port
to PS/2 port using adapter. At the same time connect RS 232 connector to COM port.

& GeoMouse (EOMZ) has 16 custom buttons, any three of them could be used as buttons of
standard mouse (see below).

@ GeoMouse (EOMZ) and standard mouse could be used at the same time.

To choose GeoMouse (EOMZ) and setup its parameters perform the following:

1. Afterinstallation of GeoMouse (EOMZ) to your PC, turn PC on and run PHOTOMOD

program;

2. Tosetup mouse choose Service » Mouse setup. The Mouse setup window opens;

3. Inthe Mouse setup window click the .. button. The Mouse configuration window

opens;
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4.

In the Used mice section select the GeoMouse (EOMZ) device from the drop-down
list;

. Mouse configuration = X

Changes made in this window define how selected pointing device works for all applications on this computer

Used mice

Standard mouse and: | GeoMouse (EQMZ) v

Standard mouse button actions assignment

A B
Button Assignment

GeoMouse buttons may be assigned standard mouse button actions. Such assignment will work for all applications on this computer. PHOTOMOD System
Menitor is necessary to setup the assignment.

Device parameters

COM-port - +  [|Invert Z motion
Z sensitivity = Ij + Swap X and Y
Invert X motion Invert Y motion
[ OK ] I Cancel J I Apply

Fig. 36. GeoMouse (EOMZ) chosen in the Mouse configuration window

Set the Device parameters (see Section 6.2.2 above);

[optional] Perform the Standard mouse button actions assignment (see Sec-
tion 6.2.2 above);

Click the Apply button to save changes;

Click OK to return to the Mouse setup window, to setup other buttons of special
mice or wheels/pedals;

The rightmost part of Mouse setup window now consists of two tabs, one of which (Standart
Mouse) allows to setup standard mouse buttons, and the second one (GeoMouse (EO-
MZ)) — other buttons of special mice or wheels/pedals.
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€ C\PHOTOMODT.VAR\ConfigiMouseConfig.x-mef - Mouse setup

]

Driver active
Macros list

L= &,

Available buttons

Standard mouse | GeoMouse (EOMZ)

3D snapping
Activate ve..,
Cancel sele...
Correlate
Delete
Delete seg...

Drag
4

+ -

<MNo macro selected>

Mouse L
Mouse R
Mouse M
Mouse X1
Mouse X2
GeoMouse 1
GeoMouse 2
GeoMouse 3
GeoMouse 4
GeoMouse 5
GeoMouse 6
GeoMouse 7
GeoMouse 8
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GeoMouse 14
GeoMouse 15
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Close

Fig. 37. Configuration of GeoMouse

9. [optional] click the E] button in Mouse setup window, to open the Macro editor

and create new macro, if needed.

Hand wheels/foot pedals 'Vector-A’ (EOMZ)

Hand wheels/foot pedals 'Vector-A’ (EOMZ) — hand wheels and foot pedals, developed
by EOMZ, that could be used to 3D processing data in the system. Distribution kit in-
cludes right and left hand wheels, (to move marker by plane), foot wheel (to move

marker by Z) and three foot pedals (for mouse button customized functions).

é Connect Hand wheels/foot pedals 'Vector-A’ (EOMZ) to a computer when it is switched off!

To choose Hand wheels/foot pedals 'Vector-A’ (EOMZ) and setup its parameters
perform the following:

1. Afterinstallation of Hand wheels/foot pedals Vector-A’ (EOMZ) to your PC, turn
PC on and run PHOTOMOD program;

2. To setup mouse choose Service > Mouse setup. The Mouse setup window opens;

3. Inthe Mouse setup window click the &.. button. The Mouse configuration window

opens;

4. Inthe Used mice section select the Hand wheels/foot pedals 'Vector-A’ (EOMZ)

device from the drop-down list;
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. Mouse configuration = X

Changes made in this window define how selected pointing device works for all applications on this cormputer

Used mice

Standard mouse and: | Hand wheels/foot pedals "Vector-A" (EOMZ) =

Standard mouse button actions assignment

Standard mouse button actions can not be
assigned to the buttons of this
device

Moving mouse cursor with the wheels will work for all applications on this computer while PHOTOMOD System Monitor is running.

Device parameters

COM-port XY plane sensitivity - Ij +  [|Invert Z motion

Z sensitivity = Ij + []SwapXand¥Y

[|Invert X motion [ Invert ¥ motion

[ ok || cance | [ appy

Fig. 38. Vector-A hand wheels/foot pedals chosen in the Mouse configuration window

5. Set the Device parameters (see Section 6.2.2 above);
6. Click the Apply button to save changes;
7. Click OK to return to the Mouse setup window;

The rightmost part of Mouse setup window now consists of two tabs, one of which (Standart
Mouse) allows to setup standard mouse buttons, and the second one (Hand wheels/foot
pedals 'Vector-A’ (EOMZ)) — marker’s actions after pressing each of three pedals.
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-
€ C/\PHOTOMODT.VAR\Config\MouseConfig.x-mcf - Mouse setup [
L= ¥, [
D Driver active
Macros list Available buttons

Standard mouse | Hand wheels/foot pedals "Vector-A™ (EOMZ) |

Mouse L
Mouse R
Mouse M
Mouse X1
Mouse X2

3D snapping

m | »

Activate ve..,
Cancel sele...

Correlate

Delete Vector-A Pedal 1
Delete seg... Vector-A Pedal 2
Drag % Vector-A Pedal 3
4 n 3

<MNo macro selected >

+ -

Close

Fig. 39. Configuration of Vector-A hand wheels/foot pedals

8. [optional] click the [ button in Mouse setup window, to open the Macro editor
and create new macro, if needed.

Stealth 3D Mouse devices

The system supports the 3D mice of the Stealth 3D Mouse-U and the Stealth 3D Mouse-
Z series of the ABS software developers;

c Connect Stealth 3D Mouse devices to a computer when it is switched off! After connecting of
Stealth 3D Mouse-Z series to PC through USB port, start mouse driver, using standard OS
Windows operations.

Q Customizing buttons are not supported for the Stealth 3D Mouse S1-U and Stealth 3D Mouse
S$2-U devices.

To choose Stealth 3D Mouse devices and setup its parameters perform the following:

1. After installation of Stealth 3D Mouse devices to your PC, turn PC on and run
PHOTOMOD program;

é After connecting of Stealth 3D Mouse-Z series to PC through USB port, start mouse driver,
using standard OS Windows operations.

2. Tosetup mouse choose Service » Mouse setup. The Mouse setup window opens;

3. Inthe Mouse setup window click the .. button. The Mouse configuration window
opens;
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4.

[optional] ]In the Used mice section select the Stealth 3D Mouse S1-U, Stealth

3D Mouse S2-U, Stealth 3D Mouse S1-Z or Stealth 3D Mouse S2-Z device from

the drop-down list;

. CAPHOTOMOD7.VAR\ConfigiMouseConfig.x-mcf - Mouse setup

D& .
[ Driver active

Macros list Available buttons Standard mouse | Stealth 30 Mouse 51U

3D snapping o Mouse L

Activate ve... = Mouse R

Cancel sele... Mouse M

Correlat Mouse X1
orrelate Mouse €2

Delete

Delete seg...

Drag %

« . »

<No macro selected>

+ -

Close

Fig. 40. Configuration of mouse buttons Stealth 3D Mouse S1-U

. Meuse configuration

Used mice

Changes made in this window define how selected pointing device works for all applications on this computer

Standard mouse and:

Stealth 3D Mouse 52-U

Device parameters

COM-port

+ Invert Z motion
Baud rate Z sensitivity + Swap X and Y
Invert X motion Invert ¥ motion
[ OK. ] [ Cancel ] [ Apply ]

Standard mouse button actions assignment

Standard mouse button actions can not be
assigned to the buttons of this device

XY plane sensitivity -

Fig. 41. Stealth 3D Mouse S1-U settings in the Mouse configuration window
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. CAPHOTOMOD7.VAR\ConfigiMouseConfig.c-mcf - Mouse setup E
L= B.
[] Driver active
Macros st N EEE IS Standard mouse | Stealth 3D Mouse 52-Z
30 snapping i Mouse L
Activate ve... = Mouse R
Cancel sele... Mouse M
Correlat Mouse X1
orrelate Mouse 10
Delete Stealth 1
Delete seg... Stealth 2
Drag 52 Stealth 3
ol v Stealth 4
<MNo macro selected > Stealth 5
+ - Stealth 6
Stealth 7
Stealth &
Stealth 9
Stealth 10
Close

Fig. 42. Stealth 3D Mouse S2-Z settings in the Mouse configuration window

[ . Mouse configuration @

Changes made in this window define how selected pointing device works for all applications on this computer

Used mice

Standard mouse and: | Stealth 3D Mouse 51-Z hd

Standard mouse button actions assignment

Button Assignment

Stealth 3D type Z buttons may be assigned standard mouse button actions. Such assignment as well ag moving mouse cursor with Stealth 3Dwill work for all applications on this
computer while PHOTOMOD System Monitor is running.

Device parameters

COM-port XY plane sensitivity - r.l + I:‘ Invert Z motion
Baud rate Z sensitivity - U + Swap X and Y
Invert ¥ motion Invert ¥ motion
[ QK ] [ Cancel ] [ Apply ]

Fig. 43. Stealth 3D Mouse S1-Z settings in the Mouse configuration window

5. [optional] Set the Device parameters (for the Stealth 3D Mouse S1-Z or Stealth
3D Mouse S2-Z device, see Section 6.2.2 above);
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6. [optional] Perform the Standard mouse button actions assignment (for the
Stealth 3D Mouse S1-Z or Stealth 3D Mouse S2-Z device, see Section 6.2.2
above);

7. Click the Apply button to save changes;

8. Click OK to return to the Mouse setup window, to setup other buttons of special
mice or wheels/pedals;

The rightmost part of Mouse setup window now consists of two tabs, one of which (Standart

Mouse) allows to setup standard mouse buttons, and the second one — other buttons of
the Stealth 3D Mouse S1-Z or Stealth 3D Mouse S2-Z device.

9. [optional] click the [ button in Mouse setup window, to open the Macro editor
and create new macro, if needed.
Atlas 3D mouse

Atlas 3D mouse — specialised mouse from Uzman Engineering Co., Ltd company that
is used for stereovectorization. Distribution kit includes power adapter and an interface
device for connecting a mouse to the COM-port.

c Connect Atlas 3D mouse to a computer when it is switched off!

QA Atlas 3D mouse has 10 custom buttons, any three of them could be used as buttons of standard
mouse (see below).

é Atlas 3D mouse and standard mouse could be used at the same time.

To choose Atlas 3D mouse and setup its parameters perform the following:

1. After installation of Atlas 3D mouse to your PC, turn PC on and run PHOTOMOD
program;

2. To setup mouse choose Service > Mouse setup. The Mouse setup window opens;

3. Inthe Mouse setup window click the &.. button. The Mouse configuration window
opens;

4. In the Used mice section select the Atlas 3D mouse device from the drop-down
list;
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. Mouse configuration = X

Changes made in this window define how selected pointing device works for all applications on this cormputer

Used mice

Standard mouse and: | Atlas 30 mouse h

Standard mouse button actions assignment

A B
Button Assignment
Bl
B2
B3
B4

Atlas 3D buttons may be assigned standard mouse button actions. Such assignment as well as moving mouse cursor with Atlas 3D will work for all applications on

Device parameters

COM-port XY plane sensitivity - Ij +  [|Invert Z motion
Baud rate |115200 ~ | Z sensitivity = Ij + []SwapXand¥Y
Invert X motion Invert Y motion

[ ok || cance | [ appy

Fig. 44. Atlas 3D mouse chosen in the Mouse configuration window

5. Set the Device parameters (see Section 6.2.2 above);

6. [optional] Perform the Standard mouse button actions assignment (see Sec-
tion 6.2.2 above);

7. Click the Apply button to save changes;

8. Click OK to return to the Mouse setup window, to setup other buttons of special
mice or wheels/pedals;

Q& The rightmost part of Mouse setup window now consists of two tabs, one of which (Standart
Mouse) allows to setup standard mouse buttons, and the second one (Atlas 3D mouse) —
other buttons of special mice or wheels/pedals.
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. CAPHOTOMODE.VAR\ConfighMouseConfig.x-mcf - Mouse setup

SRR X
e &%
[T Driver active
Macros list [miions lwl Atlas 3D mouse
3D snapping - Mouse L
: Mouse R
Activat rt
ctivate ve ex | Meuse M
Cancel selection 1 Mouse X1
Correlate Maouse X2
Delete Atlas3D B1
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<No macro selected> Atlas3D A4
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Fig. 45. Configuration of Atlas 3D mouse

9. [optional] click the [ff] button in Mouse setup window, to open the Macro editor
and create new macro, if needed.

6.2.3. Macro editor

The system has set of macros for mouse buttons or pedals and there is a possibility to
edit or create new macros.

Macro list — set of operations available to attach them to mouse buttons or pedals of
specialized devices, if it is used in stereovectorization.

To view macro list is used the Mouse setup :: Macro editor window.

The list of macros, included in a standard mouse driver, is displayed In the Macros list
section.

In the Action on button down/up sections is displayed a list of action sequence on
button down/up to run the macro selected in the Macros list.

Toolbar of the Macros list section contains buttons used to perform the following oper-
ations:

4+ —allows to create new macros with defined name;

+ — —allows to remove selected macros from the list;

= — allows to create a copy of macros selected in the list;
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Toolbars of the Action on button down/up sections are similar and contain buttons
used to perform the following operations:

« = —allows to remove action;

« % — allows to move action down in the list;

« 4 — allows to move action up in the list;

« ¥ —allows to automatically finish sequence for button down. E.g., if Ctrl+Z is attached
to a button down, it is enough to attach Ctrl and Z keys down only and click the ¥
button of the Action on button up section. Releasing Ctrl and Z added to the Macros

list automatically.

In order to create a new macros perform the following:

1. Click the ] button in the Mouse setup window. The Mouse setup :: Macro editor.

. Mouse setup : Macro editor

(S5

Macros list

Actions on button down

3D snapping
Activate vertex
Cancel selection
Correlate

Delete

Delete segment
Drag

Enter

Insert

Insert before active vertex
Left

Pan

Parallax=0

Redo

Select object
Select vertex
Snap to ground
Tab

Undo

Vertex to marker
Zoom 1:1

Zoom in

Zoom out
Zoom to fit

Press "Ctrl" key

Press "Alt" key

Press "Shift” key

Press left mouse button

+ -t W

Actions on button up

Release left mouse button
Release "Shift" key
Release "Alt" key

Release "Ctrl" key
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Fig. 46. The Macro editor window

2. Click the + button in the Macro list section and input a name of a new macros:
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’ Macro editor l Y |ﬁ|

Input name for the new macro

K ] ’ Cancel

Fig. 47. Adding new macro

3. Choose created macros in the Macro list.

4. Click the + button in the Action on button down section to choose action and
add it into macros. The New action window opens.
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Fig. 48. Adding new action into macros

5. Choose an action:

* Press the chosen mouse button — choose in the list the mouse button should
be pressed: left, right or middle;

* Press the chosen key — on keyboard image click to the chosen key. Selected
key is marked by green color.

6. Click OK. Chosen action is displayed in the Action on button down section.

7. Repeat steps 4-6 to create more actions to macros.
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8. [optional] Actions that will be performed during releasing selected mouse button,
recorded in the macro in the Actions on button up. To add action automatically,
click the '# button.

9. Click OK to save macros.

7. Interface and its elements

A Some interface elements of the system may be displayed improperly with non-standard Windows
font size settings. In order to configure Windows font size choose Start > Control panel > Screen
in main panel of Windows. The Screen window opens. Make sure that there is enabled Small

- 100% (by default) font size option.

7.1. Work area interface

On the stages of project processing 2D-window is work window. It is used to view,
create and edit DTM, vector objects, TIN, etc.

Block scheme 2D-window opens automatically on startup. Contents of displayed objects
depend on Layer manager parameters (see the Section 8.2.7).

§ On the Windows tab of the Settings windows the Automatically open 2D window checkbox
is set on by default to open 2D-window on startup (see the Settings User Manual).
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Fig. 49. Work area main elements
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The GUI contains the following elements:

title with name of opened project (A);

+ the main menu bar (B);

the main toolbar is used for quick main program functions access (C);

the additional toolbars is used for quick miscellaneous program functions access (O);

% The system interface is flexible for customizing the locations of additional toolbars according

to the user’s needs. Additional toolbars can either be fixed in designated sections of the work

area (top or bottom, right or left) or undocked by the user and placed in any place in the 2D
window.

Depending on the user-set interface configuration, docked additional toolbars can be partly
minimized (some buttons will be hidden). Docked (optionally minimized) subtoolbars are
displayed as one line, vertical or horizontal, depending on their location.

By default, additional toolbars are docked at the top of the workspace, to the right of the main
toolbar. Additional toolbars are marked with a special icon | located on the left or top (de-
pending on the location) edge of the panel. To maximize the toolbar, click ¥ (%) on the right
(at the bottom).

Undocked additional toolbars are always displayed horizontally, in one line, in a fully maximized
form. To undock a toolbar (or pinpoint it in any place), move the cursor over the icon and,

holding down the left mouse button, drag the toolbar to the area of its targeted location (the
cursor’s shape changes (i::) when it is possible to capture the toolbar).

+ the 2D-window, used for data displaying (N), contains the following elements:
o the toolbar is used for the 2D-window modes managing (D);

o the work area is used for viewing and processing with loaded data of mosaic project
(N);

o the axes direction of project coordinate system (M);

o the navigation bar is used for fast moving on the specified block images area of
mosaic project (E);

% To do this, click on the chosen point in Navigation bar. To set the layers visibility, move
to the Navi tab in the layer manager.

o the Layer manager is used for managing of mosaic project layers (F);

o current marker coordinates (K);
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@ If a block scheme adjusted in free model is displayed in the window, the ‘# symbol shows
before current marker coordinates. If there is displayed a block scheme, created by tie
points without layout, the ™’ symbol shows.

@ GSD value is displayed to the right of the current marker coordinates (excluding radiometric
correction windows).

@ RGB brightness values are displayed to the right of the current marker coordinates. When
placing the marker within the work area, the following brightness values are displayed:
R=128 (=128 B=128.

o the status bar is used to edit brightness, contrast and gamma-correction in a work
area (L);

? Shift+F8 hotkeys allow to show/hide this status bar.

o project coordinate system (G);

§ Double-click on coordinate system to change it in case of work without project or to open
the Project properties window in other cases.

§ If the is lat/lon/alt coordinate system is used, in the status bar is displayed lat/lon in grade
by XY and altitude in meters.

o scroll bar in 2D-window (H);

o the Status bar, near the current marker coordinates (K), displaying messages of
error or success (e.g., after marker was not successfully placed to ground with
correlator — Bad point: correlation error).

The system interface is flexible for customizing the locations of 2D-windows according
to the user’s needs. The 2D-window can either be fixed in designated sections of the
work area (by default) or undocked by the user and placed in any place in the work
area.

To undock 2D-window (or pinpoint it in any place), move the cursor over the window
title and, holding down the left mouse button, drag the window to the area of its targeted
location.

% Use the & button on the right side of the window title to undock a docked window.

For convenience, the system also allows you to maximize some key 2D windows,
“stretching” them to the full width of the screen work area. Thus, such a window can be

displayed in three states — “docked”, “undocked”, and “maximized”.
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To stretch a 2D window (for example, a window displaying a block scheme) to the full
width of the screen, perform the following:

1. Undock the 2D window. The maximize button O is displayed in the main toolbar
of that window;

2. Click O in the toolbar. The window fits the full width of the screen work area. The
main toolbar of the window displays the restore & button;

3. [optional] To restore down, click & .

@ To quickly return a window to the previous configuration, double-click the left mouse button
on the window title.

Several similar windows docked within one work area make up a group of tabs (e.g.,
2D windows). To go to the desired tab, left-click on its title. To close a tab (and the
corresponding window), click £ in the tab title.

7.2. The main system toolbar

Table 7. Brief description of main toolbar

Buttons Function

= to open block editor window (see the “Project creation” User Manual)

e to reload project to display the last saved version of project

¥ to perform import of exterior orientation from metadata

e to open block layout window (see the “Aerial triangulation” User Manual)

to open block editor window (see the “Project creation” User Manual)

B to display all images, loaded to project, in the Block scheme window

42 to display only selected on scheme images in the Block scheme window

& to open catalogue of all ground control points, including non-measured on block images
(see the “Aerial triangulation” User Manual)

= to open catalogue of all tie points with their measurements (see the “Aerial triangulation”
User Manual)

[is to open the Exterior orientation data list

T to load triangulation points

&t to open the adjustment toolbar

] to open 2D-window for selected stereopair (see the “Vectorization” User Manual)

pi] to open the Orthorectification toolbar to create orthoimages

B to launch the DustCorrect module to edit MS-TIFF images (see the “Project creation”
User Manual)

4 to launch the GeoMosaic programm to create othomosaic (see the “Orthophotomaps
creation” User Manual)

-] to run the GIS Panorama Mini (this software is not included with the PHOTOMOD but
can be installed separately)
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Buttons Function

B to create dense digital elevation model (DTM), which cell size coordinates to one pixel
of image, using SGM (Semi-Global Matching) method (see the “Dense DEM generation
using SGM method” chapter in “Create DTM” User Manual)

L to launch the 3D-mod module

i) to create, open and save regular nodes grid (see the “Create DTM” User Manual)

= to load vector file into the project (see the “Vectorization” User Manual)

= to load DEM file

= to load georeferenced raster image to project as a layer

E to load web-map

g to undo the last action (see the “General system’s parameters” User Manual)

to display the list of last actions (see the “General information about system” User
Manual)

T to redo the last undone action (see the “General system’s parameters” User Manual)

B to open the Marker window (see the menu description in “Vectorization” User Manual)

i to perform the Measurements in 2D-window (see the menu description in “Vectorization”
User Manual)

= to tile 2D-windows

iy to stack 2D-windows

™ to arrange 2D-windows in a tabsheet

[ to arrange 2D-windows evenly

8= to refresh all opened 2D-windows

b4 to close all 2D-windows

to open the general program parameters window (see the “General system'’s parameters”

User Manual)

7

If the GIS Panorama executable file is not found, an appropriate system message will appear.
The software description and URL hyperlink (for download) are indicated in this message.

L5

i !
. Question lﬁ

Panorama executable file not found
Lise following link in order to dowload Panorama software
Edit path to executable file in settings?

fes o]

"

Click Yes to go to path settings (see the “Paths settings” chapter of the “General system’s
parameters” User Manual.
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7.3. Brief description of system menus

The main menu bar contains set of menus used to create project, image orientation, to
work with vectors, TIN, DEM and also to launch additional modules and setup of general

system’s parameters.

Table 8. Main menu

Menu

Function

Project

contains menu items to create, open, save and
convert project, and also to get an information about
project

Block

to form images block of mosaic project

Orientation

contains menu items to interior orientation, load and
use ground control and triangulation points, exterior
orientation parameters and also to import and export
triangulation points for various formats

Grid

to create, open and save regular nodes grid (see
the “Create DTM” User Manual)

Terrain

contains Points, TIN, DEM and Contours sub-
menus (see the “Create DTM” User Manual), LAS
submenu (see the “LIDAR Data processing” User
Manual) and 3D-Mod submenu (see the “Three-di-
mensional modeling” User Manual)

Vectors

purposed for creating, editing, import/export of vec-
tor data (see the menu description in "Vectorization’
User Manual)

Rasters

to load and georeferenced raster images, and also
to launch additional modules for editing and orthorec-
tification images (see the “Creating project” User
Manual)

Edit

purposed for modes choosing to select and draw
vector objects, to transform curves, repeat/cancel
the last operation (see the menu description in
‘Vectorization’ User Manual)

Service

to launch applications, load additional data, set
general parameters and edit coordinate systems
(see the General system’s parameters User Manual)

Windows

to open additional toolbars and windows (new 2D-
window, Marker and Measurements windows, win-
dow of Object Attributes)

Help

to start the 'Help’ system
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8. General system’s windows

8.1. The “Windows” menu

Table 9. Brief description of the “Windows” menu

Menu items

Function

Toolbars

contains menu items allows to open additional tool-
bars

Show all toolbars

to show all toolbars

Find all toolbars

to show all opened toolbars in visible part of the
screen

temporarily hide toolbars (TAB)

to hide/show all opened toolbars

Block editor (Ctrl+Alt+B)

to open block editor window (see the 'Project cre-
ation’ User Manual)

2 Block layout (Ctrl+Alt+L)

to open the block layout window (see the ’Aerial tri-
angulation’ User Manual)

Image list...

to open the Images list window (see the 'Creating
project’ User Manual)

New 2D-window (block)

to open window with a block scheme

0l New 2D-window (stereopair) (Ctrl+Alt+W)

to open window with a stereopair

New 2D-window (single image)

to open window with image selected on a block
scheme

Open image under marker

to open all 2D-windows with marker place. Press
and hold Alt key while clicking the menu item to
open images with 1:1 zoom , otherwise, full images
are displayed

Close all single image windows

to close all 2D-windows with images

#¥ Refresh all 2D-windows

to refresh information in all opened 2D-windows

#¢ Refresh all 2D-windows

to close all 2D-windows

Arrange

contains menu items allow to arrange opened 2D-
windows in a work area with one of the following
ways:

« BB Tile — to tile 2D-windows;

+ [l Row — to row 2D-windows;

+ = Column — to column 2D-windows;

« [® Stack — to stack 2D-windows;

. ™ Arrange 2D-windows in a tabsheet;

. Evenly — to arrange 2D-windows evenly.

Stereopairs

contains menu items allows to move to other stereo-
pairs (see the 'Vectorization’ User Manual)
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Menu items

Function

3D-window

to open the 3D-window

i Marker window (Ctrl+Alt+C)

to open marker parameters window (see the "Vec-
torization’ User Manual)

4is Measurements window (Ctrl+Alt+D)

to open window that allows to perform measure-
ments by images in 2D-window (see the “Vectoriza-
tion” User Manual)

Triangulation points coordinates

to show table with triangulation points coordinates

Triangulation points view control

to choose triangulation points to display

Contours classifier table

to open contours classifier window to edit paramet-
ers of contours display (see the “DTM generation”
User Manual)

EEClassifier to open the Classifier window to show set of
standard vector objects attributes (see the Classifier
chapter in the “Vectorization” User Manual)

Objects list to display list of active layer vector objects (see the

“Vectorization” User Manual)

Objects attributes

to open the Attributes window to display attributes
of selected vector objects (see the Vector objects
attributes chapter in the “Vectorization” User
Manual)

Marker motion in pixel coordinates

allows to set on the mode allows to move marker in
stereopair 2D-window in pixel coordinates

Zoom all in (Shift+* NumPad)

to zoom in all 2D-windows

Zoom all out (Shift+/ NumPad)

to zoom out all 2D-windows

Layer view mask

to use a view mask for active layer

Windows list

to view list of opened 2D-windows

8.2. 2D-window

8.2.1. General information

There are the following types of 2D-window, available in the system:

* block scheme window;
 stereopairs window;

+ single window of selected image.

Choose Windows > New 2D-window (block) to open a block scheme window. It is
also opened automatically when loading and creating a project.

To open stereopair 2D-window, place marker on image or select image in the Block
editor window and choose Windows » New 2D-window (stereopair) (Ctri+Alt+W) or
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click the button on the main system toolbar. As a result, 2D-window with stereopair of
selected and next images opens.

@ In case of the last image in the strip was selected, stereopair consist of selected and previous
images.

To open 2D-window of single image, select an image in the block scheme 2D-window
or in the Block editor window and choose Window > New 2D-window (single image).

@ It is possible to use more than one opened 2D-window at the same time.

To synchronize marker in all opened 2D-windows is used Edit » Sync markers menu
item.

8.2.2. 2D-window toolbar

The toolbar of 2D-window contains the following buttons:

« &% _ allows to turn on/off panning mode: press and hold down the mouse button to
move image in 2D-window after mouse moving;

« T F4 — turn on/off 'marker=mouse’ mode;

- [# — allows to center image on marker (move point with marker to the center of the
2D-window);

« & F6 — turn on/off fixed marker mode;

» sl (Shift+F7) — [only for stereopair 2D-window] turn on/off mode of fixed parallax
marker;

« 2 F9 — [only for stereopair 2D-window] — turn on/off stereomode (anaglyph or page-
flipping) (see the Vectorization User Manual);

« & (F11) — [only for stereopair 2D-window] allows to switch stereo phase (to swap
left’ and 'right’ images) in stereo mode, in mono mode allows to display left/right image
of stereopair (see the Vectorization User Manual);

. (F2) — [only for stereopair 2D-window] — allows to set the 0 value for parallax in a
marker position (see the Vectorization User Manual);

» ++ (F3) — [only for stereopair 2D-window] is used to return parallax parameters to
default after using the -- button (F2) (see the Vectorization User Manual);

[ - show/hide the Navigation bar and Layer manager,

£3 — show/hide the Navigation bar;
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« o (Ctrl+F8) — show/hide scroll bars;

- &, 8, & & L and -* — buttons allowing to setup image scale in 2D-window;

@ Description of buttons to setup image scale in 2D-window see in the Section 8.2.3.

* [optional] shortcut commands — are the custom button combinations for quick access
to various functions when working with the layers of Vectors, DEM, Raster, Grid, or
TIN types. These buttons are available for a user when a layer of one of the above-
mentioned types is downloaded and editable (#). Shortcut commands are similar to
hotkeys and can be also customized.

@ Shortcut commands are described in Section 8.2.4.

% Layer types are described in Section 8.2.7.

8.2.3. Image scaling in 2D-window

Image scaling of 2D-window is performed with the following buttons of 2D-window
toolbar:

« & - allows to zoom in an image by one step (*);
« & - allows to zoom out an image by one step (/);

- &/ — allows drag a rectangle by mouse to zoom in area of image;

% Press Ctrl+Alt hotkeys (or click an appropriate button to enable the & mode) and drag a
rectangle by mouse to zoom in area of image. Press Ctrl+Alt+Shift hotkeys (or Shift key
only, if the & mode is already enabled) and drag a rectangle by mouse to zoom out area of
image.

- & - allows to fit to page data of opened layers (Alt+Enter);

% To apply this function to a certain layer, select the layer in the Layer manager and select
Edit > Fit window to active layer (or choose Zoom to fit in the shortcut menu for this layer
in the Layer manager).

« @ _ allows to display data in 1:1 scale, when one pixel of the image corresponds to
one pixel on the screen (Alt+1);

« C§ — allows to sequentially display preset zoom (Alt+5);
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@ To edit preset zoom choose Service > Settings and move to Windows | Zoom tab (see the
‘General parameters’ User Manual).

Alt+0 hotkeys is used to return to previous scale.

To set scale manually, click the =* button and move slider.

Press and hold Ctrl+Alt hotkeys and click on image to zoom in or Ctrl+Alt+Shift to
zoom out image in the window.

Press and hold Alt key and mouse button for panning. Slide bars are also used to move
image.

To move fast in area of image is used the Navigation bar.
8.2.4. Shortcut commands

The system allows to use so called shortcut commands, the custom button combinations
for quick access to various functions when working with the layers such as Vectors,
DEM, Raster, Grid, or TIN.

These buttons are placed in the right part of the 2D-window toolbar, after the buttons
used to customize image scaling in the 2D-window (see the chapter above). These
buttons are available for a user when a layer of one of the abovementioned types is
downloaded and editable (#).

5 Layer types are described in Section 8.2.7.
Shortcut commands have functionality similar to hotkeys’ and are supposed to be used

together with them. The shortcut commands are pre-installed for each of the abovemen-
tioned layers and are available for customizing. For this, perform the following:

1. Choose Service » Customize fast commands. The Customize Shortcut Com-
mands window.
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. Customize Shortcut Commands &l
Data type: |DEM b

Commands list

Delimiter (—) Delimiter (—) -
B Bilateral DEM filter... ﬁ'g Shift...
@;, From TIM... B Transform to ancther coordinate system...
]® Interpolate elevation in selected polygons... Delimiter (—)
Extract classes from DEM T Median filter...
é Set elevation in selected polygons... M E Slope based filter.
E DEM classification — Delimiter (—) =
o .ljl'zli-'-i Create histogram by DEM
—— | @& Check against triangulation points
i @ Check against vector objects
‘E‘ 1.3 Search for DEM areas
—1 | Delimiter (—)
¥ B Build difference DEM...
Recover

Cut by selected polygons...
B cut NULL edges...

Hd o~ mrea =

Fig. 50. The Customize Shortcut Commands window

2. Select data type — Vectors, DEM, Raster, Grid, or TIN. The list of available com-

4.

mands applied when working with the selected type data is displayed in the left part
of the window. The list of commands to be displayed in the 2D-window toolbar are
given in the right part of the window;

In the list places in the left part of the window, select one or more required com-
mands and click the ‘= button (or click the == button to move all the commands).
As aresult, all the commands or the selected ones are moved to the list of displayed
commands in the 2D-window toolbar (right);

é To cancel the command selection, choose this command in the right part of the window
and click the ‘= button (or click the == button, to clear out the list of commands displayed

in the 2D-window toolbar).

é To move the selected command down in the list on the right, click the & button; to move
it up, click the 4F button.

é The &7 button allows to come back to default settings.

@ Move the Delimiter (—) to the list of commands displayed in the 2D window the required
number of times in order to visually group the commands as needed. Move the delimiters
using the d and 4 buttons, similar to the shortcut buttons.

[optional] if required, customize shortcut commands for another type of data;
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5. Click OK.
8.2.5. Stereopair 2D-window
Stereopair 2D-window is used to work in stereo mode.

To open a stereopair 2D-window, select images in the Block scheme or Block editor
windows with one of the following ways:

+ select two images with overlap;

+ select one images. In the stereopair window opens the best stereopair, found with
parametric search or stereopair consists of selected and next images in the strip.

? In case of the lastimage in the strip was selected, stereopair consist of selected and previous
images.

$EFL EEKSS
Ed Marker

3 Raster

e aEEE

Fig. 51. Stereopair 2D-window

During displaying stereopair in 2D-window, the Navigation window displays the left image
of the stereopair.

The system provides possibility to pass to the adjacent stereopair when working in 2D-
window.

The Change stereopair toolbar, hotkeys and also Window > Stereopairs menu items
are used to move to other stereopair.
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Table 10. Brief description of the Stereopairs menu

Buttons and menu items Function
=» Next stereopair (Ctrl+Alt+RIGHT) to open next stereopair in the strip
#= Previous stereopair (Ctrl+Alt+LEFT) to open a stereopair with previous image in the strip
it Stereopair up (Ctrl+Alt+UP) to pass to a stereopair located on one strip up
4 Stereopair down (Ctrl+Alt+DOWN) to pass to a stereopair located on one strip down
[l Select stereopair to select an arbitrary stereopair to pass to
[ Auto change stereopair (Ctrl+J) to select a stereopair to pass to automatically
Open reverse stereopair to swap images of opened stereopair and to rotate
image by 180 degrees

Depending on the object of vectorization for different stereo vectorization methods the
system provides the following modes of marker work:

* moving marker mode — The operator moves the marker arbitrarily by image ‘fixed’ in
XY plane. In this mode operator moves moving marker in any direction in XY plane
over 'fixed’ image using mouse with pressed left button or arrow keys, to move the
image in Z operator uses Page Up, Page Down hotkeys or mouse wheel,

@ Moving marker mode is enabled in the system by default, besides, the system switches to it
when any other mode of marker control is turned off.

- & fixed marker mode (F6) — marker is always in the center of the screen, horizontal
parallax on it is zero.

@ In fixed marker mode a step of model move by Z is defined arbitrarily.

Fixed marker mode is intended for users who have work experience on stereo devices. The
advantage of the mode is the ability to vectorize extended objects continuously with a constant
automatic moving of image.

To place the marker on the surface of relief model in stereomode use the Page Up
and Page Down hotkeys (in XY plane) or mouse wheel rotation to move marker by
Z. To move image in XY plane use mouse or arrow keys.

To change horizontal parallax in fixed marker mode it is possible to use Shift+tmouse
wheel rotation and Ctrl+Shift+mouse wheel rotation shortcuts by X and Y accord-
ingly. To set parallax to zero in marker position the F3 hotkey is used.

« T marker=mouse mode (F4) — mouse cursor is invisible, all mouse moves lead to
marker moving without additional clicks of mouse buttons;

? This mode is used for vectorization of extended objects breaklines.
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é The marker=mouse mode is not available if the alignment mode is enabled.

* it fixed parallax marker mode (Shift+F7) —in modes of moving or fixed marker allows
to fix marker parallax value.

§ To change marker parallax value.are used the same keys as in fixed marker mode.

To move marker on block scheme are also used keys of NumPad.

@ Step of marker moving along Z axis is discrete and inversely proportional to the current image
increase when scaling. For fast marker moving along Z use mouse wheel rotation while holding
pressed Alt key.

The system also allows to place marker on a model surface automatically using correl-
ator. The Space key is used to do this.

* [optional] If the correlator failed to work the Status panel displays the Bad point
message and the system produces warning audio signal;

* [optional] In case of successful correlator operation, correlation coefficient (Corr) and
autocorrelation coefficient (AQ) values are displayed in the Status panel.

é High autocorrelation coefficients may indicate that the marker is located in an area containing
contrasting, but similar and adjacent objects, mainly of anthropogenic origin, for example sections
of a railway track or road markings.

é To configure threshold values of the correlation coefficient and autocorrelation coefficient, choose
Service ) Settings. The Settings window opens. Set the required values in the Block scheme
section of the Correlator tab (see the “Correlator settings” in the “General system’s parameters”

User Manual).

To set up marker parameters choose the Service » Settings. The Settings window
opens. In the Window | Marker (stereopair) tab choose type, color and size of marker.

To change horizontal parallax in stereo mode the system provides the Shift+PgUp/PhDn
hotkeys, and Shifttmouse wheel rotation.

é For fast parallax change for high values, move the mouse while holding Alt+Shift+tmouse
middle button.

8.2.6. Brightness and contrast settings

To display the status bar used to adjust the image brightness, contrast and gamma-
correction for a single image or both images of a stereopair use the Shift+F8 hotkeys.
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The %, &, _! sliders are used to adjust a brightness, contrast and gamma-correction
of a stereoimage. Tools located in the right part allow to select color channels, which
correction settings will be applied to.

If the & button is set on, adjustment settings is performed by all channels at the same
time. Otherwise, adjustment settings is performed only for selected channel.

W 1 0 1 . 1 E RN o BIE=)
Fig. 52. Status bar used to adjust image brightness and contrast

Parameters in stereopair 2D-window changes at the same time for both images if the
¢ button is pressed, otherwise — for left O or right [l image of stereopair separately.

To invert image’s colors, right click the settings panel and select the Revert intensity
item.

To restore brightness and contrast settings to default values, right click the settings
panel and select the Reset item.

? Brightness, contrast and gamma settings are not restored after the module restart.

8.2.7. Layer manager
The system supports the following types of layers and their parameters:
* Marker — layer with marker and direction of the axis;

* Raster — layer contains loaded georeferenced images (see the “Project creation”
User Manual);

* Block scheme — layer with a block scheme that consists of the following elements:
o Strip names — names of strips displayed in the center of each strip;
o Image names — names of loaded images displayed in the center of each image;
o Strip outlines — outlines of each strip in a block scheme;
o Image outlines — outlines of each image in a block scheme.

+ Triangulation points — layer contains measured tie and ground control points (see
the “Aerial Triangulation” User Manual);

é Choose Orientation > Load triangulation points to display triangulation points in the 2D-
window. These points also could be saved to a vector layer and used to consider in DEM
creation (see the “DTM Generation” User Manual).
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* Pre-regions — layer contains pre-regions (vector layer);
@ The name of a vector layer containing pre-regions is the following: <Layer name> (Pre-re-
gions).
« Layer border — a vector layer containing a rectangle polygon that visualize borders

of the selected layer of any type;

% A name of a vector layer with a border is the following: * Border for layer <Layer name>.

» Grid — layer contains regular grid that is used to create points (see the “DTM gener-
ation” User Manual) with the following objects:

o Limits — frame of created grid (red line);
o Nodes — nodes of grid (green points).

* TIN — layer contains triangulation irregular network (see the “DTM generation” User
Manual) with the following objects:

o Contours;
o Triangles.

« DEM - layer contains digital evaluating model (see the “DTM generation” User
Manual) with the following objects:

o Selection — frame of DEM selected area;
o Frame — rectangle frame of DEM,;
o Raster — DEM.

» Vectors — layer contains vector objects (see the “Vectorization” User Manual) with
the following objects:

o Selected objects — vector objects, selected in a 2D-window;
o Labels — labels for vector objects;

o Point objects — only points of the layer;

o Line vertices — vertices of linear/areal objects;

o Lines — linear objects and frames of areal objects.

» Contours — vector layer with contours (see the “DTM generation” User Manual);
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@ The name of a vector layer containing contours is the following: <Layer name> (Contours).

* Points — vector layer with points (see the “DTM generation” User Manual);

» Georeferenced external data — (see the “Georeferenced external data” section of the
“Aerial triangulation” User Manual).

To change general parameters of displaying for layers are used corresponding tabs of
the Settings window (see the “General parameters” User Manual).

The system provides possibility to manage layers, loaded in the project. Layer manager
is used for that.

Basic | Mawi |

+143v2 EEH &8
Marker
> D o E AutoCutlines (Wectors)
Selected objects
Labels
Point objects
Line vertices

Lines

#O0 « [T
Smooth contours
Contours
Triangles

> [ 4 dem2m (DEM)
Selection
Frarme
Raster

5[] 4 Block scheme
Strip names
Image names
Strip outlines
Image outlines

» Raster

WOOOOOO{{VOVNOOOOOOO 0@

Fig. 53. Layer manager

The [ button of the 2D-window toolbar allows to show/hide Layer manager and Nav-
igation bar.

é Ctrl+F11 hotkeys are also used for that.

The Main tab is used to adjust layer displaying in 2D-window, the Navi tab — to adjust
objects displaying in navigation bar.
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In the Layer manager is displayed the list of all opened layers and the following elements
of layer management:

- 4 ¥ 4 and F - is used to change layers order;

5 The system allows you to pin a layer using the appropriate item in the drop-down menu (see
below) or by double-clicking the left mouse button (repeat this operation to unpin a layer).

Pinned layers are marked with the appropriate icon () and are always located at the top
of the layer list. If they are available, the buttons for changing the order of layers (4, ¥, 4
) work separately within the two groups of layers — pinned and unpinned.

i@ — allows to show all layers of the selected type;

 EE — allows to hide all layers of the selected type;

« = — allows to invert all layers of the selected type visibility;
- # - allows to close all the layers of the selected type;

- # - allows to close the layer group (selected in the Close selected layers window):

r. Close selected layers @1

@ an

[] dem2 (DEM)
[] Bektopsl (Vectors)

] (TN

QK ] l Cancel

Fig. 54. The Close selected layers window
the Close selected layers window toolbar contains the following elements:
o K — allows to select all items;

o ' — allows to deselect all items;
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O

¥ — allows to invert items selection.

to close the layer group set the appropriate checkboxes and click OK.

s ®

L

— layer is visible in 2D-window;

— layer is invisible;

@ If layer visibility changes, layer status (active/editable) does not change.

§ Visibility of any layer element could be set separately.

« # —layer is active and editable;

é The k@ mark near the layer name means that this layer is not available for manual editing at

the moment (see the “Orthophotomaps creation” User Manual).

« > —layer is active, but not editable;

« [_]- displays general color of layer objects;

O

It is possible to adjust color, symbols and symbol size of objects in the vector,
points, pre-regions and contour lines layers (see the “Vectorization” User Manual);

It is possible to adjust color, symbols and symbol size of grid nodes in the grid
layers (see the “DTM Generation” User Manual);

For georeferenced raster and DEM layers could be changed transparency of layer
visibility in 2D-window (see the “DTM Generation” User Manual);

é Changing of layer transparency is possible only if the Do not use textures for precision
raster display checkbox is set off on a System tab of the Settings window (see the
General systems parameters User Manual).

For a TIN layer could be changed colors of triangles and contours (see the “DTM
Generation” User Manual);

For a triangulation points layer could be changed colors of points XY and Z coordin-
ates labels (see the “Triangulation points display in 2D-window” chapter of the
“Aerial triangulation” User Manual);

For the Block scheme layer could be adjusted color of the following objects:

m images;
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m irregular strips;

m image names;

m regular strips;

m names of selected images.

To change colors of objects (for example — for the Block scheme layer) perform the
following:

1. Double-click on layer objects color button ([_]) in a Layer manager. The Raster
layer parameters window opens (for the Block scheme layer).

& Layer display settings &J

Layer: Block scheme
Colors Symbols

Images
Irregular strips
Image names

Regular strips

1111

Selected image names

[ oK l | Cancel | | Apply

Fig. 55. Raster layer parameters (“Block scheme” layer)
2. Double-click on the object’s color in the Colors section and choose necessary
color from standard color palette.
3. Click the Apply button to display changes in 2D-window.
4. Click OK to save parameters.

Right-click menu is used to save, close or to obtain info about layer. Right-click on the
name of layer in the Layer manager to open it.

Right-click menu of selected layer can contain the following menu items, depending of
the layer type:

« .i) Information — allows to open layer info image;

« [E Pin layer / Unpin layer — pinned layers are marked with the appropriate icon ()
and are always located at the top of the layer list. If they are available, the buttons
for changing the order of layers (4, ¥, 4 F) work separately within the two groups
of layers — pinned and unpinned.
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@ The system allows you to pin a layer using the appropriate item in the drop-down menu (see
below) or by double-clicking the left mouse button (repeat this operation to unpin a layer).

 [optional] Properties — allows to configure the settings of DEM display (see the
“Settings of DEM display” chapter of the “General system’s parameters” User
Manual);

@ This menu item is available for the DEM layers only.

 [optional] Palette — is used for the fast configuration of DEM coloring settings (see
the “Settings of DEM display” chapter of the “General system’s parameters” User
Manual);

% This menu item is available for the DEM layers only.

 [optional] Georeferenced raster layer parameters (see the “Georeferenced external
data” section of the “Aerial triangulation” User Manual and the “Pseudo-stereo mode”
section of the “Vectorization” User Manual);

 # Zoom to fit — allows to move the marker to the geometric center of the selected
layer and show the entire layer in the 2D-window;

§ See also Edit > Fit window to active layer.

« [ Load layer border — allows to create a vector layer containing a rectangle polygon
that visualize borders of the selected layer (available for layers of any type);

@ A name of a vector layer with a border is the following: * Border for layer <Layer name>.

+ [& Save - allows to save selected layer;
« [E save as — allows to save file with new name;

* [optional] Import — is used for access to the menu items allowing to import vector
objects (for the vector layers only, see the “Import of vector objects” chapter of the
“Vectorization” User Manual);

* [optional] Export — is used for access to the menu items allowing to export vector
objects (for the vector layers only, see the “Import of vector objects” chapter of the
“Vectorization” User Manual);
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+ 3B Show all current type (see above);
 Ei Hide all current type;

+ =3iF Toggle visibility all current type;

« 3 Close — allows to close selected layer;

- # Close all current type — allows to close selected layer and all other layers of the
same type;

- # - allows to close the layer group (selected in the Close selected layers window,
see above).

@ It is also possible to close all opened layers such as Raster, Grid, TIN, DEM or Vectors using
the Close all opened layers command in the corresponding menus. For example, to close all
opened vector layers, select Vectors » Close all opened layers.

i "
. PHOTOMOD 7.51.4495 I. — - ]

T 5 17.05.2024 15:15:13:
L= Information about layer: Bektope (Vectors)
T Resource: "/TechSuppertTests/Aalen_training/Data/BexTopelx-data”.
=0 File creation tirne: 2023-02-17T09:24:00.000+03:00
— Layer not empty
Wil 1 Layer changed: no
Read-only layer: no
0 Lirnits:

- Xmin: 580269908703
- ¥min: 5409909 487276
{1y -Zmin: 478.585

- Xmax: 581026.860478

- ¥Yrnax: 5411086.081869

- Imax: 534,907

Total objects: 2046

of thern:

- points: 1

- lines: 2045

(closed: 1232, open: 813)

Total points: 8195

Layer coordinate system: georeferenced, WG5S 84 / UTM 32N,

Fig. 56. Vector layer info
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-
. PHOTOMOD 7.51.4495 — oy

17.05.2024 14:14:05:
Information about layer: TIN
Layer not empty
Layer changed: yes
Read-only layer: no
Limits:
s, - Kmin: 580269.908703
¥ - Ymin: 5409909 487276
- Zmin: 478,585
- Xma:x: 581026.869478
- ¥Ymax: 5411086.081859
- Zmax: 534,807
Vertices in base vector layers: 8195
Layer coordinate system: gecreferenced, WGS 84 / UTM 32N,

Fig. 57. TIN layer info

. PHOTOMOD 7.51.4495 = p—.

17.05.2024 15:12:11:
Information about layer: dem2 (DEM)
Resource: "/TechSupportTests/aalen_2314_npp_delme/Data/dem/dem2 x-dem".
File creation time: 2024-03-22716:45:09.361+03:00
Resource size: 27.00 KB
Layer not empty
Layer changed: no
Read-only layer: no
Limits:
- Xmin: 580443109870
tid - Ymin: 5410068.091765
- Zrnin: 0,000
- Xmax: 581153109870
- Yma:x: 5410778.091765
- Zmax: 520.480
GSD: 1010 m
Raster size:
- K72 cells
-1 72 cells
Bytes per sample: 4
Layer coordinate system: gecreferenced, WG5S 84 / UTM 32N,

Fig. 58. DEM layer info

97



PHOTOMOD 8.1 General information about the system (Windows x64)

@ If georeferenced raster files are downloaded into a single layer (without creation of a separate
layer for each image), the GSD value average for all raster files will be displayed in the layer
info window.

8.2.8. Save scene in 2D-window

The system provides possibility to save window content of 2D-window to a TIFF file
with pyramid. At that content of active 2D-window saves considering to all settings in
Layer manager, scale and order of raster displaying.

To save 2D-window content do the following:
1. Choose Service > Save scene. The Save scene window opens.

c Visible (on a screen) part of 2D-window saves as a scene.

r. Save scene [&r

Select window to save:

|l: 2:5 Block scheme v| EI @

Scene size:

W= 2249 pix
H= 1512 pix
Estimated file size 9.73MB
Set resolution 300 = dpi

Print size with selected resolution
W= 19.0 cm
H= 12.8 cm

Open created image

oK ] | Cancel

Fig. 59. Saving settings scenes

2. [optional] To save scene of a stereopair 2D-window in stereomode choose Service »
Settings and choose anaglyph mode on the Stereo tab.

? In case of saving scene of a stereopair 2D-window in mono mode, the button allows to
save as left and right images separately.

3. Select window to save from the list.

4. Define scale of saving image with & and & buttons.
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é In case of big zoom of saving image is increased retention time and the output file size.

5. In the Resolution set field define resolution of the image in dpi.

é Size in centimeters is displayed in the Print size with selected resolution field.

6. [optional] Set the Open created image checkbox on to quick view of image.

7. Click OK and define path and file name. As a result, visible part of 2D-window saves
in a file.

Is it possible to save scene with output file size less than 4 GB in *.tiff or *.prf
(PHOTOMOD MegaTIFF) files. For output files with size more than 4 GB is used
only *.prf.

§ At that also creates a *. tab file with georeference data in current project coordinate system.

8.2.9. Layer view mask

The system provides possibility to display two raster layers in one 2D-window.

@ The layer view mask is available not only for raster but for all other layer types (vectors, DEMs).

To set the mask on perform the following:
1. Open at least two layers in 2D-window.

% Layer overlay mask could be used for two or more layers.

2. Make active a base layer.

3. Choose Window > Layer view mask. The Layer overlay mask window opens.

ﬁ In the Layer overlay mask window the name of the layer to which the effect is applied.
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( . Layer overlay mask @1

dem2 (DEM)
Enable layer overlay mask

Close

Fig. 60. The Layer overlay mask window

4. Set overlay with sliders. By moving the slider layer is partially hidden on the side
on which the slider is moved.

é Active layer in the Layer manager is marked by red frame around the & icon.

@ If any of sliders is on the end position nearest to center of the window, layer is not displayed.
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Block scheme.
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Fig. 61. Overlay of the images and strips borders (partially hidden) to the project images
5. Click the Close button to continue. When the window is closed overlaying layer
remains on.
To set this effect off perform the following:
1. Make active the layer for which the effect is set on.
2. Choose Window > Layer view mask. The Layer overlay mask window opens.
3. Setthe Enable layer overlay mask checkbox off.
4. Click the Close button to continue.

The layer view mask is individual for a certain program 2D window (active at the moment
of configuring). The system allows one to set various view masks for the same layers
displayed in different 2D windows open at the same time.

The layer view mask parameters are saved when the 2D window is updated and are
active until the specific 2D window is closed (if the layer view mask is not adjusted or
disabled by the user).

8.3. 3D-window

Some layers used by the system (both loaded to the project and opened without a
project) the user can see in a special 3D window. This is available for the following
layer types:

* Block scheme — layer with a block scheme that consists of the following elements:
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(0]

Cameras — are displayed in a 3D window only;

o Rays — are displayed in a 3D window only;

(@]

(0]

7

7

Rasters — project images;

Raster frame (2D) - outlines of each image in a block scheme.

The block scheme, correctly displayed in three-dimensional space, makes it possible to
roughly estimate the geometric conditions of the survey. The correct relative position of
the block scheme elements in the 3D window directly depends on the quality of the block
layout and the completed project adjustment

Raster frame (2D) are displayed on the plane that corresponds to the average project
height. For better visualization, the photographic height (see Section 8.3.1), used for the
initial construction of the block scheme in the 3D window, is selected by the system in
such a way that the plane where the rasters are located does not coincide with it along
the Z-axis.

In order to ensure an approximate visual height match between the Rasters and Raster
frame (2D) planes, set the distance to the surface close to the real one in the corres-
ponding field when configuring the block scheme display in the 3D window layer manager

To select images on the block scheme, use the same tools as when working in the 2D
window

* Rasters — layer with georeferenced external data (see the “Georeferenced external
data” section of the “Aerial triangulation” User Manual). The layer consists of the fol-
lowing elements:

o Raster;

o Frame of the raster;

o Label (file name).

* Vectors — layer contains vector objects (see the “Vectorization” User Manual) with
the following objects:

o Labels — labels for vector objects;

o Point objects — only points of the layer;

o Line vertices — vertices of linear/areal objects;

o Lines — linear objects and frames of areal objects.

7

The system provides for working with vector objects both in 2D and in 3D windows (see
“Vectorization” User Manual).
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« DEM - layer contains digital evaluating model (see the “DTM generation” User
Manual);

* TIN — layer contains triangulation irregular network (see the “DTM generation” User
Manual);

* LAS - layer contains LIDAR point clouds (see the “LIDAR Data processing” User
Manual);

? A point cloud cannot be loaded directly into the project and displayed in the 2D-window. A
special Load LAS window is designed for working with point clouds. To open a point cloud
in the 3D window (from the file system or from the active profile resources), click = (or )

in the 3D window Layer Manager toolbar.

« 3D-TIN — layer contains textured TIN 3D surfaces (see the “DTM generation” User
Manual).

? 3D objects cannot be loaded directly into the project and displayed in the 2D-window. A
special PHOTOMOD 3D-Mod module is designed for work with 3D objects (see the “Three-
dimensional modeling” User Manual). To open 3D-TIN the 3D window (from the file system

or from the active profile resources), click = (or =) in the 3D window Layer Manager toolbar.

To open the 3D window, choose Windows > 3D window. On the right side of the window
there is a 3D window layer manager, and on the left there is an area for viewing loaded
layers.

x 30 Window
B O3@eR0 wd @OOO000

Cr X%8s oun

4 Block Scheme

ccccccc
0470116_rgh
Aalen__040115_rgb
0114_rgb
aaaaa
Aalen__0470113_rgb
VNN _Aalen__040112_rgb
T &

GOGOYYYYY Y Y
(]
3
2
K

Property Value
D 1
Loyer name dem
4 Layer color 192,102, 192) (255)
Red

Green 192
Blue 192
Alphs 255

Display Ves

Fillng -

DEM detsit 200

Map detais 100

Rasterayer Not selected

Fig. 62. 3D window
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Table 11. 3D-window toolbar

Buttons Function

[if model displays in perspective projection] allows to refresh model in
3D-window in case of changes in 2D-window if it does not occur auto-
matically

i) to open a window containing information about the version of OpenGL
used

=l to display an area of the 3D window containing a log of completed oper-
ations

&m to set moving mode on

& to move view area of 3D-scene perpendicular to the screen plane

& to set rotation mode on

R to zoom in/zoom out view area

=Y to zoom in of 3D-scene view area selected by rectangle

T to implement a comprehensive display of all objects of 3D-scene

& to move center scene with press and hold down mouse button and
moving cursor

pa e to scaling along objects Z axis (+/-) with press and hold mouse button

& to use perspective projection for displaying

28 00 0 0 to rotate 3D-scene

8.3.1. 3D-window layer manager

The 3D window layer manager is used to manage loaded layers and their display
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Er XX$ES$ Q0N

B[] 4

Block Scheme

-1 Cameras s
-] Cones
= Rasters
- Frame rasters 20
-] 4 Rasters
w[] 4 Raster (2)
- Raster
-] Frame
= Label
- 4 Vectors =
= |:| 4 BexTopel (Vectors)
= Labels
-] Point objects
= Lines
= Line vertices
= > DEM
& = TIM
- > LAS
= » 30-TIM .
Property Value
D 1
Layer name dem5

4 Layer color

[192,192, 192] (255)

Red 192

Green 152

Blue 192

Alpha 255
Display Yes
DEM wiew Hipsometry
DEM details 1.00
Map details 1.00
Raster layer Mot selected

Fig. 63. 3D-window layer manager
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Table 12. 3D-window layer manager toolbar

Buttons Functions

to open the LAS (or 3D-TIN) located in a folder of Windows file system

to open the LAS (or 3D-TIN) located in active profile resources

to close selected layer (except the Block scheme)

to close all opened layers (except the Block scheme)

allows to close all the layers of the selected type

allows to close the selected layers of the same type (press the Ctrl or Shift key to select
the several layers)

to show all items in the list of all opened layers

to hide all layers in the list

DD WX ey

to invert layers visibility

At the top of the 3D window layer manager, lists of loaded layers (which are arranged
according to their types) are displayed, as well as tools for controlling the visibility of
layers:

« ® — |ayer is visible in 3D-window;
+ =« —layer is invisible;

Right-click menu of selected layer can contain the following menu items, depending of
the layer type:

- ¥ Zoom to fit — allows to show the entire layer in the 3D-window;
« & Close — allows to close selected layer;

« # Close all current type — allows to close selected layer and all other layers of the
same type.

At the bottom of the layer manager, there is a table that describes the properties of the
selected layer (and also contains tools for customizing its display). The contents of the
table may vary depending on the layer type.

The display of a layer is controlled by changing the values in the editable table cells:
* ID;
* Layer name;

« Layer color RGBA color model ([_]);

A checkbox to choose whether to display or not to display the layer
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The following additional features (display options) are provided for the Block scheme
layer:

* Distance to the surface;

@ In order to ensure an approximate visual height match between the Rasters and Raster
frame (2D) planes, set the photographic height close to the real one.

* A checkbox to choose whether or not to display cameras as icons;
+ Afield to set the size of the camera on the screen.
The following additional features are also provided for the Rasters layer
* Raster height.
The following additional features (display options) are provided for the DEM layer:
* DEM view:
o Hypsometry — as hypsometry model;

o Color fill — allows to display DEM with color filling layer-by-layer corresponding to
altitude relief scale.

o Texture (for georeferenced source images only).
 DEM details;
* Map details;

* Raster layer (texture) — one of the previously loaded layers with georeferenced ex-
ternal data.

8.4. Loading progress window

Loading progress window is displayed while processing any time-consuming operation.
Progress of loading, spent and estimates time and log are displayed in the window.

The progress bar blocks user’s interaction with PHOTOMOD interface.
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i !
a# PHOTOMOD 7.3.3818 = | G S
‘ 0 06/12/202212:02:34: Began: Reading configuration.,
T 06/12/202212:02:34: Began: Reading configuration.,
¥
.0 06,/12/202212:02:34: Began: Copying remote profiles,
(il 0
3

Program paused. Press "Continue”

Tirne elapsed: 0:00:02.3 7 Estimated tirme left: 0:00:00.0
Reading configuration

| 0.0%

Copying remote profiles

T — | T18%

Continue ] ’ Cancel

Fig. 64. The loading progress window
The loading progress window contains the following buttons:
» Pause — allows to pause performed operations;
o Continue — allows to continue the operations.
+ Cancel - allows to cancel performed operations.

The buttons of the window toolbar allows to enable/disable the visibility of an appropriate
messages categories. The number of messages in the each category is displayed to
the right of the corresponding button.

Table 13. The loading progress window toolbar

Buttons Function
A to enable/disable the visibility of the error messages
! to enable/disable the visibility of the warnings

i to enable/disable the visibility of the information messages

S to enable/disable the visibility of all the messages
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8.4.1. Progress bar for distributed processing

Distributed processing tasking process is displayed in the progress bar, which (in most
cases) immediately closes automatically after the completion of this operation. The
Monitor for distributed processing is used for further monitoring of the task execution
progress and data processing control.

This is a standard way of distributed processing control for PHOTOMOD. Distributed
processing is usually used when working with large amounts of data, what is quite time-
consuming. Use of the monitor for distributed processing keeps PHOTOMOD interface
available to the user, allowing them to carry on online operation (including another
project).

5 PHOTOMOD interface becomes available after the distributed processing tasks have been
created and the progress window is closed.

In some expressly stated cases, the ways of distributed processing control may differ
from the described above:

Automatic measurement of tie points

Some methods of automatic measurement of tie points in the distributed processing
mode involve the use of a progress bar for step-by-step setting of distributed processing
tasks.

ﬁ See “UAS” and “Feature based correlator” subsections (both for aerial data and scanner imagery)
in the “Aerial triangulation” User Manual.

In case of step-by-step distributed processing task setting, the progress bar remains
open during the entire operation running, allowing the user to directly monitor the pro-
gress of data processing from the PHOTOMOD interface without opening the Monitor
for distributed processing.

In this case, suspending the currently-running operation from the progress window (by
clicking the Pause button) means pausing the process of creating new distributed pro-
cessing tasks (at the same time, already created tasks will keep running).

ﬁ Direct control of each task execution progress is available in the Monitor for distributed pro-
cessing.

Distributed orthomosaic creation
With distributed orthomosaic creation, the user can customize the progress bar display:

« If the progress bar is displayed only during distributed processing task list creation,
the user can keep working in PHOTOMOD Geomosaic, simultaneously with the exe-
cution of distributed processing tasks;
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+ If the progress bar is displayed during the entire operation, the user can monitor the
progress of data processing in the program interface without opening the monitor
for distributed processing, but access to the PHOTOMOD Geomosaic user interface
remains blocked.

In this case, suspending the currently-running operation from the progress window
(by clicking the Pause button) means pausing the process of creating new distributed
processing tasks (at the same time, already created tasks will keep running)

% Direct control of each task execution progress is available in the monitor for distributed pro-
cessing.

% See “Distributed processing” in the “Orthophotomaps creation” User Manual.

DEM creation in batch mode

The progress bar remains open during the entire operation running, allowing the user
to directly monitor the progress of data processing from the PHOTOMOD interface
without opening the Monitor for distributed processing.

9. Prepare to processing
9.1. Data storing

9.1.1. Main definitions of resources system

Resources system is a way to store data with possibility of network distributed project
processing. Operator has access for an unified system with all available profiles, regard-
less of the PC used for data storage and processing. Data could be stored in optimal
way for processing a current task.

The following main definitions are used in the resources system:
* Profile — independent group of resources relative to one or several projects;

* Virtual folders is a virtual names of real local/network folders (hard disks) or group
of folders, chosen by user to store profile resources;

@ One profile can use data located on several computers.

9.1.2. Profiles and virtual folders

Configuration of resources depends on profile settings. Profile has a virtual name and
do not equal to real file system. This name is a common root of the resources tree that
connects all branches (resources) profile.
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Profile resources could be placed on any workstations and hard disks in a local network.

@ It is recommended to create one profile for one project or group of projects.

The profile resources system contains all subfolders and files (except *.meta-files) of
real folder, defined as virtual.

Configuration files that describe a set of local profiles and its structure are stored in the
PHOTOMODS. VAR folder.

i ™y
Control Panel @

Profile  Resources Service Help

Profiles Resource tree
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Profile Free = Node Path Free
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P_FO‘WOFk 30.30TB /Hobart WDelhracursh\proj 3030 TB

Piter 2.72T8 Anput g 30TB
Orto_USGIK 1.85TB /Kobzeva 10 TE

bzew 30

Opsis 44.33TB Work 30 TR

Ofec-test 937.21GB Hark e \projects o

Obliques 13.55 TB fCoun Dcl\racurs\projectsh... 3030 TB
Novokuznetsk 30,30 TB L

Meural 11.50 TB 1

MDVI_LAS 3.95TE

Maongolia 4,33TB

Miklos 45.72TB

Meridian 43.00 TB

Megagalaxy 8.17TB
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Lion2012Gigz 30.30TE
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Managing network profile is available only in network profies management mode Manage network profiles ‘

[ Ok ] [ Apply ‘ I Close J

Fig. 65. Control Panel window

The Control Panel module is used to create and manage profiles. The Control Panel
module is used to create and edit profiles, connect virtual folders, create/connect network
profiles folder, change active profile and so on.

The system provides possibility to create and manage local and network profiles.

Profile, available to use only on one PC, is called local profile. Local profile is marked
with i leftward to profile name.

Network profile is available on all workstations in the system to process project at the
same time. Network profile is marked with tg leftward to profile name. When selecting
a network profile, its configuration is copied automatically to a local PC to provide inde-
pendent work if storage is unavailable.
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In one session could be used only one active profile. Any local or network profile available
profile could be chosen as active.

The PHOTOMOD Explorer moduleis a service module for resources management. All
active profile resources are displayed in the module — contents of virtual folders (including
subfolders and files). The module also allows to edit resource structure.

8| PHOTOMOD Explorer =5
BEX &f+B&Bik L=
4 Ill it I'\Ja)me Size Time
4 Antwerp Mo nopesbr 01.11.2010 19:...
© Antwerp
- Antwerp Test DTM_Antwerp testx-dem 0B 30.07.201016:44, ..,
© Antwerp Test2 - | |Konua DTM_Antwerpx-d... 0B 30.07.201016:17...
4 Antwerp konua [ Meg nepesslx-dem 955 B 02.08.201010:46...
backup
Cache
Cameras
4 Data
classifier
4 |dem
Mog nopessl
© mosaic
sheets
Features
Locks
4 mnr 3
* ProjOptions
Temp - | Filter
| fantwerp/Antwerp koma/Data/dem | 1 resources [ 303.10 MB (selected: 0 resources /0 B)

Fig. 66. PHOTOMOD Explorer window
9.2. Profiles

9.2.1. Control Panel. Profiles management
The Control Panel module is used to manage profile structures to work in the system.

To launch the system at least one profile is required. Creation of profile is performed
in the Control Panel module.

@ During the first launch of the system, the PHOTOMOD initial setup windows opens that allows
to define settings folder and create profile.

Profile separate place for project files. It is a resources tree with the following structure:
* Root — profile virtual name.

» Top level branches — profile virtual folders — virtual names of physical local or network
folders/disks.

ﬁ One physical folder could be specified as a virtual folder.
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* Resources — the whole content of selected folder of a profile — all subfolders and
files. Only images source files from active profile resources could be matched with
images of current project.

7

In the Lite-version of the system it is possible to create only local profiles and to process project
only by one operator in one time. In the full version could be created any local or network profiles
and organized network processing of project with a lot of operators. In both versions project

data could be stored on any computers of the net (including servers).

To launch the Control Panel module perform one of the following actions:

» choose Start » Programs » PHOTOMOD 8 x64 > Control Panel,

« Choose Control Panel in the right-click menu of the System Monitor module (the &3

icon in the Windows system tray);

« click the g# button in the Project management window in the system (see the Project

creation User Manual).

-

~
Contral Panel ﬁ
Profile  Resources Service Help
Profiles Resource tree
N Ssls8S Y Sl B T
Profile Free s Made Path Free
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Drto_USGIK L3518 /Kobzeva ‘WDel\racurs\projects 3
Opsis 44.337TB . o . : : o
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Obliques 13.55 TB fCoun Dclhracursprojects 30.
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Lion2012Gigz 30,30 TE
|Linux_test 30,98 TB !
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[
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)

Fig. 67. Control Panel window

Loading progress with a log-file are displayed while module is launching.

A\

If module launches too slowly, remove all incorrect profiles, because delay is due to attempts

to access a non-existent folders.
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& PHOTOMOD 7.3.3818
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06/12/2022 12:02:34: Began: Reading configuration.

0 06/12/2022 12:02:34: Began: Copying remote profiles,

=

[¥¥)

CEET

Reading configuration

Time elapsed: 0:00:023 / Estimated time left: 0:00:00.0

Program paused. Press "Continue”,

0.0%

Copying remote profiles

T7.8%

| Continue || Cancel |

Fig. 68. Control panel module loading

In the Control Panel module window the resources system, allowed to work in the system,
is displayed. Each profile has resource structure — list of virtual folder compared to real
folders on hard disks of different computers in the network used to store system’s data.

Table 14. Brief description of Control Panel window toolbar and menu items

Buttons and menu items

Function

& Profile > Create

to create the new local profile

& Profile > Delete

to remove from the table local profile and its resources structure;
at fact files and folders do not delete and could be used again in
new or existed profiles

Profile » Delete uncorrect profiles

to remove from the table all profiles (local or network) that are linked
to unavailable of nonexistent profiles

& Profile > Copy

to copy selected profile with its its resources structure and save it
with a new name

& Profile » Rename

to to rename selected profile

& Profile » Activate

to make selected profile active and use it in the next system’s launch

= Resources > Connect folder

to create virtual folder and connect it to a selected profile

£ Resources » Disconnect folder

to disconnect folder selected in the list from profile; real folder does
not changes

&' Resources > Modify folder

to rename virtual folder or change path to its real folder on a hard
drive

& Service > Initial setup

to specify initial settings of access and management of network
profiles, which configurations are stored in the centralized manage-
ment folder

7 Help > Help index

to open the User Manual. It is a PDF-file contains a table with
available files
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Buttons and menu items Function

tii Help » About opens a window indicating the number of system build and serial
number of hard lock key, the technical support end date, and also
opens the System Information Panel window with detailed inform-
ation about software, hardware configuration, and components of
the computer (such as details about the device drivers)

é Only one chosen ’active’ profile could be used at the same time.

% Unavailable profiles and profiles with unavailable resources or virtual folders are marked by red
color in the table. To remove these profiles from the table choose Profile » Delete uncorrect
profiles.

Table of profiles with size of common free space of each profile is displayed in the
Profiles section. Common free space of profile is a sum of free places on all hard disks
with connected folders. Profiles could be local or network and marked by different icons
in the table. For detailed information see the Creating and connecting profiles chapter.

Table of virtual folders is displayed in the Resource. It contains list of real folders, cor-
responding to virtual folders and information about free space on all involved hard disks.

§ Points sorting in columns of the list is performed by mouse click on the column header.

§ If the selected profile is editable in the Control panel window (no infotip to go to the Control
Panel — network profiles management window), double click the appropriate line of the Re-
source tree table to view Virtual folder properties (in a separate window).

§ To copy the physical folder location data from a line in the Resource tree table, open the Virtual
folder properties window and copy data from the Folder field.

The system provides possibility of additional placement of project folder in subfolder
(e.g. Projects/InfoMap/InfoMap_copy). For example, to place project folder in the In-
foMap_copy folder, create a new folder in the InfoMap_copy with project.tag name. It
is possible to place projects in the projects.tag folder.

9.2.2. Creating local profile

Profile, available to use only on one PC, is called local profile. This profile is not displayed
in the list of profiles on other PCs in the network. Local profile is marked with fi leftward
to profile name.

Perform the following actions to create a local profile:

1. Choose the Profile » Create or click the &% button. The New profile window opens.
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# Input new profile name @lﬂ—hj

Mew profile

Local profile 1

QK ] [ Cancel

Fig. 69. Creating profile

2. Input a name of new local profile.

3. Click OK. The Connect virtual folder window opens.

. N
Connect virtual folder ﬁ

Virtual folder name

Folder

Fig. 70. The Connect virtual folder window

4. Define name and path to virtual folder.

‘ It's impossible to use logical disk root folder.

5. Click OK. Local profile creates and also defined virtual folder connects to this profile.

é Local profile is marked with fii leftward to profile name.

6. Make profile active by double-clicking on its name. Leftward to profile name the red
mark is shown (¥"). It marks an active profile.

é Restart all opened modules of the system to apply changes.
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Control Panel

Profiles

8 &

Resource tree

c8®y CNA

Profile

¥ Local profi... 93.66 GB /2 Cih\datal 93,56 GB

Free MNode Path Free

5. Information Iﬁ

For the changes to take effect it is necessary to restart all PHOTOMOD modules
currently running.

’ CK H Apply H Close

7. Click OK.

Fig. 71. Control Panel window

8. Run the system. All space in active network profile resources is available in the

system on

a current workstation. The Project management window opens allows

to choose active or create, copy, remove, import and backup profiles (see the Project
creation User Manual)

9.2.3. Connect virtual folder

To connect virtual folder to selected profile perform the following:

1. In the Control panel window choose the Resources > Connect folder or click the

e button.

The Connect virtual folder window opens.

-

Connect virtual folder @

Virtual folder name

Folder

Fig. 72. The Connect virtual folder window
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2. Input a virtual folder name — arbitrary text is used to identify data in folder.

3. In Folder field click the _... | button to choose a physical space for connecting as a
virtual folder. Click OK to close the connect virtual folder window.

. It's impossible to use logical disk root folder.

é To connect folder only read access for this folder is required.

c Local profile folder could be placed both on a workstation, where the system runs, and on
any workstation of the network.

4. Click OK. Folder connects to the active profile.

To disconnect virtual folder form a local profile, choose Resources » Disconnect folder
or click the £5° button. At that, physical folder is not deleted, only the virtual folder name
is remove (cleared the path to this folder).

é To disconnect virtual folder form a network profile, choose Resources > Disconnect folder or
click the £ button in the Network profiles management.

ﬁ When disconnecting the network profile it is converted to local. This local profile is available on
all workstation of the network.

9.2.4. Creating network profile

Network profile is available on all workstations in the system to process project at the
same time. Network profile is marked with tz leftward to profile name. When selecting
a network profile, its configuration is copied automatically to a local PC to provide inde-
pendent work if storage is unavailable.

The PHOTOMOD initial setup window is used to create/edit network profiles and net-
work profiles accessing. Network profiles are used to process one project with several
operators, at the same time as well.

Centralized management folder and network profiles create and adjust only on one of
the workstations with installed system.

Perform the following actions to create a network profile:

1. Choose Control Panel in the right-click menu of the System Monitor module (the
(33 icon in the Windows system tray). The Control Panel window opens.
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Control Panel | £ |
Profiles Resource tree
+ + X
SN CeS8%Ty o o &
Profile h Free MNode Path Free
¥ Local profi... 93.66 GB /2 Cih\datal 93,56 GB
5. Information L&J
For the changes to take effect it is necessary to restart all PHOTOMOD modules
currently running.
’ CK ] [ Apply ] ’ Close
A

Fig. 73. Control Panel window

2. Click the & button. The PHOTOMOD initial setup window opens.
( Initial setup &Jw

Settings folder
C:\PHOTOMOD7.VAR), (e

(™) For all users on this computer @ Only for me

Centralized profile management

Use

Centralized management folder

\\heap3\PHOTOMOD \MNet-profiles), E]

[Manage network prnﬁlesl

[ oK H Cancel ]

Fig. 74. PHOTOMOD initial setup window

In the Settings folder section is displayed path to the PHOTOMODS8. VAR folder,
that is used to store configuration and temp files. Click the _... | button to change
path to configuration folder.

@ Choose For all users on this computer to use one configuration folder for all users of
current workstation, otherwise choose Only for me.
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3. Inthe Centralized management folder section set the Use checkbox on and define
a folder.

4. Click the Manage network profiles button. The Control Panel — network profiles
management window opens.

’ 1
% Control Panel @
Profile Resources Service Help
Profiles Resource tree
CE8E et o &
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Fig. 75. Network profiles management
5. Click the &% button. The New profile window opens. Input a network profile name
for project or independent group of projects. Click OK.

6. Inthe Resource tree section create a resource structure for a new network profile.
? Network profiles could be edited/created in the Control Panel — network profiles man-
agement window the same way as local profiles in the Control Panel window. Structure

type of local and network profiles are the same.

é Network profile could be edited only in the network profiles management mode.

7. Click OK. Network profile saves in the centralized management folder. Created
profile could be used on a current workplace straight away.

At creation of network profile in a centralized management folder following files creates:

* profiles.x-ini file with list of all network profile;
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9.2.5. Connecting to existing network profiles

subfolders with names equal to profile names; they contains files of configuration
profiles.x-ini profile resources. Each profiles.x-ini file (relative to concrete profile)
contains description of profile resources structure tree: list of virtual folders and its
absolute path to physical folders.

Network profile should be connected to a workstation to use it in the network processing.
Perform the following actions to do this:

1.

3.

[optional] On a workstation choose Control Panel in the right-click menu of the
System Monitor module (the &2 icon in the Windows system tray). The Control
Panel window opens. Click the & button.

The Initial setup window opens:

-

Initial setup

Settings folder

C:\PHOTOMODE. VAR,
For all users on this computer @) Only for me
Centralized profile management

Use

Centralized management folder

QK

| | Cancel

Fig. 76. The Initial setup window

In the Centralized management folder section set the Use checkbox on and
choose a path to centralized management folder that was defined on a network
resource structure creation step.

% When you connect a centralized management folder to a workstation, all network profile
configurations are copied to the local workstation into the PHOTOMODS. VAR folder.

Click OK. Network profiles are displayed in the Profiles table of the Control panel

window:
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@ Control Panel | 2 |
r
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24.05.2024 13:35:48: Reading directory "\dc1\RACURS\projects\UAV-FB\projects”. 1
24,05.2024 13:35:48: Finished: Reading profile "UAV-FB". Time spent: 0:00:00.1. (i
24.05,2024 13:35:48: Beoan: Readina orofile "UAV-FB direct”. 2
Program is running. Please wait. ..
Elapsed: 0:00:01.4/Left: 0:00:00.1
Reading configuration
— | 91.2%
Reading profile "UAV-FE_direct™
| 0.0%
Manzgini

Fig. 77. Connecting to network profiles

5. Make profile active by double-clicking on its name. Leftward to profile name the red
mark is shown (¥"). It marks an active profile. Click Apply.

6. An info message that the system should be restarted appears. Click OK to close
the window. Click OK in the Control panel window to finish system configuration
and restart PHOTOMOD program.

5| Information @

For the changes to take effect it is necessary to restart all PHOTOMOD medules
currently running.

Fig. 78. Information message
7. Wait until the system starts. All space in active network profile resources is available
in the system on a current workstation.

8. [optional] Repeat the 2—7 steps on other workstations to add access to network
profile resources.
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9.3. Processing setup

9.3.1. Local processing

The system implements not only local, but network processing of one o several projects
at the same time.

When working on a single workstation, and if at the same time with each project is only
one operator, it is recommended to create a separate local profile with all the resources
for each workstation. It allows to take advantage of the access speed to hard disk
compared with access through the network (if the virtual profile folders are located on
the server or on another workstation).

9.3.2. Network processing

One of the main features of the system is way to store data and possibility of distributed
network processing. Network processing is a joint project processing by several oper-
ators at several workstations. For network processing resources could be placed both
on workplaces and servers.

Distribution of resources on workstation

Profile resources could be placed on several workstation in a local network. Read and
write public access is required for all folders with data.

@ Any number of profiles could be created in the network.

The following recommendations for the allocation of resources on the network worksta-
tions:

» use to store data computers that are not used as a workplace to decrease risks of
failed access;

 place resource on different hard disks to most effective use of free space;

+ toinstall hard lock key on a separate computer, which does not has resource-intensive
tasks, which can lead to failures in protection and failures of system processing on
workstations.

‘ For simultaneous editing of the same files there is always a rule, except for explicit messages
= and warnings, the rule of 'the last saved data is stored’.

c There is no limitation for browsing, it's allowed to simultaneously open the same project files in
any number on multiple computers. In the local OS Windows (XP, Vista, 7) there is a limit in 8
connections.
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The best way to organize network-based workflow using network computers to store
resources is as described below:

1. Create a centralized management folder on any workstation. Configure read-write
network access to that computer.

2. Create network profile in this folder (or multiple network profiles) and setup resources
configuration of each profile. Connect the virtual folders.

3. Configure the usage of centralized management folder on the all workstations. All
network profiles, for which configurations are stored in central control folder, will be
available on workstations (which are displayed in Control Panel’s profiles list).

4. Choose a network profile and make in active.

5. Restart all opened modules of the system to apply changes.

-ini ]
Profile Resources Help
Profiles Resource tree
SSES e & |
Profile ~ | Free l:] Virtual Folder ~ | Free
Project 1 4.15TB /high |
Project 2 13.36 TB C:i\Documents and Settings\Devl... 1.43 GB
Project 3 3.67TB
Project 4 3.02TB J
Project 5 8,30 TB
Project 6 9.76 TB
T T —
Project 7 3.56 TB |
oK | Cancel Apply

Fig. 79. Example of network profile
Distribution of resources on servers

This option is most appropriate for working with network projects. It is recommended
to have dedicated file-servers, which are not used as workstations.

As a file server it is recommended to use FreeBSD operating system or Microsoft
Windows Server andLinux OS.

é It is recommended to store profile resources in several virtual folders on different servers.

@ It is recommended to store not more than one virtual folder on one hard disk drive. It provides
more uniform load distribution on aggregate bandwidth of disk system of servers and network.

Perform the following actions to create a network profile:
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1. In the Initial setup window define a centralized management folder.
2. Choose a network profile and make in active.
3. Restart all opened modules of the system to apply changes.

Network access to data is used operation system’s tools (network access to folders
and files).

There are the following recommendations of network processing management using
file servers:

For project or group of projects not more than 1 Tb perform the following:
1. Create a network profile with centralized folder on a server.

2. Allocate hard disk or folder on a server (depending on size of a project) to store
data and define virtual folders.

3. Connect created network profile to all workstations involved in the project processing.

4. Restart all opened modules of the system to apply changes.

This data organization is convenient in terms of easy backups (all resources is placed in the
same place), and there is no loss in speed while simultaneous processing of small volumes.

If the project (or group of projects) assumes large volumes, it is best to use to place
resources multiple file servers; use several different server drives.

@ It is recommended to allocate resources so that it would be convenient to backup it.

Two strategies of resources allocation on the servers are recommended:

1. Connect different server drives (folders) as virtual folder to store images, and sep-
arate server drives to store projects. Administrator involvement is desirable for or-
ganization of such structure and to monitor availability of free space on server
drives.
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& Control Panel -- Network profiles management

Profile Resources Help

=10l x|

Profiles Resource tree
EI8e o & b
Profile ~ | Free H Virtual Folder =

Project 1 3.027TB /Gratz
Project 2 8,30 TB \\Filez\TechSupport|DatalGratz
Project 3 9,76 TB /high
Metwork profile 1 —I C:iDocuments and Settings\Dev\Deskropihigh
Project 5 3.56 TB /Images
Project 6 3.56 TB \\Bigz\PhSData2\Techsupport\GeoEye_GroupiGeoEyve Quick lookil, ..
Praoject 7 4.15TB /Projects b
Project 8 3.56 TB ﬂ C:\Projects ;I

| QK I Cancel

Apply |

Fig. 80. Example of creating network profile using different server drives to store images and separate

network profile for project files

2. Select different server drives (folders) as storages to place images and connect
that group of storages to profile, using virtual folder Select separate server drive
(s) as virtual folder to store projects.

-lolx
Profile Resources Help
~Profiles —Resource tree
CE8E o e &'
Profile '*] Free E Virtual Folder ZI
Project 1 3.027B /Images
Project 2 8.30TB 1\Bigz\PhSData2\ TechsupportiGeoEye_GrouplGeoEye Quick looklImac
Project 3 9.76 TB /Projects
Metwork profile 1 J Ci\Projects
Project 5 3.56TB /storage
Project 6 3.56TB projects (C:\Projects)
Project 7 4,15TB stor (C:\Stor)
Project 8 3.56 TB ;I bl

oK I Cancel

Apply

Fig. 81. Example of creating network profile using group of storages for images and separate server

for project files

Network data access is only implemented using operating system (network access to
files and folders). It is strongly recommended to meet following requirements when
network processing is performed:

* network access must be permitted to profile resources with full permissions for all

users, who work with them;
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« all profile resources connected to workstation should be available while working with
the system on this workstation;

+ all changes in structure of profile resources, which performed using Control Panel
moduleare available for running modules only after restart of these modules;

« if local network contains a server, where profiles are created, it is necessary to control
number of users accessing it simultaneously. There are limitations to simultaneous
access in non server operating systems ( Windows 2000/XP).In this case recommen-
ded number of operators working with server storage is not more than 8.

+ install hard lock key on a separate computer, which does not has resource-intensive
tasks, which can lead to failures in protection and failures of system processing on
workstations.

9.4. PHOTOMOD Explorer module. Resources management
PHOTOMOD Explorer module is a service module to work with system resources.
To start the module perform one of the following:

» choose Start » Programs » PHOTOMOD 8 x64 » PHOTOMOD Explorer;

+ choose PHOTOMOD Explorer in the right-click menu of the System Monitor module
(the & icon in the Windows system tray);

» choose Service » PHOTOMOD Explorer (Ctri+Alt+E) in the main system window.

§ The PHOTOMOD Explorer module is used also during loading data from resources to a project.

The PHOTOMOD Explorer window opens and displays active profile resources.

%] PHOTOMOD Explorer [
BEXC+ Bk BED
4 = - Name Size Time
4 Antwerp Mo nopests 01.11.2010 19:...
> Antwerp
» Antwerp Test DTM_Antwerp testx-dem 0B 30.07.2010 16:44...
Antwerp Test2 | | Konua DTM_Antwerp-d.. 0B 30.07.2010 16:17...
4 Antwerp konua 1 Moa nopesbiic-dem 955 B 02.08.2010 10:46...
backup
Cache
Cameras
4 Data
classifier
4 |dem
Moa nopeser
mosaic
sheets
Features
Locks
< b
ProjOptions
Temp - | Fiter
| fantwerp/Antwerp korma/Data/dem | 1resources J 303.10 MB (selected: 0 resources JOB)

Fig. 82. PHOTOMOD Explorer window
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System resources include projects, cameras data, images and other.

List of projects is presented in hierarchical form and displays in the left part of window.
Upper level is a virtual folders.

@ The ¥ button allows to show a list with 10 recently selected resources.

In the right part of the window resources of selected project are displayed. Resources
are displayed as a table with the following rows:

* Name - name of file or project’s subfolder;

Size — [for files only] file size;

+ Time — time of the last change;

Path — real path to folder or file in a workstation.

% Points sorting in columns of the list is performed by mouse click on the column header.

Double-click on file name of TIFF, MegaTIFF or JPEG files allows to open file in a
viewer.

Full path to selected folder is displayed in the left status bar, in the right one — resource
statistics: number of resources/their size (selected resources/size).

The Filter field is used to quick search files in the system profile resources.

Table 15. Brief description of the PHOTOMOD Explorer window toolbar

Buttons Function
B to copy selected resources to clipboard
& to paste resources from clipboard
b to remove selected resources
e to create new physical folder in the active profile resources New physical folder couldn’t

be created on a virtual folder level.

+ to connect new virtual folders

to copy resource

] to rename resource selected in the right part of window

to refresh window

T to display all resources in all subfolders of selected folder, or entire profile. The list on
the right side of the window shows all subfolders, and all files of selected folder and path
to them

to move one level up in resources tree
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é The tools should be used carefully to edit resource structure in PHOTOMOD Explorer window
in order to avoid loss of needed resources, belonging to project (delete, rename or move con-
figuration files of projects, etc.).

In PHOTOMOD Explorer window, it's possible to connect new virtual folder only to
local profile. Use Control Panel for network profile.

é All changes of connecting new virtual folders in the PHOTOMOD Explorer moduleare displayed
automatically in the Control Panel modulewindow. The PHOTOMOD Explorer module does not
provide possibilities to edit or disconnect virtual folders, The Control Panel module is used for

this.

Right-click on file name or subfolder in the right part of PHOTOMOD Explorer window
opens the context menu.

Table 16. Brief description of right-click menu items

Menu items Function
Open in default program (F3) to open file in proper program or choose it manually
Open in file explorer to open file location in Windows file system
View as text to open file in a text editor
View in external editor (F4) to open file in default external editor defined with

Editor settings menu item. By default is used in-
cluded FAR Manager

Edit metadata (Ctrl+F4) to edit metadata of selected file

Editor settings to choose external editor to use by default. Filename
in the command line is specified as %1 and in ma-
jority of cases should be enclosed in quotes.

Copy (F5) to copy file or folder
Rename (F6) to rename the resource, except virtual folders
Delete (F8) to delete selected resource
Create folder (F7) to create new physical folder in the active profile
resources
Copy to clipboard (Ctrl+C) to copy resource resource identifier to clipboard so

that it can be copied to another folder with the
command Paste from clipboard

Paste from clipboard (Ctri+V) to create a copy of a resource (whose identifier has
been saved to clipboard with the Copy to clipboard
command above) in the current folder

Refresh (Ctrl+R) to refresh windows contents in case of changes in
start of PHOTOMOD Explorer module
Select all (Ctrl+A) to select all resources in the right window
Size in compact format to show resource sizes in human-readable form
(e.g.’1 MPB’) instead of strict number of bytes (e.g.
1048576 b’);
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é The system do not allow the user to Copy (using context menu tools) DEMs and orthophotos
in PHOTOMOD MegaTIFF (*.prf) format located in active profile resources. To copy a DEM,
choose Terrain » DEM > Save copy.

9.5. The “System Monitor” service module

After the system installation System Monitor module is launched and in the system tray
of Windows the 1 icon displays.

The Start » Programs » PHOTOMOD 8 x64 » PHOTOMOD System Monitor menu
item is used to start the module.

It is also possible to start module from a command line. Use --profile="profile_name’
key when launch the run the module from command line to run profile with active profile,
defined in a key. Last active profile is used if module runs without key.

é It is not possible to change active profile when module is launched from a command line.

Module right-click menu contains the following menu items:

« PHOTOMOD - is used to launch the system (also double-click on the €2 icon);

PHOTOMOD UAS - is used to launch the PHOTOMOD UAS program (see the
“Processing of UAS data” User Manual);

» Explorer — allows to run module to view active profile resources (see Section 9.4);
» Control Panel — allows to run module for resources system management;

* Raster Converter — allows to run module used to convert raster images (see Sec-
tion 10);

i\- If these modules run with a System Monitor module the active profile is used. If these modules
run from the main system’s window, is used the current profile.

* GeoMosaic — allows to run the GeoMosaic program that is used to create georefer-
enced orthoimages (see the Orthophotomaps creation User Manual);

» 3D-Mod - allows to run module fr creation 3d-objects based on 2D-vectors;

* GeoCalculator — allows to run the GeoCalculator program that is used to recalculate
geodetic coordinates of points from one coordinate system to another and also to
create and edit coordinate systems or its parameters (see the “The GeoCalculator
program” User Manual);

» Distributed processing control center — allows to setup options and to control
distributed processing;
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« Start automatically — with start of System Monitor module Distributed processing
control center starts automatically;

 Profile — allows to select an active profile in the list of local (h) and network (R) profiles;

» Language — allows to change the interface language;

@ Language changes at restart modules. To change the System Monitor language also restart
the module.

* Mouse configuration — allows to setup a configuration of mice or other special
devices (like hand wheels/foot pedals), which are used for images stereo processing
(see the chapter Mice and hand wheels adjustment for stereo processing);

+ Show log folder — allows to open the PHOTOMODS8.VAR\Logs folder in Windows
explorer;

* Log cleanup settings;

» About — opens a window indicating the number of system build and serial number
of hard lock key, the technical support end date, and also opens the System Inform-
ation Panel window with detailed information about software, hardware configuration,
and components of the computer (such as details about the device drivers):

r.AbDut ﬁw
- k

PHOIQMOD

|

Version 8.0
Wersion: 8.0.5135 x64 (C) Racurs, 2025
Serial number: PH370385RCRS http:-/fwww. racurs.ru
Build date: 24.06.2025
Tech. support expiry date: 31.12.2025

Close l [System infa...

Fig. 83. The About window

» Licence info — opens a window with information on system’s modules configuration
and hard lock key ID (see Section 5.3.1);
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* News — opens the embedded browser window for quick link to www.racurs.ru news;

« Automatic download for news — allows for enabling (%) or disabling automatic
download data on unread news on the www.racurs.ru website;

+ Exit — allows to close the System Monitor module and close the system.

10. Raster Converter source images preparing

Raster Converteris a service system module that could be used to batch and sequence
conversion of raster files to inner MS-TIFF format with LZW or JPEG conversation or
without it and to convert MS-TIFF images to different formats.

5 In case of processing amount of images places on different data medium and take much disk

space, it is recommended to preliminary prepare raster images with module before creation of
a project.

10.1. Raster images conversion

For working with images in program, it is recommended to use MS-TIFF internal raster

format, which is the TIFF format with overview pyramid (set of subsampled images

copies) for higher image display performance.

g The system allows the direct use of various formats of raster images (without having to convert
them). It saves the disk space, but slows down significantly operations with images, so it is

strongly recommended to use raster images in MS-TIFF format.

% PHOTOMOD software supports already existing third-party image pyramids, if available (*.ovr).

@ In most cases, images acquired by digital camera, might contain metadata, written in EXIF
format. Metadata of converted images (in TIF format or in system’s internal format MS-TIFF) is
stored in the folder, which contains these images, in separate files with *.md extension.

To start the module perform one of the following:
» choose Start » Programs » PHOTOMOD 8 x64 > Raster Converter;
» choose Rasters » Raster Converter;

» choose Raster Converter in the right-click menu of the System Monitor module (the
(33 icon in the Windows system tray).
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[} PHOTOMOD Raster Converter = | B |
Falders Files [selected: 1/ 3] View
Name - In folder: C:data2 E] C:/DATAZ/DII_0379.JPG
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Fig. 84. Raster converter window

The module allows to perform the following processes:

 to convert images in different raster formats to an interior MS-TIFF format;

 to convert images of interior MS-TIFF format and other raster formats to TIFF-files;

» to convert 8 or 16-bit images;

 to convert images without compression or with JPEG or LZW compression;

 to convert raster images with size more than 4 GB to a MegaTIFF-files;

+ to perform radiometric correction to improve visual properties of images;

+ to create a single raster file by combining an image whose different bands were saved

as separate files;

 to convert into a defined folder in Windows file system or in active profile resources;

+ to use distributed processing for conversion.

133



PHOTOMOD 8.1 General information about the system (Windows x64)

The Raster Converter window contains the following main sections:

Folders — is used to display a folder tree;
Files — is used to display raster files in selected folder and subfolders;

List — is used to display a list of raster files, chosen for conversion;

@ In the title of Files and List section is also displayed [number of selected\all files].

View —is used to preview display selected raster file;
Output format — allows to define format and parameters of an output file;

Output files placement — allows to define a folder for output files, their names and
actions in case of output file already exists.

Module supports the following raster formats of input files:

Tag Image File Format (*.tif, *.tiff)— TIFF and GeoTiff formats, included tags for
saving of georeferenced information;

PHOTOMOD MegaTIFF (*.prf)—is used to store voluminous TIFF images. MegaTIFF
format is a set of following files: *.prf and files of MS-TIFF format images placed to
folder which has a name of source file;

Windows Bitmap File (*. bmp);

VectOr Raster Maps (*. rsw) — images of GIS Panorama software;
ERDAS IMAGINE (*.1img) — ERDAS system raster format;

NITF (*.ntf);

JPEG (*.3pg, *.]peg);

PNG (*.png);

USGS DEM (*.dem);

PCIDSK (*.pix) — raster format with georeference in the heading developed by PC/
Geomatics company;

Enhanced Compression Wavelet (*.ecw) — is the raster file format optimized for
storing aerial and satellite images;
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* 11Q (*.1iq) —is the RAW file format for data obtained using the equipment by Phase

One;

* BIL (*.bil, band Interleaved by line) — is the raster format for storing multi-band data;

+ JPEG2000 (*.jp2) — raster format with jpeg compression and georeference in the
heading developed.

g The limitation on output file size of JPEG2000 format — no greater then 500 Mb.

é The system allows to create JPEG2000-files with size more than 500 Mb. To do that, in the
MegaTiff section choose Auto or Always on.

The following buttons in the Source section allows to select images source files:

- 3B — allows to select all files;

« B — allows to unselect all files;

i — allows to invert files selection.

Table 17. The List section toolbar

Buttons Function

= to select all files

=Sk to unselect all files

£ to invert files selection

il to enable display only source images of acceptable raster formats (see above). Filter is
enabled by default. The system allows to set the filter parameters manually in the field
to the right of the button

g, to restore filter settings to default values

+ to add to the list images files selected in the Files section

&= to open a drop-down menu that allows user to switch to other methods for adding files

- to remove selected images files from the list (they are not removed physically at that)

* to remove all images files from the list (they are not removed physically at that)

= to enable display of selected images with created pyramid in the View window (enabled
by default)

m to enable display of all images in the View window with automatic creating of temporary
pyramid (in case of its absence)

= to enable display of images with radiometric correction applied (enabled by default)

i to perform radiometric correction of image selected in the list

= to load radiometric correction parameters from a *. rmc file

=} to save radiometric correction parameters of selected image to *. rmc file

v to save radiometric correction parameters of each selected image to its own *. rmc file
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Buttons Function
[ to perform the autolevels for selected images without opening the Radiometric correction
window
= to create the pyramid
oY to create the pyramid (distributed processing)

The View section contains the image view window and toolbar with the following buttons:

&, — allows to zoom in an image by one step (*);
&}, — allows to zoom out an image by one step (/);
& - allows to fit to page data of opened layers (Alt+Enter);

@, — allows to display data in 1:1 scale, when one pixel of the image corresponds to
one pixel on the screen;

[ — allows to open image on full screen.

In case of low visual properties of source image, in the Raster Converter module could
be performed image radiometric correction.

The Output format section is used to define the following output parameters:

The File format section allows to specify output files format:
o MS-TIFF/BigTIFF — interior MS-TIFF format (chosen by default);
o Other format: — allows to select other output files format in drop-down list.

To perform radiometric correction, choose the following actions in the Correction
parameters section:

o Save separately (recommended) to save parameters of radiometric correction of
images into separate *. rmc files. In this case just geometric transformations (rota-
tion-flip) are applied to rasters directly;

@ At that the image is displayed in the system with all defined parameters of radiometric

correction.

o Apply to image to apply radiometric correction to the image directly without pos-
sibility to cancel radiometric transformations applied.

o Normalize histogram is used only to apply histogram normalization automatically
(to correct white color level).
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@ If a source image has more than three channels, it is recommended to perform histogram
normalization without radiometric correction in order to obtain output orthophoto with the
same number of channels and color depth. In case of creating orthophoto, set off the Use
radiometric correction from project checkbox in the Output image parameters window

(see the “Orthorectification” User Manual).

» Color depth — Auto, 8 bit or 16 bit.
@ If color depth of source image is less or equal 8 bit, then color depth of output image (with

the Auto option selected) will be 8 bit, otherwise, 16 bit.

+ Compression —allows to choose type of compression: without compression (None),
JPEG with quality specified by the user, or LZW, or Deflate without quality loss; In
case of using JPEG-compression, define quality of compression in percent.

g By default compression level is 80%, that allows to reduce images size in 5-7 times. In most
cases it does not cause loss of accuracy while the adjustment, and also allows to save storage
space.

@ This type of compression is applied to output images of MS-TIFF format only.

* In the MegaTIFF section define format to convert voluminous images:

MegaTIFF format is a set of following files: *.prf and files of MS-TIFF format images
placed to folder which has a name of source file and is created after conversion in
specified target folder.

% To limit file size included to MegaTIFF files set, choose Service > Settings » System and
specify the Maximum tile file size within MegaTIFF. Upper limit of file size — 8 192 MB; file
size by default — 1 024 MB.

To convert image in to MegaTIFF format, choose one of the following:

o Auto (by default) for automatic identification of output format depending on source
image size: MegaTIFF only if the size is more than 2 GB; otherwise — MS-TIFF
format;

o Always on to convert source images to MegaTIFF regardless of their size;

o Always off to convert source images to MS-TIFF regardless of their size. Images
with more than 4 GB size are displayed incorrectly in the system.

* In the Georeference section specify source files format with georeference:
o None — in case of no georeference files;

o Internal/GeoTIFF — to create GeoTIFF file;
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@ The Save datum parameters checkbox allows to save seven parameters of coordinate
system to meta data of TIFF-file.

o ArcInfo World File — to create file in chosen format with Arcinfo georeference;

o Maplinfo TAB - to create file in chosen format with *.tab georeference file.

@ Button [# button is used to choose coordinate system of georeference file.

To convert raster image perform the following:

1.

Select folder in the Folders section or click the _.. | button in the File section for
choosing folder.

Select image in the File section and click the + button to add selected files from
the Files section to the List section.

é The =+ button allows to open menu used to perform one of the following actions:
« Add all from the current folder;
+ Add all from the current folder and subfolders;
+ Add satellite images;

* Merge channels from files.

é The Raster Converter module allows to create s to form a list of files located in different
local/network folders, as well as on different media.

[optional] To display raster images in a View section or in the Raster Converter
window pyramid of selected image is required. Temporary pyramid is build automat-
ically, when you choose file without pyramid in mode of all images displaying. At
that, in the folder with source file creates the \Pyramid folder with pyramids.

% To create temporary pyramid for image displaying, click the &3 button.

[optional] Perform the image radiometric correction. To perform radiometric correction
without additional settings click the [if; button. The Auto levels window opens.
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Fig. 85. Selecting image correction mode

The following types of correction are displayed in the window:

Stretch channel histogram — allows to spread histogram evenly, separately in
each channel;

o Set the Trims left and right — area of histogram (in percent) which will not
consider in stretching of histogram.

+-3 std. dev. — allows to cut histogram area out of 3 standard deviations;
+-5 std. dev. — allows to cut histogram area out of 5 standard deviations;
Auto std. dev — allows to exclude light-exposed areas on image;

Manual std. dev. — allows to cut histogram area out of specified nhumber of
standard deviations;

o Set the value of deviation each pixel from 'average’ in the Standard deviations
field.

QuickLook — allows to use brightness from RSD files.

é Processed channels are Red, Blue, and Green. The channels are identified according
to the channel order displayed (or user defined) in the Channels window. Additional
channels are processed using the average QuickLook histogram.

Specify necessary parameters in the Output format section.
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6.

7.

8.

9.

In the Output files placement define an Output folder to save converted images:
+ Same as input;
* Folder — Images folder in the Windows file system;

ﬁ It is strongly not recommended to place image files in the root project folder (e.g., /Pro-
jects/InfoMap).

« PHOTOMOD resources — folder in the active profile resources.

[optional] In the Add prefix and/or Add suffix of the File names section define
arbitrary symbols to add to image file names.

Define actions if files with the same names exist in the target folder:

+ Choose new name automatically — new name automatically generated from a
template 'Name [i].Ext, where ’"Name.Ext — name obtained in the previous step,
and i/ — the serial number;

» Skip — allows to skip or not rewrite image;

* Overwrite (if not same as input); otherwise — new name — overwrite, if the
target file in a folder does not coincide with an input or generate a new file name
automatically if they match.

[optional] Set the Do not process images, only extract metadata checkbox on
to update metadata of aero/satellite images or to display metadata in existed project.

10. [optional] In order to start distributed processing perform the following actions:

é To process images correctly, it is strongly not recommended to choose files on a local PC
(in this case the system will display a warning that the input file list contains local paths)..

§ It is recommended to use the distributed processing mode to convert a big number of rel-
atively small images. To work with more than 3 GB images it is recommended to use
MegaTiff distributed processing (see below).

1. Change settings and run the distributed processing server/client (see the “Dis-
tributed processing” chapter).

2. Click the Distributed processing button. The Distributed image conversion
window opens.
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3.

4.

@ Distributed image conversion I,ﬁ,l

Images number 3

4|k

Tasks number 2

(04 ] | Cancel

L5 =

Fig. 86. Distributed image conversion parameters
Set the distributed processing Tasks nhumber.
ﬁ It is recommended to define number of tasks depending on computer power and

hardware, but not more than five tasks.

Click OK to create distributed processing tasks.

11. [optional] For distributed transformation of the selected images into MegaTiff format,
perform the following:

A\
5

7

To process images correctly, it is strongly not recommended to choose files on a local PC
(in this case the system will display a warning that the input file list contains local paths).

To work with more than 3 GB images it is recommended to use MegaTiff distributed pro-
cessing. To convert a big number of relatively small images it is recommended to use
common distributed processing mode (see above).

To limitimage files size included to MegaTIFF files set, choose Service » Settings » System
and specify the Maximum tile file size within MegaTIFF. Upper limit of file size — 8 192
MB; file size by default — 1 024 MB.

Change settings and run the distributed processing server/client (see the “Dis-
tributed processing” chapter).

Click the Distributed processing MegaTiff button. The Distributed processing
MegaTiff window opens.

The window displays the Number of images (the number of files in the list for
conversion) and the Number of MegaTiff fragments (is calculated automatically
and depends on initial image sizes);
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@ Distributed processing MegaTiff I,&J

Mumber of images: 3

Mumber of MegaTIFF fragments: 3

Mumber of fragments per task: 1 =

l K ] | Cancel

Fig. 87. MegaTIFF distributed processing parameters

3. Set the Number of fragments per task;

é It is recommended to define Number of fragments per task depending on computer
power and hardware. Recommended Number of MegaTiff fragments / Number of
fragments per task ratio is no more than 1000.

When setting distributed processing, it is also necessary to take into account the net-
work capacity. For example, for 1 Gbit/s local network the recommended Max tasks
is no more than 4.

% To set Max tasks quantity choose Service > Distributed processing > Monitor and
press the B button (see the “Distributed processing” chapter).

4. Click OK to create distributed processing tasks.

12. Click Convert to start the operation.

10.2. Radiometric correction
Images radiometric correction — means improvement of visual features of initial images.

Their insufficient quality may be due to the peculiar properties of the optical path of
surveying devices, radiant energy converter, analog-digital converter, etc. For example,
in case of 16-bitimage, that looks plain black on a screen, you have to perform histogram
correction.

é To perform search for 16-bit project images without radiometric correction (no *. rmc file associ-
ated with the image) choose Block > Check images (see “Radiometric correction” in the
“General information” User Manual). If images are found in the project that meet the criteria
described above, an appropriate info message is issued.

Images radiometric correction could be performed on different stages of project pro-
cessing, for example:

+ on stage of initial images preparation in theRaster Converter module;

142


general.pdf

PHOTOMOD 8.1 General information about the system (Windows x64)

» on stage of images loading from files, located out of profile resources, including
loading of satellite scanner images, as well as ADS 40/80/100 scanner images;

» on stage of block forming from project images;

» on stage of project images setting in the ImageWizard module.

The Radiometric correction window is used to perform radiometric correction of selec-

ted image.

Perform one of the following to open the Radiometric correction window:

« click the 7, button or the Radiometry button;

» double-click the left mouse button on the required image in the List subsection of
the main Raster Converter window;

» choose the Block » Image radiometric correction.

Table 18. The toolbox of 'Radiometric correction’ window

Buttons Function
= to load radiometric correction parameters from a *. rmc file
= to save radiometric correction parameters of image to *. rmc file
& to zoom in an image by one step (*)
SN to zoom out an image by one step (/)
& to fit to page data of opened layers (Alt+Enter)
@&, to display data in 1:1 scale, when one pixel of the image corresponds to one pixel on

the screen

to change the channels order

to perform the channel transformation

to perform the radiometric correction

to edit curves

to change brightness, contrast and gamma of image

to edit color balance of the image

to apply filters

to apply geometric transformation (rotate, reflection)

to cancel all actions (up to 10 last actions)

to undo the last action

to redo the last undone action

E Q|55 G| M| 1| B P=| B | B A

to view raster image histogram (see the “Raster image histograms” chapter in “Creating
project” User Manual)

Perform the following actions for radiometric correction:
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Select image in the List section in main window of the Raster Convertermodule.

Click the 5 button or double click the strip name in the list. As a result, temporary
pyramid for faster refresh of image creates and the Radiometric correction window
opens.

§ Temporary pyramid is placed in the \Pyramid folder inside of folder with source images.
To display images in scales differing from 1:1, required amount of free place on chosen
hard disk to store temporary pyramid’s files.

[ Rsdiometric correction: DIL0380 (4000 x 3000 x3 x8) ==X
FadAA WA SBHEIEUFSID oo~ W

000y ~0.000[R~141G-1428-163 ok Concel

Fig. 88. The Radiometric correction window

Name, height, width and byte per pixel of image are displayed in the title of the
Radiometric correction window. Coordinates of marker and brightness are dis-
played in the status bar of window.

It is recommended to perform autolevels setup for 16-bit image. Otherwise it is
displayed with black color.

@ If bytes per channel more than 8, histogram of images stretches for full brightness range
separately on each channel.

ra Question u‘

a—

Raster 16 bits per sample!

L * 4
Perform autolevels?

[ Yes ] ’ Mo ]

W #

Fig. 89. Requirement to perform radiometric correction
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4. Click the Yes button. The Auto levels window opens.

5.

' N
@ Auto levels [&J
Mode: |Standard deviations -

Trim left: 0.00 | %
Trim right: 0.00 T %

| Cut background
Background color: 0

4|k

L1

Tolerance: 0

Standard deviations: 3.00 = Auto adjust

Ok | | Cancel | | Apply |

Fig. 90. The Auto levels window
Setup parameters of correction (see below) and click OK. Image radiometric correc-
tion is performed.

§ Generally, it is suffices in the Standard deviations mode specify the Standard deviations
value or click the Auto adjust button to correct image automatically.

The system allows to save radiometric correction parameters to *. rmc files in order to
apply these parameters to other images. Perform the following actions to do this:

1.

2.

Select image in the List section in main window of the Raster Converter module.
Setup parameters and perform radiometric correction of selected image.

Click the g button and define a folder to save radiometric correction parameters
in file with *. rmc extension.

§ To save radiometric correction parameters in folder with source image, click the ' button.

Choose image for correction in the list.
Click the 2 button. The load correction parameters window opens.

Choose parameters file file and click OK. Correction parameters apply to selected
images.
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Perform the following to change the number of channels and the channel’s order of
output image:

1. In the Radiometric correction window click the & button. The Channels window
opens.

@ The first order of channels is set depending on their order in the source image.

r@ Channels @1

Red: |Channe|: 1 v|
Green: |Channe|: 2 v|
Blue: |Channe|: 3 V|

@) RGB and other channels
RGE only

Grayscale (single channel)

[ 0K ] | Cancel | | Apply |

L% 4

Fig. 91. Window of the order channels setup

2. Specify the mode of channel usage in the system:
* RGB and other channels — all image channels are to be used;

% The user can assign any channel as a red, green, or blue one (see below, next subsec-
tion). Other image channels will be considered as supplementary.

* RGB only — only three channels are used;

§ The user can assign any channel as a red, green, or blue one (see below, next subsec-
tion).

When processing images with a large number of channels, using RGB only mode (or
channels designated as such) allows one to exclude “extra” channels from processing
if the user does not need them to perform current tasks.

In this case, the size of the images under processing can be notably reduced (provided
that in the Raster Converter module, the user intends to apply radiometric correction
directly to the images themselves).

» Grayscale (single channel) — is used to display one channel.
% The Raster Converter module also provides for transforming a one-channel panchro-

matic raster image into a three-channel one. For this, when converting such an image,
choose RGB only. As a result, when saved, the image has three identical channels.
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3. Setup channels order to display and use in the system.

@ The Apply button allows to display changes.

4. Click OK.

<

When applying the radiometric correction to images (in particular, when setting the mode and
order of using raster channels), it is necessary to take into account that the user can apply ra-
diometric correction in different ways, i.e., both apply the selected settings to the raster (over-
writing the image — Apply to image option) and Save separately the correction parameters in
a file *. rmc.

In certain cases, during further data processing, the user can either use the radiometric correction
parameters saved as a *. rmc file or not take them into account (see the “Orthorectification” and
“Orthophotomaps creation” user manuals).

PHOTOMOD provides for configuring in detail the number and order of channels (including
when processing data containing more than three channels) in the output images created by
PHOTOMOD, after completion of the main processing of the project during the orthorectification.

The configuration is performed in the Output image parameters window (see “General orthoim-
ages creation parameters” in the “Orthorectification” User Manual and “Mosaic’s main parameters”
in the “Orthophotomaps creation” User Manual.

Perform the following to change transformation parameters of output image:

A

1.

It is impossible to preform channels transformation for image with single channel.

In the Radiometric correction set the checkbox on near to the S button and click
the S button. The Channels transformation window opens.

[ Channels transformation [&y
Red Green Blue
3 0.000 0.000 1.000
4 0.000 0.000 0.000
[ Ok ] | Cancel | | Apply

Fig. 92. The Channels transformation window

2. Change values in the channels table.

3. Click the Apply button to display changes.
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4. Click OK to save changes.

Perform the following to perform more detailed radiometric correction (to correct white
color level):

1. Inthe Radiometric correction window click the [i, button. The Auto levels window
opens.

@ Aute levels L&J
Mode: |Standard deviations -

Trim left: 0.00

%

4|k 4k

Trim right: 0.00

| Cut badkground
Background color: 0

%o

4k 4|k

Tolerance: ]

Standard deviations: 3.00 = Auto adjust

| oK | | Cancel | | Apply |

Fig. 93. The Auto levels window

2. Choose the correction Mode:
» Separate channels — correction separately for each channel,
« All channels — correction for all channels rateable;
* Red, Green, Blue - correction only for chosen channel;

» Autocolor — automatic selection of the best brightness for displaying;

Standard deviations — stretching histogram of source image for full brightness
range;

QuickLook — allows to use brightness from remote sensing data files.

@ Processed channels are Red, Blue, and Green. The channels are identified according
to the channel order displayed (or user defined) in the Channels window. Additional
channels are processed using the average QuickLook histogram.

+ External image — using image from folder as a sample for correction.

3. Setthe Trims left and right — area of histogram (in percent) which will not consider
in stretching of histogram.
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4. [optional] By default the Cut background checkbox is set. This function allows not
to take into account the background on image edges during the correction. To ex-
clude background parts from the correction, set the following parameters:

» Background color — value of background color;
@ If the O value is set in the Background color field, background also will be changed

during the correction.

* Tolerance — deviation from background color value.

5. Set the value of deviation each pixel from ’average’ in the Standard deviations
field.

@ The Auto adjust button allows to calculate value of Standard deviations in such a way
as to none of pixels was not light-exposed.

6. Click OK. As a result histogram stretches of source image for full brightness range.

To view histogram of image and setup activation function, that specify arbitrary brightness
transformation, perform the following:

g Activation function in graphic form is a curve with color of chosen band. Values of brightness
on source images are placed by X-direction (values in the In field), be Y-direction — values after
transformation (values in the Out field). Activation function is specified by creating nodes on
curve. Activation function between nodes is a cubic spline.

1. In the Radiometric correction window click the & button. The Curves window
opens.

( @ Curves &Jﬁ
Channels:|Red - E E

E)
B

—
“““ Load...

----- | saven |

For all

————d--t——t-—F——F—-

Preview

————— Cancel

cobodbodbodlsodoofbooboddbod

T- R~ r=a~ =A== 1= 1="r=-r=1

T T T AT T T TR T T I T T
Loloobodbodbodloodooltoolbo

| Apply |

| Cut background
Background color: 0 + Tolerance: [u}

4.

In Out

Fig. 94. The Curves window
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The window contains the toolbar with buttons used to perform the following opera-
tions:

+ [] — allows to restore linear dependence;
- HH — allows to display grid;
+ [&] — allows to show source histogram (with gray color);

+ [&] — allows to show destination histogram (with white color);

— allows to smooth segment;

* Restore — allows to restore source curves;

Load — allows to load curves from *. crv-file;
» Save —allows to save curves in to *. crv-file (by default in the folder with images).

Values of brightness of node in source and changed histograms are displayed ac-
cordingly in the In and Out fields.

2. [optional] To edit channels histogram separately, set the For all checkbox off and
choose Channel for edit from the list.

5 By default the For all checkbox is set on to edit curve for all channels in one time.

3. [optional] By default the Cut background checkbox is set. This function allows not
to take into account the background on image edges during the correction. To ex-
clude background parts from the correction, set the following parameters:

» Background color — value of background color;

@ If the O value is set in the Background color field, background also will be changed
during the correction.

* Tolerance — deviation from background color value.
4. [optional] Set the Preview checkbox on to preview changes.

5. Click on histogram to add node. To move node, move marker holding pressed Ctrl
or Alt key.

@ To select node, click in its vicinity. To delete node, right click on it.
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6. Click the Apply button to apply changes and return to the Radiometric correction

window.

To perform color correction do the following actions:

1.

In the Radiometric correction window click the ¥ button. The Brightness-Con-
trast-Gamma window opens.

@ Brightness-Contrast-Gamma I,ﬂh,l

Channels: |Red -

Brightness: D
Contrast: D
Gamma: D

| Cut background
Background color: 0

4|k

4|k

Tolerance: 0

| On fly For all

[ Ok l | Cancel Apply

h &

Fig. 95. The Brightness-Contrast-Gamma window

Choose Channels for correction;

§ To correct all the channels in the same time set the For all checkbox.

Setup balance of image brightness, contrast and gamma using sliders.

[optional] By default the Cut background checkbox is set. This function allows not
to take into account the background on image edges during the correction. To ex-
clude background parts from the correction, set the following parameters:

» Background color — value of background color;

@ If the O value is set in the Background color field, background also will be changed
during the correction.

» Tolerance — deviation from background color value.

[optional] To display changes automatically set the On fly checkbox on.

@ The Apply button allows to display changes.
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6. Click OK to apply color corrections of image.
To perform color balance do the following actions:

1. In the Radiometric correction window click the ¥& button. The Color balance
window opens.

r !
@ Color balance [i"j-]
Cyan D Red
Magenta D Green
Yellow |_ Blue
Values: a = 0 = 0 =

| Cut background
Backaground color: 0

4|k

(e

Tolerance: 1]

on fly

QK ] | Cancel | | Apply

Fig. 96. The Color balance window
2. Set the red, green or blue channels balance using sliders or input values of color
in the Values field with range from -100 to 100.

3. [optional] By default the Cut background checkbox is set. This function allows not
to take into account the background on image edges during the correction. To ex-
clude background parts from the correction, set the following parameters:

» Background color — value of background color;

? If the O value is set in the Background color field, background also will be changed
during the correction.

» Tolerance — deviation from background color value.

4. [optional] To display changes automatically set the On fly checkbox on.

% The Apply button allows to display changes.

5. Click OK to apply color balance of image.
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To improve visual properties of source image with using different filters perform the
following:

1.

In the Radiometric correction window click the Z button. The Filters window

opens.
i !
i Filters e e
Filter type: |Shar|:uen edges v|
Aperture size |3}(3 - |
Filtering level {0-100%:)
y

Threshold: 0.50000 =

| Cut background
Background color: 0

L1132

Al

Tolerance: 0

On fly

Ok ]| Cancel || Apply

Fig. 97. The Filters window

2. Specify one of the following image processing types in the Filter type list:

» Blur - is used for image details dithering;

» Gaussian blur —is a type of blur filter where transfer value is not a linear function,

but part of Gauss function ('Bell curve’);

Sharpen — allows to highlight and intensify differences between image’s individual
details (image sharpness);

Sharpen edges — is used to setup image sharpness, but performs filtering only
when brightness differences between details are exceeding some threshold;

o Set the Threshold.

% Suits very well for identifying and highlighting of objects borders which are homogeneous
insight (agricultural fields, for instance), at that inner part of objects remains unchanged.

Median — non-linear filter intended mainly for impulse noises filtration (single

pixels with unnatural brightness);

Sobel — non-linear differential filter, which is the first derivative of the initial raster.
Used to acquire contour borders of image in raster form.
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3. Inthe Aperture size list define the matrix size from 3x3 pixels to 21x21 pixels.
4. Move slider to define Filtering level in percent.

5. [optional] By default the Cut background checkbox is set. This function allows not
to take into account the background on image edges during the correction. To ex-
clude background parts from the correction, set the following parameters:

» Background color — value of background color;
@ If the O value is set in the Background color field, background also will be changed
during the correction.
» Tolerance — deviation from background color value.
6. [optional] To display changes automatically set the On fly checkbox on.

@ The Apply button allows to display changes.

7. Click OK to apply filter.

For geometric transformations of image in the Radiometric correction window, click
the button. The Rotate-flip window opens, you can use it for selection of rotation
angles (at 90,180, 270 degrees) or horizontal/vertical reflection. To cancel the last op-
eration or all geometric transformations applied to image using appropriate buttons.

@ Rotate-Flip &J
g &
[ Ok ” Cancel |

Fig. 98. The Rotate-flip window
10.3. Prepare scanner images

10.3.1. Adding scanner images

The system provides possibility of converting scanner images into internal PHOTOMOD
format and perform their radiometric correction. To add scanner images to a list for
conversion is used the Add pushbroom images window. In order to open the window
click the =+ button of the Raster Converter toolbar and choose Add satellite images
in the open dropdown list.
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4 Add pushbroom images [
MName Size Type Last Modi = | C:\fr_0043_0102_01321_1_01314_05_10_ps E]

« Drive 12.05.20; Name Size Type Last Modified -

cygwinGd File Folder 24.04.200 Pyramid File Falder 27.05.2024 12:38
* File Folder 13.05.20; fr_D043_010 632,67 MiB tif File 20.01.2022 16:08
datal File Folder 2405204 fr_0043_010.. 682,67 MIE tif File 2001.2022 16:08 3
data2 File Folder 2705.204 = fr_0043_010 682,67 MiB tif File 20.01.2022 16:08
data2_out File Folder 01.09.204 fr_0043_010... 682,67 MiB tif File 20,01.2022 16:06
data3 File Folder 15.11.204 fr_0043_010.. 357,02 MIB tif File 20012022 16:06
data3_out File Folder 1207.200 | # o043 010 682,67 MiB tif File 20.01.2022 16:06
datad File Folder 20.09.20 fr_0043_010... 682,67 MiB tif File 20.01.2022 16:06
datad_out File Folder 12.07.20: fr_0043_010... 682,67 MiB tif File 20.01.2022 16:04
data’ File Folder 0406200 || # o043 010 682,67 MiB tif File 20.01.2022 16:04 i
datab File Folder 1210.20: =1
DocBook File Folder 14.05.201 Autosearch
DocBookSoft File Folder 03.03.201 “) Only in current folder
EXAMPLE PROJECT File Folder 140520: | ) From current folder
fr 0043 0102 01321 1 01314 05 10_ps File Folder 37.05.20; D N
Geomosaic File Folder 15.05.20: 7] Show rasters without metadata
> ) Intel File Folder 3105200
RS - eraran. 1917
Project images Added images
N
Name R D Type Width Height Bands Bytes/pixel

Fig. 99. Automatic images search in remote sensing product
The Add pushbroom images window consists of the following parts:

« folder tree in the left part;

* in the Project images section is displayed the list of images already added in the
project (their project names);

+ list of found images in the right part;
» parameters of searching files specifies in the Auto-search section;

» the Images to add section contains table with found images, their names and prop-
erties and also buttons to edit properties of image.

The table contains the following columns:

o Name — allows to change project name of selected image (by default the image
name is the same as the file name);
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@ Edit the appropriate cell to change project name of selected image (by default the image
name is the same as the file name).

o R — denotes that the radiometric correction was performed;

o ID — source name of image, obtained from metadata;

o Type — type of sensor, from which image was obtained;

o Width/Height — linear size of sheet (in pixels);

o Bands — number of channels in image;

o Bytes/pixel — number of bytes per pixel of image.

The Images to add table contains the following buttons used to work with images:

o ¢n — allows to perform radiometric correction of selected image;

é’ If the radiometric correction is already performed the R column of the table displays +
symbol for selected image, otherwise — — symbol.

o ¥ — allows to remove selected images from the table;
o #& — allows to remove all images from the table;

o [ — allows to display features of selected image;

Image ID: _PAN

Image type: KOMPSAT-3 Level 1R PAN

Preprocessing level: Level1R

Farmat: GEOTIFF

Along track GSD {m): 0.865063

Across track GSD (m): 0.86903

Acquisition date and time: 24/03/2016

04:12:59,732

Revolution number: 20547

Satellite; KOMPSAT-3

Sensor: AEISS

Imaging mode: Stereo Imaging Mode

Off-nadir angle: 28.9

Raster height: 18496

Raster width: 24060

Bands count: 1

Image frame:

upper left: (1 1) (-42.891417 147.156803)
upper right: {24060 1) {-42.814553 147,392327)
lower left: {1 13496) (-43.027698 147.211336)
lower right: (24060 18495) (-42.951852
147.446752)

Fig. 100. Image properties
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o hen — allows to create the georeference file in MIF/MID format.

@ Ctrl+A hotkeys allows to select all images.

In order to add satellite images to a project perform the following actions:

1.

In the folder tree choose folder that contains images. The contents of selected path
are displayed in the right part of the window.

In the Autosearch section define the following settings:

+ Selected folder only used to search for remote sensing data in the selected
folder only;

» Selected folder and subfolders used to search for remote sensing data in the
selected folder and its subfolders.

* Pan-sharpening allows to open the Adding images found window to view de-
tailed parameters, to perform pan-sharpening operation and images setting.

» Show rasters without metadata — allows to perform search of all files with im-
ages in selected folder, including those without metadata.

Click the Search button. In the Images to add section are shown found data.
? Already added images are marked in the table by gray color.

While searching for images with metadata, in the added images list they can be
highlighted with various colours depending on processing level:

* Red colour — indicates non-photogrammetric images;

* Yellow colour — indicates images without any orientation data. Only generic ad-
justment method is applied to them (see the “Processing images algorithms”
chapter in the “Creating project” User Manual).

[optional] Click the & button to perform radiometric correction of images, selected
in the Images to add table.

Click the Add all button to add all images of the table to the list of convertible files.
Click the Add selected button to add one or more images.

é Scanner images are marked with # symbol before image name.
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10.3.2. Detailed properties of adding scanner images

To display detailed parameters of recognized remote sensing products, choose, prepare
and add found images manually to load them to a project is used the Add pushbroom
images window.

Perform the following actions to open Adding images found window:

1. Choose folder that contains images. The contents of selected path are displayed
in the right part of the window.

2. In the Autosearch section set on the Pan-sharpening checkbox.

3. Click the Search button. The Adding images found window opens.

|4 Adding images found &J

Products Product images list

| 1 Name R D Type Width Height Bands

|SCENEiDZLHRiMiZGlB—lGrG?T(]EUSjQ‘EiZM SCEME_DZZ_HR_M_2018-10-07T08_15_59.6_24456 - SCEMNE_DZZ_HR_M_2018-10-07T08_15_59.6_24456 D7Z-HR SCENE level 2 RPC 6464 6332 4

Project images Added images

Ot WEX A

Mame R ID Type Width Height Bands Bytes/pixel

G

Fig. 101. Detailed properties of adding scanner images

When the images list is formed click the Close button in the Images to add section
(see below) to go back to the Add pushbroom images window. The Images to add
section of the Add pushbroom images window displays all images to be loaded (added
both automatically and manually).

The Adding images found window is divided for Products and Project images parts.

The Products panel is used to view properties of RS products found and contains the
following features:
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* The Products table is used to view found RS products and their properties (ID of
product delivered by supplier, product type — sensor type and preprocessing level,
product format, number of images included to the product);

@ For images without metadata found by auto-search with the Show rasters without metadata
checkbox set, Raster is displayed as a product type.

* The Product images list table is used to display only images included to remote
sensing product and their properties (ID, width, height, number of channels and
number of bytes per pixel).

é Itis not recommended to change image ID received from supplier using standard OS Windows
tools, for instance.Otherwise, you may face some issues during work with the image, since
the rest of files related to the product may be associated with initial file name.

The Project images panel is used to view images properties, perform radiometric cor-
rection, define project names and manually form a list of images to be added to a project.
The panel Images contains the following features:

* The Project images table is used to display images loaded to a project (project
names of the images).

+ The Added images table is used to display data selected for loading to a project.
The table shows all images selected for loading: added manually to the Adding im-
ages found window and added automatically to the Add pushbroom images window.

The table displays the following images properties: ID, width, height, number of
channels, number of bytes per pixel, and label about radiometric correction availability
+/- in the R column (see Section 10.2).

§ Edit the appropriate cell to change project name of selected image (by default the image
name is the same as the file name).

The Added images section contains the following buttons used to work with images:
o 1] — allows to display the features of image, selected in Added images table;

o i — allows to open the Files of product window, which is used to display all files
(images files, files with metadata) of remote sensing product and their properties
(name, path, size and extension);
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( @' Files of product ﬁw
Mame Path Size Type
metadata.dim | C:\dstaan_d. 1067262 Metadata
IMAGERY'I'[F ------------ Ci\datadiraw_d... 340829445 Irnage
RPC.XML Ci\datadiyraw_d... 11070 RPC
PREVIEW.JPG C\data4yraw_d... 110277 Preview
ICOMJPG Ci\datadyraw_d... 2597 Icon

Fig. 102. The product files list

o hen — allows to create the georeference file in MIF/MID format;

@ Ctrl+A hotkeys allows to select all images.

o Il - is used to start pan-sharpening operation — merging of color (multispectral)
image with grayscale one with more high spatial resolution to obtain as a result
color image with better resolution;

o k% — allows to add selected image to the Added images table to load it then to the
project;

o ¥ — allows to remove selected images from the Added images table;
o ¢n — allows to perform radiometric correction of selected image.
% If the radiometric correction is already performed the R column of the table displays +
symbol for selected image, otherwise — — symbol.
10.4. Merging channels from separate files

The system provides for combining images into single raster files, the different channels
of which were originally delivered as separate files. To perform this operation, use the
channels merging window.

To go to this window, perform the following:
1. Open the folder with detail in the main Raster Converter window;

2. Select the needed files and click the 4 button on the toolbar to add the to the List:
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|} PHOTOMOD Raster Converter 5 [l
Folders Files [selected: 0/ 7] View
Name o In folder: wiTestsYK \Mica\rededge-p-soccer-field-sample-datasetiTest1_image E
| rol_shut B % Rame O
SAR Vizard MName Size Type Last Modified
Topodrane P d ] File Fold 29.09.2023 16:32
220k 09_2021_Fixar007 yram! i € PO b :
[ m6_01361... 3,03 MiB tif File 19.05.2022 22:45
. maum
N = = m6 0136 2... 3,03 MiB tif File 19052022 22:45
. y VK IMG_0138 3... 3,03 MiB tif File 19052022 22:45
) ABOCO IMG_0135 4... 3,03 MiB tif File 19052022 22:45
, on IMG_0136_5... 3,03 MiB tif File 19.05.2022 22:45
Leica ALSS0 ¢ kamaepoi RSD30 IMG_0136 6... 9,67 MiB tif File 19.05.2022 22:45 +
Mica
4 | rededge-p-soccer-field-sa...
E 3 2 * bFE EF - - -] - |
rep-sample-data2 HED LAl Ml x @ a2
Testl_image List [selected: 0 /6]
. Pollux File i
MeITh \WHEAP3\Pirogowt Tests\VIK\Mica‘rededge-p-soccer-field-sample- datasett”
CeeTnos TecT
. Teet 2 \WHEAP3\Pirogovi Tests\WK\Mica'rededge-p-soccer-field-sample- dataset'”
_ y nnn S _ _ L
< [ 3 < . +
Output format
File format Correction parameters Color depth Compression MegaTIFF Georeference
@) MS-TIFF/BigTIFF @ Save separately @ Auto ) Mone @ Auto @ Nane
() Other format: © Apply to image © sbit @ PEGwithqualty 90 [2] % @ Awayson () Internal {GeoTIFF
() Normalize histogram ©) 16bit @ LZW ©) Aways off © Arcnfo World File
) Deflate () Maplnfo TAB
[7] Save datum parameters
Output files placement
Output folder File names When output file exists
@ Same as input () Choose new name automatically
) Folder Add prefix @ Skip
(©) PHOTOMOD resources Add suffix () Overwrite (if not same as input); otherwise - new name
[ Do not process images, only extract metadata [ convert | [Distributed processing... | [Distributed processing MegaTiff| | Close

Fig. 103. The Raster Converter window

3. Select the needed files in List section, click the +, button of the Raster Converter
toolbar and choose Merge channels from files in the open dropdown list. The
Merge channels from files window opens:
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- Ny
Channels merging. @
Grouping View
L& : o
Showing:

YWHEAP3\Pirogowi Tests\MK\Mica\rededge-p-soccer-field-sample-dataset\ Testl_image\IMG_(
YWHEAP3\Pirogowv\ Tests\MK\Mica\rededge- p-soccer-field-sample-dataset\ Testl_image\IMG_{
YWHEAP3\Pirogowv\ Tests\MK\Mica\rededge- p-soccer-field-sample-dataset\ Testl_image\IMG_{ Q Q @ @k =
YWWHEAP3\Pirogowi\ Tests\MK\Mica\rededge-p-soccer-field-sample-dataset\ Testl_image\IMG_|
WWHEARS\Pirogow\ Tests\ MK\ Mica\rededge-p-soccer-field-sample-dataset\ Testl_image\IMG_(
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Groups Group's files
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GROUP

Alignment
(@ use ¥MP metadata
perform correlation

default

Add alpha-channel

Rewverse channel order

[Apply to selected] [ Apply to all ]

[ OK ” Cancel ]

Fig. 104. The Channels merging window

The channels merging window consists of the following sections:
* Grouping — instruments of automatic file grouping;

* File list— displays the original list of files under processing containing separate image
channels;

5 The system allows for processing several such images at once.

* Groups and Group’s files — for manual file grouping;

§ File group — are files containing single channels of one specific image. Files in a separate
group are intended to be merged into a single raster

+ View - is for previewing the selected raster file;

+ Alignment — allows the user to set the parameters of geometric alignment of images
containing individual channels relative to each other.
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<

Structural and operational features of surveying instruments that record each channel of a
single image as a separate file often lead to the fact that images containing single image
channels are actually slightly shifted relative to each other. Alignment implies a shift ofimages
containing single channels relative to the first such image in the group list, until the objects
contained in the image match geometrically.

This operation is performed either by processing image metadata (if any), or by means of
the PHOTOMOD (using the correlator). Note, that if the channel images are displaced relative
to each other, then alignment, for obvious reasons, leads to the formation of “margins” at
the edges of the resulting image.

The name of the resulting image (and group, in case of automatic grouping) corresponds to
the name of the first image in the group. During further processing of the project (aerial trian-
gulation and adjustment), it must be taken into account that the geometric characteristics of
the resulting image correspond to the geometric characteristics of the firstimage in the group
(relative to which geometric transformations of other images containing other channels are
performed).

The system also provides for the possibility of cropping image edges during the creation of
PHOTOMOD output products, such as DEMs, textured 3D surfaces and orthomosaics (per-
formed after aerial triangulation and adjustment).

The View section contains an image view window, a caption that displays the name of
a group of images, a field, showing the path to the image selected for viewing, and a
toolbar with buttons for performing the following operations:

« & — allows to zoom in an image by one step (*);

« & - allows to zoom out an image by one step (/);

- & - allows to fit to page data of opened layers (Alt+Enter);

« @ — allows to display data in 1:1 scale, when one pixel of the image corresponds to
one pixel on the screen;

« [ - allows to open image on full screen.

7

To show/hide scroll bars in the View window is used the Ctrl+F8 hotkeys.

To create an output raster file, perform the following:

1. Divide files into groups by images. One group should contain files with single
channels belonging to one image.

Files can be divided into groups automatically (in case when file names reflect that
image files belong to a specific image, or when these files are already distributed
over existing separate folders).
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The system also allows for manual grouping of files. In the case of processing a
large number of images, this process can be quite time consuming, but it allows
the user to customize the order of channels in each resulting image as needed.

* [optional] To divide files into groups automatically, do the following:

o [optional] Click & in the grouping section, to divide the files into groups by
folder, in case the files belonging to separate images are already sorted into
folders accordingly. The system automatically creates groups of files according
to the subfolders contained in the data folder;

o [optional] make sure that image files are sorted in the correct way by their
names in the File list (to sort by names, if appropriate, click the title of this list
by the left mouse button).

A The name of the resulting image matches the name of the first image in the group.
To provide a further correct comparison of the resulting image with the exterior orient-
ation data, before merging, make sure that in all groups the image files are correctly

sorted by names, in the sequence A—Z.

Specify the number of channels for processed images in the appropriate field
of the Grouping section, then click  to create file interleaved groups. The
system automatically creates groups of files, according to the names of the
images and the specified number of channels that each image should contain;

o [optional] make sure that image files are sorted in the correct way by their
names in the File list (to sort by names, if appropriate, click the title of this list
by the left mouse button).

Specify the number of images among the data under processing in the appro-
priate field of the Grouping section, then click | | to create band interleaved
groups. The system automatically creates groups of files, according to the
names of images and the specified number of images;

ﬁ In the process of organizing files into groups, the corresponding image files are ex-
cluded from the File list and displayed in the Group’s files section.

ﬁ To view Group’s files, select the required group by clicking it by the left mouse
button in the group list.

ﬁ If the grouping was incorrect, click % in the Groups section to reset current file
grouping. Every current group will be deleted, every image file will be displayed in
the File list.

* [optional] to group files manually, use the File list, Groups and Group’s files
sections, as well as image View section.
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Use + and — in the Groups section to create or delete new file groups. To edit
or delete the selected group, click it in this list by the left mouse button.

Use + and — in the Group’s files section to link the selected file to the pre-
selected group and to unlink a file added to it earlier from the group, respectively.
Files are selected (in the file list, to add a file in the selected group; or in the
group file list, to remove file from the group) by clicking the left mouse button.

@ The order of adding files to a group determines the order of the channels in the resulting
image. The name of the resulting image corresponds to the name of the first image in
the corresponding group.

When further processing the project, it must be taken into account that the geometric
characteristics of the resulting image correspond to the geometric characteristics of the
first image in the group (relative to which geometric transformations of other images
containing other channels are performed during alignment).

2. Make sure that files were correctly grouped using the image view section;
3. Choose the way of performing Alignment (see above):

* Use XMP metadata;

» perform correlation;

* no alignment (default).

4. [optional] Set the appropriate checkboxes to add alpha-channel to the resulting
image and/or reverse channel order. To apply these setting to all images, click
the Apply to all button. To apply these settings to the selected image (or images),
first select the desired groups of images and click the Apply to selected button;

5. Click OK to close the channels merging window and go to the main Raster Con-
verter window to start creating the resulting images.

After the channels merging window is closed, in the List section of the Raster
Converter window, instead of the source raster list, a list of future images that are
supposed to be created as a result of merging is displayed.

At this stage, the system already provides for radiometric correction of those still
“virtual” images, which will be considered by the program as an integrated image
with several channels.
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Fig. 105. The Raster Converter window

11. The pan-sharpening operation

The system provides possibility to perform the pan-sharpening operation.

Pan-sharpening is merging of color (multispectal) image with grayscale one with more high
spatial resolution to obtain as a result color image with better resolution.

As the result of pan-sharpening operation, new multispectral image is created possessing
the same high spatial resolution as the grayscale image.

It is possible to perform pan-sharpening during the adding scanner images (or preparing
scanner images in Raster Converter), that becomes available when the system detects
images suitable for such operation in remote sensing product. Pan-sharpening operation
also could be applied to any chosen images (including batch images processing).

Batch processing of scanner imagery is also available, but in this case the pan-
sharpening operation is performed for images located in a folder in the Windows file
system, before adding images in the project.
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11.1. Pan-sharpening operation during the adding scanner images
(or preparing images in Raster Converter)

c When synthesizing a multispectral image, the following methods can be used to increase spatial
resolution of the output image: Brovey, HSV, Principal Component Analysis and Enhanced
Principal Component Analysis (see Section 11.1.1).

The Enhanced Principal Component Analysis method (selected by default) is recommended
and does not require radiometric correction. In this case is strongly recommended to refrain
from performing radiometry correction.

For correct multispectral image synthesis using the methods Brovey, HSV and Principal
Component Analysis radiometric correction must be performed. If a radiometric correction
was not performed for the selected image it will be requested to perform it during the pan-
sharpening operation.

Perform the following actions to merge images during adding images in project:

1. Inthe window displaying detailed parameters of recognized remote sensing products
(see Section 10.3.2) after found images for pan-sharpening, click the @ button.
The Pan-sharpening window opens:

ﬁ The window displaying detailed parameters of recognized remote sensing products will

open after clicking the Search button in the Add pushbroom images window (in case the
Pan-sharpening checkbox is set, see Section 10.3.1).

If images suitable for Pan-sharpening are not found, the appropriate button in the detailed
parameter setting window is displayed as inactive ().

7

@ Adding images found @
Products Product images list
ID Product type Productformat [mages Name R pio] Type Width Height Bands Bytes/pixel
.m i,PAN = _PAN KOMPSAT-3 LevellR PAN 24060 18406 1 2
LevellR GEOQTIFF 2 _Ms - _MS  KOMPSAT-3 LevellR M5 6015 4624 4 g
LevellR GEQTIFF 2
LevellR GEOTIFF 2
d I, 3
Project images Added images
Mk MR X A
Name R ID Type Width Height Bands Bytes/pixel
Cancel

Fig. 106. Example of images pair: color image (4 channels) and panchromatic image (1 channel)
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2. Choose panchromatic image in the High-resolution image table;

f H Pansharpening [ér

High-resolution image

R D Type Width Height Bands Bytes/pixel
_PAN KOMPSAT-3 LevellR PAN 24060 18496 1 2
_PAN - _PAN KOMPSAT-3 LevellR PAN 24060 18492 1 2
_PAN - _PAN KOMPSAT-3 LevellR PAN 24060 18060 1 2
_PAN - _PAN KOMPSAT-3 LevellR PAN 24060 18060 1 2

Multispectral image

Na‘me R D Type Width Height Bands Bytes/pixel
M5 - _M5 KOMPSAT-3 LevellR MS 6015 4624 4 8
M5 - _M5 KOMPSAT-3 LevellR MS 6015 4623 4 8
M5 - _M5 KOMPSAT-3 LevellR MS 6015 4515 4 8
M5 - _M5 KOMPSAT-3 LevellR MS 6015 4515 4 g
[ OK ] [ Cancel ]

Fig. 107. Choosing images for pan-sharpening

3. Choose color image in the Multispectral image table;
4. Click OK. The Pan-sharpening window opens:

- N
B Pan-sharpening Iﬁ
Parameters Correlation

Output channels

RGE

@ al

Pan-sharpening method:

) PCA @ Hsv () Brovey (0) EPCA

Cut off source images background color

Background color: ] =
Color depth: [Auto v]
Areas outside color raster [Badcground color v]

Color fill putside color raster
0.50 = (pix)
|:| Measure tie points

|:| |Jse source images georeference

[ 0K, ” Cancel ]

Fig. 108. Parameters of pan-sharpening
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5. Setup the parameters of pan-sharpening (see below);

6. Click OK. Wait until the operation is complete. The virtual file PhPanSharpened with
one image is displayed in the Products section of the Adding images found win-
dow:

f Adding images found I&
9 g

Products Product images list

hiv] Product type F Mame R jin] Type Width Height Bands Bytes/pixel

LevellR _PAN_PhPanSharpened - _PAMN_PhPanSharpened KOMPSAT-3 LevellR PAM 24060 18406 4 8
LevellR
LevellR

LevellR

_PhPanSharpened | LevellR PhPanSharpenEd

4 mn 3 4 n 3

Projectimages Added images
O Sk B X A

MName R ID Type Width Height Bands Bytesjpixel

Fig. 109. Virtual product PhPanSharpened with one image

é The process of pan-sharpening performed after specifying parameters of transformation,
but before adding images into project (see Section 10.3.1). This process could take much
time.

% If one of the following methods for increasing spatial resolution was selected during the
parameters setup: Brovey, HSV or Principal Component Analysis, and the radiometric
correction was not performed for the selected image, it will be requested to perform it.

7. Choose images in the Product images list table to add them in the Added images
table (E);

8. When the images listis formed click the OK button to return to the Add pushbroom
images window;

9. Choose images to load into strip in the Add pushbroom images window (see
Section 10.3.1), setup transformation parameters in the Parameters window (see
the “Parameters of images loading” chapter in the “Creating project” User Manual).
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Then load images to the project (or perform the further transformation in Raster
Converter module).

11.1.1. Parameters of pan-sharpening (during adding images in project)
To perform the pan-sharpening operation correctly specify parameters of output image.

I N
g Pan-sharpening Iﬁ
Parameters Correlation

Qutput channels

RGB
A
Pan-sharpening method:

| PCA @ H3V _! Brovey | EPCA

Cut off source images background color

Background color: ] =
Color depth: IAuto v]
Areas outside color raster lBadcgruund color v]

Color fill outside color raster
0.50 |2 (pix)
|:| Measure tie points

|:| |Use source images georeference

QK ] I Cancel

Fig. 110. Parameters of pan-sharpening
The Parameters tab is used for setting the following parameters of output image:
» the Output channels allows to choose quantity of channels in output images:
o RGB (by default);
o All — all channels from source image.

» the Pan-sharpening method section allows to choose one of the following methods
of increasing resolution of output image: PCA (Principal Component Analysis), HSV,
Brovey or EPCA (Enhanced Principal Component Analysis).

Depending on the type of images, different methods might be preferable. The default En-
hanced Principal Component Analysis method is recommended as it ensures minimum
distortion of the initial colors. It is recommended to use other methods if the results are unsat-
isfactory otherwise.
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The HSV and Principal components methods produce similar results, where is no domination
or deficiency of one color. The Brovey produce the same results on images with average
brightness, but different results on dark or glaring images.

It may be difficult to determine beforehand which color correction parameters should be se-
lected.

» the Cut off background colors of source images checkbox allows not to apply
histogram stretching to background color of source image. The Background color
field allows to define color of background.

» the Color depth list is used to choose color depth of output image: 8 bit, 16 bit, Auto
(by default).

» the Areas without color raster section allows to choose one of the following ways
of filling areas without color image:

o Background color to fill areas with background color of source images;
o Grayscale raster to use grayscale image as a base for these areas.

» Value of the Color area outside color raster parameter (in pixels) to perform color
extrapolation on image edges.

» the Searching for tie points checkbox allows to use tie points in pan-sharpening in
case of visible shift between objects on color and black-white images.

* Use source images georeference checkbox allows to eliminate blur effect on the
synthesized image which occurs if sensor features caused a shift of black and white
and color images relative to each other in raster coordinate system.

If the checkbox is cleared, the data processing algorithm implies just a comparison
of grayscale and color images, without introducing any additional corrections (the
initial “reference point” is the lower left corner of the grayscale image). It is assumed
that the images are not shifted and not turned relative to each other.

If the checkbox is set, georeferencing data (stored in image metadata) are used to
compensate for shift between the images. If the required information is not found in
the image metadata, RPC coefficients are used to calculate the corrections.

% Itis strongly recommended to use source images georeference when processing Pleiades
sensor data.

The Correlation tab is used to setup correlator parameters for tie points measurement:

é Correlation parameters are only available if the Measure tie points check box is set in the
Parameters tab.
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i N
@ Pan-sharpening Iﬁ
Caorrelation
Correlation parameters
Fragment size: 20.00 1 pix
Search area: 20.00 1 pix
Correlation pixel size: D
Max auto-correlation: 30,00 =
Min correlate value: 0.80 =
Min fragment RMS: 10,00 =
Mumber of fragments: 5 =1 x5 =
Mumber of points in fragment: 5 = x5 =
Method: 2D-5hift -
[7] check residual deviations
[7] use feature-based correlator
K ] I Cancel

L A

Fig. 111. Correlator parameters for tie points measurement window

Set an appropriate checkbox to use feature-based correlator with predefined paramet-
ers (see the “Automatic measurement of tie points coordinates (aerial survey)” chapter
in “Aerial triangulation” User manual). Clear this checkbox to set the following correlation
parameters manually:

+ Fragment size — allows to define a size (in pixels) of a fragment which contains the
point indicated on one image;

» Search area — — allows to define a search area (in meters) of appropriate point on
another image;

+ Correlation pixel size — allows to define a value of a pixel size of images, where
correlation to be performed, if the images have different pixel size;

* Max. auto correlation — allows to control auto-correlation of a point, i. e. a degree
of point’s uniqueness in some its vicinity on the left image;

The more the auto-correlation radius value, the less the point’s uniqueness and the more
probable its incorrect comparison with the right image even when the correlation coefficient
is high.
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* Min. correlate value — allows to define minimal acceptable value of correlation
coefficient;

* Min. fragment RMS - allows to define a brightness value of image fragment. The
less the value, the worse the correlation.

* Number of fragments — number of fragments on one image.

7

If an image contains objects with big brightness difference (dark lake and light colored field,
for example), it is recommended to set more fragments number.

* Number of points of fragment — number of matching points on one fragment.

* Method - allows to choose 2D-shift or Affine correction to compensate for geometric
discrepancies between color and grayscale images during measurement of tie points
in those images.

<

7
7

A

Camera design and operation features often lead to the fact that color and grayscale images
are slightly shifted relative to each other.

The correction that compensates for simple 2D-shift of images is recommended by default.
The advantage of this method is also that random errors in tie point measurements that may
occur during the operation of the correlator have little effect on the quality of output data.

The affine correction is recommended if the use of other settings has led to unsatisfactory
quality of certain sections of output images. The affine correction is applicable in a situation
where there is reason to suppose that the resulting defects in the output image are due to
geometric discrepancies between color and grayscale images, which are more complex than
a simple shift due to a small difference in time between the survey moments.

When using the affine correction, the requirements for the quality of measurement by the tie
point correlator are significantly increased. This is due to the increasing influence of random
measurement errors on the quality of output images

» Check residual deviations allows to evaluate the accuracy of overlaying black and
white and color rasters (in pixels). Data is displayed in the information window which
opens once the pan-sharpening operation is completed.

11.2. Pan-sharpening operation without adding images to project

To apply the pan-sharpening operation for any chosen images, perform the following:

1. Choose the Rasters » Pan-sharpening. Parameters of pan-sharpening Pan-
sharpening window opens.
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. Pan-sharpening

Source file with high resolution raster {grayscale)

Source file with low resalution raster (calar)

Cutput file with high resolution raster (color)

000 |§

Parameters | Output I Carrelation |

Output channels
RGE
@ al
Fan-sharpening method:
) PCA i) Hsy () Browvey i@ EPCA

Cut off source images background color

Background color: 0 =
Color depth: Auto
Areas outside color raster Background color

Color fill outside color raster
0.50 =1 (pix)

|:| Measure tie points

K ] [ Cancel

Fig. 112. Parameters of pan-sharpening
2. Choose the panchromatic image in the Source file with high resolution raster
(grayscale) field.
3. Choose the Source file with low resolution raster (low) in the field.
4. Specify name and path of Output file with high resolution raster (color).
The allowed output file formats are:

* Tag Image File Format (*.tiff) and GeoTIFF —format, included tags for saving
of georeferenced information;
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5.

6.

Windows Bitmap File (*.bmp);

GeoTIFF (*.tiff) —includes tags for saving of georeferenced information;

GIS Panorama raster map (*. rsw) — raster formats of GIS Panorama software;
ERDAS IMAGINE (*.1img) — ERDAS system raster format;

NITF (*.nitf);

JPEG (*. jpeg);

PNG (*.png);

DGN (*.dgn) — MicroStation system raster format;;

PCIDSK (*.pix) — raster format with georeference in the heading developed by
PCI Geomatics company;

JPEG2000 (*. jp2) raster format with jpeg compression and georeference in the
heading developed. The limitation on output file size of JPEG2000 format — no
greater then 500 Mb.

Setup the parameters of pan-sharpening (see below).

Click OK to start pan-sharpening operation.

11.2.1. Parameters of pan-sharpening (without adding images in pro-

ject)

To perform the pan-sharpening operation correctly specify parameters of output image.
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. Pan-sharpening

Source file with high resolution raster {grayscale)

Source file with low resalution raster (calar)

Cutput file with high resolution raster (color)

000 |§

Parameters | Output I Carrelation |

Output channels
RGE
@ al
Fan-sharpening method:
) PCA i) Hsy () Browvey i@ EPCA

Cut off source images background color

Background color: 0 =
Color depth: Auto
Areas outside color raster Background color

Color fill outside color raster
0.50 =1 (pix)

|:| Measure tie points

K ] [ Cancel

Fig. 113. Parameters of pan-sharpening
The Parameters tab is used for setting the following parameters of output image:
» the Output channels allows to choose quantity of channels in output images:
o RGB (by default);
o All — all channels from source image.

» the Pan-sharpening method section allows to choose one of the following methods
of increasing resolution of output image: PCA (Principal Component Analysis), HSV,
Brovey or EPCA (Enhanced Principal Component Analysis).

176



PHOTOMOD 8.1 General information about the system (Windows x64)

g Depending on the type of images, different methods might be preferable. The default En-
hanced Principal Component Analysis method is recommended as it ensures minimum
distortion of the initial colors. It is recommended to use other methods if the results are unsat-
isfactory otherwise.

The HSV and Principal components methods produce similar results, where is no domination
or deficiency of one color. The Brovey produce the same results on images with average
brightness, but different results on dark or glaring images.

It may be difficult to determine beforehand which color correction parameters should be se-
lected.

+ the Cut off background colors of source images checkbox allows not to apply
histogram stretching to background color of source image. The Background color
field allows to define color of background.

» the Color depth list is used to choose color depth of output image: 8 bit, 16 bit, Auto
(by default).

» the Areas without color raster section allows to choose one of the following ways
of filling areas without color image:

o Fill background color to fill areas with background color of source images;
o Fill grayscale raster to use grayscale image as a base for these areas.

* Value of the Color area outside color raster parameter (in pixels) to perform color
extrapolation on image edges.

» the Searching for tie points checkbox allows to use tie points in pan-sharpening in
case of visible shift between objects on color and black-white images.

The Output tab is used for setting the following parameters of output image:
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. Pan-zharpening

Source file with high resolution raster (grayscale)

Output

Source file with low resolution raster (color)

Output file with high resolution raster {color)

Correlation

[] create Ms TIFF

Output images compression
@ Mone

(™) IPEG with quality

i LW

(") Deflate

Georeference file:

[7] create Geo TIFF

| Arcworld (TFW, BPW,...) ~

K ] [ Cancel

Fig. 114. Output parameters

* Create MS TIFF — allows to create output mosaic sheets in MS TIFF format with
pyramid that helps to redraw images more quickly on a screen, when using systems

with MS TIFF format support.

* Create GeoTIFF — allows to create output mosaic sheets in GeoTIFF format with

pyramid;

* The Output images compression allows to set up the compression parameters of

output orthoimages files:

o None - files are creates without compression;

o JPEG with quality .. % — TIFF-files are creates with set quality of JPEG-compres-

sion;
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@ Default compression level is 75 %, that provides the 5-7 times compression of initial image
volume.

o LZW — TIFF-files are creates with LZW-compression;
o Deflate — TIFF-files are creates with Deflate compression.

» Georeference file — allows to select the format of the additional file created;
o None - files are creates without compression;

o PHOTOMOD GEO (*.geo) — PHOTOMOD georeference file, contains pixel and
ground coordinates of 4 mosaic cells as well as cell size by X and Y axes in given
units.

& Example of *.geo file:
Mosaic created by PHOTOMOD 10.01.07
Units: (m)
Linscale: 8.600
Colscale: 8.600
(0.5, 0.5) (8271360.000 East, 1857514.200 North)
(0.5, 2446.5) (8271360.000 East, 1836470.000 North)
(2612.5, 0.5) (8293831.800 East, 1857514.200 North)
(2612.5, 2446.5) (8293831.800 East, 1836470.000 North)

Coordinate system: UTM, (North)

o Arc World (*.tfw extension at export to *.tiff format) — georeference file, used
by Arc INFO.

QA Example of *. tfw file:
1.000000
0.000000
0.000000
-1.000000
551286.128054
200588.824470
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After mosaic export to other formats georeference files (of text format likewise
*.tfw file) are created with the following extensions: :

m After export to *.bmp georeference file with *.tfw extension is created;

m After export to *. jpg georeference file with *.tfw extension is created;

m After export to *.nitf georeference file with *. tfw extension is created;

m After export to *.dgn georeference file with *.tfw extension is created;

m After export to *.png georeference file with *.tfw extension is created.

o Maplinfo TAB (*.tab) — Georeference file, used by Mapinfo.

<

Example of *. tab file:

ltable

Iversion 300

Icharset WindowsLatin1

Definition table

File “mosaic.tif”

Type “RASTER”

(143424.937,2635592.133) (0,0) Label “Point 17,
(224834.937,2635592.133) (1163,0) Label “Point 27,
(143424.937,2565592.133) (0,1000) Label “Point 3”,
(224834.937,2565592.133) (1163,1000) Label “Point 4”

CoordSys Earth Projection 8, 104, “m”, 33.000000, 0.000000, 0.999600, 500000.000000,
0.000000

The Correlation tab is used to setup correlator parameters for tie points measurement:

ﬁ Correlation parameters are only available if the Measure tie points check box is set in the
Parameters tab.

180



PHOTOMOD 8.1 General information about the system (Windows x64)

. Pan-sharpening

Source file with high resolution raster (grayscale)

Source file with low resolution raster {color)

Qutput file with high resolution raster (colar)

agagan|

| Parameters I Output | Correlation |

Correlation parameters

Ak

Fragment size: 20,00 pix

Ak

Search area: 20,00 pix

Correlation pixel size: D

Ak

Max auto-correlation: 30.00

Ak

Min correlate value: 0.80

Ak

Min fragment RMS: 10,00

4|k
=
i
4

Mumber of fragments: 5

4|k
=
i
4|k

Mumber of points in fragment: 5

Method: 2D-5hift -

[7] check residual deviations
[7] use feature-based correlator

QK ] [ Cancel

Fig. 115. Correlation parameters

Set an appropriate checkbox to use feature-based correlator with predefined paramet-
ers (see the “Automatic measurem.ent of tie points coordinates (aerial survey)” chapter
in “Aerial triangulation” User manual). Clear this checkbox to set the following correlation
parameters manually:

* Fragment size — allows to define a size (in pixels) of a fragment which contains the
point indicated on one image;

» Search area — — allows to define a search area (in meters) of appropriate point on
another image;

» Correlation pixel size — allows to define a value of a pixel size of images, where
correlation to be performed, if the images have different pixel size;

181


measurement.pdf

PHOTOMOD 8.1 General information about the system (Windows x64)

* Max. auto correlation — allows to control auto-correlation of a point, i. e. a degree
of point’s uniqueness in some its vicinity on the left image;

The more the auto-correlation radius value, the less the point’s uniqueness and the more
probable its incorrect comparison with the right image even when the correlation coefficient
is high.

* Min. correlate value — allows to define minimal acceptable value of correlation
coefficient;

* Min. fragment RMS - allows to define a brightness value of image fragment. The
less the value, the worse the correlation.

* Number of fragments — number of fragments on one image.

@ If an image contains objects with big brightness difference (dark lake and light colored field,
for example), it is recommended to set more fragments number.

* Number of points of fragment — number of matching points on one fragment.

* Method - allows to choose 2D-shift or Affine correction to compensate for geometric
discrepancies between color and grayscale images during measurement of tie points
in those images.

g Camera design and operation features often lead to the fact that color and grayscale images
are slightly shifted relative to each other.

@ The correction that compensates for simple 2D-shift of images is recommended by default.
The advantage of this method is also that random errors in tie point measurements that may
occur during the operation of the correlator have little effect on the quality of output data.

@ The affine correction is recommended if the use of other settings has led to unsatisfactory
quality of certain sections of output images. The affine correction is applicable in a situation
where there is reason to suppose that the resulting defects in the output image are due to
geometric discrepancies between color and grayscale images, which are more complex than

a simple shift due to a small difference in time between the survey moments.

c When using the affine correction, the requirements for the quality of measurement by the tie
point correlator are significantly increased. This is due to the increasing influence of random
measurement errors on the quality of output images

» Check residual deviations allows to evaluate the accuracy of overlaying black and
white and color rasters (in pixels). Data is displayed in the information window which
opens once the pan-sharpening operation is completed.
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11.3. Batch pan-sharpening

c In the Lite-version of the system batch pan-sharpening is not available.

The system allows possibility to perform the pan-sharpening operation with same
parameters for more than 2 images.

To do this it is necessary to prepare a *. txt file with the list of paths to source images:
high resolution, low resolution images and also a path of output file which will be created
as a result of pan-sharpening.

In order to start batch pan-sharpening perform the following actions:
1. Prepare a *.txt or *.csv file with the list of paths to source images.

2. Choose the Rasters » Pan-sharpening. The Pan-sharpening window opens.

r. Pan-sharpening &J‘

Batch files list (high resolution low resolution, output)

=)

Parameters Output Correlation

Qutput channels

RGB

@ al

Pan-sharpening method:

PCA HSY Brovey @ EPCA

| Cut off source images background color

Background color: 1] =

Measure tie points

| QK | |Dish’ibuhed processing...| | Cancel |

Fig. 116. Parameters of batch pan-sharpening

3. Perform one of the following actions:

« [optional] In the Batch files list section click the _... | button and choose a text
file with list of paths to source images. For example:

"Input_high resolution image path","Input low resolution image path","Out-
put image path"
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"Input high resolution image path","Input low resolution image path","Out-
put image path"

+ [optional] Otherwise to form image list click the %] button. The Pan-sharpening
images list window opens.

. Pan-sharpening images list Iﬁ

+ — il E: A + —-iQE SRR NE
{Cy/data5/K3_20160324041414 20547 0933067 | C:/data5/K3_20160324041414 20547 0933067
Cy/data5/K3_20160324041414 20547 0933067¢ | C:/data5/K3_20160324041414 20547 0933067

L L k L UL k

Pan-sharpenning output directory

C:\datas (e

0K H Cancel J

Fig. 117. Pan-sharpening images list

Left part of the window is used to form list of high resolution images, right part —
to form list of low resolution images.

The window contains the toolbar with buttons used to perform the following oper-
ations:

o + — allows to choose and add image to the list;
o = — allows to remove image from the list;
o #@ — allows to select all images;

o EE — allows to unselect all images;

O

gk — allows to invert selection of files;

o % — allows to move selected image to the top of the list;
o «» — allows to move selected image up the list;

o » — allows to move selected image down the list;

o  — allows to move selected image at the end of the list.
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Perform the following to create list of source images:

1.

2.

3.

4.

Add in the left list high resolution source images.
Add in the right list low resolution source images.
Click the _... | button and define the Pan-sharpening output directory.

Click OK to return for the Pan-sharpening window.

4. Setup the parameters of pan-sharpening.

5.

[optional] To start the pan-sharpening operation in distributed processing mode,
perform the following actions:

1.

Change settings and run the distributed processing server/client (see the “Dis-
tributed processing” chapter).

Click the Distributed processing button. The Distributed processing window
opens.

The Number of images displays in the window.

& Distributed processing [i—:hJ

Mumber of images: 2

Mumber of tasks for processing: 2 =
Owerwrite existing images

| Delete temporary project if success

(a4 ] | Cancel

L &

Fig. 118. Parameters of pan-sharpening in distributed processing mode

Specify Number of tasks for processing, which are processed by one com-
puter.

[optional] Set on the Overwrite existing images to overwrite preliminary created
images.

[optional] By default if process was completed successfully, temporary project
is deleted. Set the appropriate checkbox off not to delete temporary files.

Click OK. Distributed processing tasks are created and the system shows a
message about number of created tasks.
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6. Click OK to start pan-sharpening operation. When operation complete produces
information message, that contains number of created/skipped images as a result
of pan-sharpening.

11.4. Batch pan-sharpening for pushbroom images

A In the Lite-version of the system batch pan-sharpening is not available.

The system allows possibility to perform the batch pan-sharpening operation with same
parameters for more than 2 scanner images.

In order to start batch pan-sharpening perform the following actions:

1. Choose the Rasters » Batch pan-sharpening for pushbroom images. The Batch
pan-sharpening window opens:

F !
. Batch pan-sharpening @
Source data  C:\Usersiguk) E] Parameters | Compression Correlation |
Output data  C:\Usersiguk), E] Output channels

RiGE

@ Al

[ Search products <<

MNurmber Panchromatic Multispectral
Pan-sharpening method:

) PCA ~) HSV ) Brovey @ EPCA

Cut off source images background color

Rl

Background color; 0

0.5 | (pix)
|:| Measure tie points

|:| Use source images georeference

|PHOTOMOD MegaTIFF (*.prf) - |

|:| Overwrite existing

l 0K ] [Distribubed prccessing...] [ Cancel ]

Fig. 119. Parameters of batch pan-sharpening for pushbroom images
2. Click the _... | button according to the Input folder field and choose the folder in
the Windows file system that contains scanner images subjected to pan-sharpening;

3. Click the _... | button according to the Output folder field and choose the destination
folder in the Windows file system;
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4. To form the image list, click Search products << button. If remote sensing data
are found in the specified folder, the list of images is formed in the table located in
the left part of the window.

@ If there are no scanner images, check the path to the given folder in the Windows file system

and also the folder’s content. Try to add used images to the scanner project. Check out

the list of supported space sensors (see “Formats of satellite scanner images” in the
“Creating project” User Manual). For more information contact technical support.

5. [optional] To exclude some images from processing, select the rows of the table
containing the desired image pairs and press Delete. The following dialog box
opens:

r. Question I,i:-?-,r

'-6.' Do you really want to delete 1 rows from 47

Yes l | Mo

Fig. 120. The dialog box

Click Yes, to remove the selected image pairs from the list of images to be pro-
cessed.

§ The images themselves will not be deleted from the Windows file system, only the image
list in the Batch pan-sharpening window will be edited. If needed, user can re-create the
image list clicking the Search products << button.

6. Setup the parameters of pan-sharpening.
7. Select the output files format:
* MS-TIFF (*.tif);

« PHOTOMOD MegaTIFF — to save voluminous images. MegaTIFF format is a
set of following files: *.prf and files of MS-TIFF format images placed to folder
which has a name of source file and is created after conversion in specified target
folder.

% To limit file size included to MegaTIFF files set, choose Service > Settings » System
and specify the Maximum tile file size within MegaTIFF. Upper limit of file size — 8
192 MB; file size by default — 1 024 MB.
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8. Choose the type of compression (in the appropriate tab): without compression

(None), JPEG with quality specified by the user, or LZW or Deflate without quality
loss; In case of using JPEG-compression, define quality of compression in percent.

g By default compression level is 80%, that allows to reduce images size in 5-7 times. In
most cases it does not cause loss of accuracy while the adjustment, and also allows to
save storage space.

@ This type of compression is applied to output images of MS-TIFF format only.

Click OK to start pan-sharpening operation. When operation complete produces
information message, that contains number of created/skipped images as a result
of pan-sharpening.

[optional] To start the pan-sharpening operation in distributed processing mode,
perform the following actions:

1. Change settings and run the distributed processing server/client (see the “Dis-
tributed processing” chapter).

2. Click the Distributed processing button.

12. Distributed Processing

12.1. General Information

Program includes capability of distributed processing of some tasks. This helps achieve
maximum utilization of hardware resources for carrying out large projects.

Distributed tasks processing is a capability of parallel task execution with multiple pro-
cessor cores or multiple computers in local network.

The system allows to perform the following processes in distributed processing mode:

processing of raster images in the Raster Converter module;
batch pan-sharpening (see also the Orthophotomaps creation User Manual);
ADS data preparing (see the Project creation User Manual);
automatic tie points measurement (see the Aerial triangulation User Manual);

automatic block layout creation for UAS data (see the Aerial triangulation User
Manual);

automatic points calculation for DEM creation (see the DTM generation User Manual);
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« creation of textured TIN 3D surface (see the DTM generation User Manual);

* dense DSM creation (see the DTM generation User Manual);

» dense DEM generation using SGM method (see the DTM generation User Manual);
* batch DTM creation (see the DTM generation User Manual);

» DEM filtering (slope based filter, median filter, smooth filter and filter by image prop-
erties — see the DTM generation User Manual);

* transformation of DEM coordinate system (see the DTM generation User Manual);

» batch transformation of DEM’s coordinate system (see the DTM generation User
Manual);

+ rebuilding DEM considering last adjustment (see the DTM generation User Manual);
« filling null cells by minimum values (see the DTM generation User Manual);

» merging of overlapping DEMs (see the DTM generation User Manual);

+ splitting DEM into sheets (see the DTM generation User Manual);

* DEM cutting by polygons (see the DTM generation User Manual);

+ creation of difference DEM (see the DTM generation User Manual);

« creating of orthophoto (see the Orthorectification User Manual);

» automatic UAS triangulation (see the Processing of UAS data User Manual);
 creating of image pyramids (see the Orthophotomaps creation User Manual);
 creating useful areas (see the Orthophotomaps creation User Manual);
 creating cloudy areas (see the Orthophotomaps creation User Manual);

+ cutlines creation (see the Orthophotomaps creation User Manual);

» automatic searching of tie points in the vicinity of cutlines (see the Orthophotomaps
creation User Manual);

+ orthoimages creation in distributed processing mode (see the Orthophotomaps creation
User Manual);

 transformation of point cloud coordinate system (see the LIDAR Data processing
User Manual);
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 point cloud cutting by polygons (see the LIDAR Data processing User Manual);
* block adjustment in batch mode (see the Block adjustment User Manual);

» batch DEM export (see the DTM generation User Manual);

» LAS filtering by data density (see the LIDAR Data processing User Manual);

* LAS interpolation (see the LIDAR Data processing User Manual).

Computers participating in the distributed processing are assigned the two following
modes:

» Server is the control center of the distributed processing, responsible for distribution
of tasks and synchronization of Client computers;

5 Server is also could has Client status.

» Client is a computer, which receives tasks to process from the Server,

§ Each Client must be connected to the Server.

% It is possible to temporary exclude Client from distributed processing.

There could be several computer groups in one local network to process project in
distributed mode independently of each other.

§ There are the following limitations in the Lite-version of the system: maximal number of task in
queue couldn’t be more than 10 tasks; maximal connections of client type is 3.

To launch the Distributed processing control center perform one of the following:

* in right-click menu of System Monitor modulechoose the Distributed processing
control center;

§ The Start automatically menu item allows to launch the distributed processing control center
automatically concurrently with launching any module of program when System Monitor
module is launched.

» choose the Service » Distributed processing » Control center.

If both full version of system and PHOTOMOD UAS are installed on a computer, it is possible

= to launch Distributed processing center for different system’s version at the same time. Besides

it is required to launch Distributed processing center one the same system’s version on all
computers of group to correct tasks processing.
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The distributed processing control center is launched with properties of previous working
session of program in the Windows system tray the = icon displays. During the first
launch the Distributed processing setup window is also opens.

@ Tooltip to the distributed processing center displays the version of the system from what distrib-
uted processing center was launched, the port number and information about server/client
status.

The distributed processing icon in the Windows system tray is different depending on
using computer in the distributed processing mode:

« & - Server and Client are not launched (computer is not used in distributed pro-
cessing);

+ = —only Serveris launched;

« = — Server and Client are launched;

« = —only Client is launched, connection to Server,

« Alternating icons (= and [&&]) — only Client is launched, Server connection fault.
To use distributed processing in a local network requires the following:

» the same Centralized management folder should be connected to each workstation,
involved in distributed processing;

% Active profile is not important for Client computers.

* read and write public access and defined full path is required for all folders with data;

ﬁ Full path is not required for local folders.

+ atleast one computer should be in Server mode and all Clients should be connected
to one Server.

12.2. Workflow of distributed processing

The following workflow is used to distributed tasks processing:

1. Launch the Distributed processing control center on all involved computers.
2. Configure the required distributed processing settings:

» Define one of computers as a Server and input free Port for incoming connec-
tions.
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é Ports in the range 0-1023 are reserved by the operating system, so the minimum value
of the port is set to 1024.

» Define all the rest involved computers as a Clients, choose server name and Port
for connecting to server, specified on step 2.

§ Server is also could be use as a Client at the same time.

@ The system also provides an opportunity only to use local computer for distributed pro-
cessing tasks with using several cores of one computer, i.e. using computer as a Server
and Client at the same time.

3. Open the main PHOTOMOD window;

4. Setup the parameters of the current task in an appropriate window and click the
Distributed processing button. The list of distributed processing tasks is created
and displayed in the Tasks table.

% Distributed processing tasking process is displayed in the progress bar, which (in most
cases) immediately closes automatically after the completion of this operation (see details

in Section 8.4.1).

% As the output folders and folders for intermediate data, specify only folders which are
available for all involved computers.

é Distributed processing is impossible if the Distributed processing control center has
not been previously started and configured (see items 1 and 2). The appropriate message
appears in this case.

o Errar

)

[ =]

Could not connect to server, Probably sercer is not running,

—

Fig. 121. A message that appears if items 1 and 2 have not been completed before clicking the

Distributed processing button

5. Open the Monitor for distributed processing to view the progress of tasks per-

formance;

% Click the P> button to perform all distributed processing tasks automatically.
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@ The Monitor for distributed processing window also allows to manage distributed pro-
cessing tasks performance.

12.3. Distributed processing parameters setup

The Distributed processing setup window is used to setup distributed processing
parameters. Parameters are setup depending on computer’s mode.

To open the Distributed processing setup window the menu item Configuration...
of right-click menu of the distributed processing icon is used. The Distributed pro-
cessing setup also opens after the first launch of the Distributed processing control
center.

Distributed processing setup ﬁ

IIse this computer as:

+ | Distributed processing dient

| Distributed processing server

Serv [127.0.0.1 w| [..] 10000 [F] [£]

Manitor uses the server name and port specified for the server.

Ok | [ Apply ] | Cancel |

Fig. 122. Distributed processing parameters setup

To use computer as a Client of distributed processing, perform the following actions:

é The system upgrade may require to delete the existing database and create a new one (when
the Distributed processing setup window opens, the appropriate informational message ap-
pears).

A Question
i Y ,  Failed to initialize DE.
L ¢ 4 Recreate DB to attempt to fix problem?

Yes l | [

Fig. 123. The dialog window

The database contains the distributed processing parameter settings, the lists of tasks and logs
of their execution. The database files are saved in the PHOTOMODS. VAR folder at the Server
by default.
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@ The & button allows to check the availability of the database (at the specified server IP address
and port for connecting to the server) for the current network node.

1. Set on the Distributed processing server checkbox.
2. Set the Distributed processing client checkbox off.
3. Set free port in the Port for incoming connections field.

c Ports in the range 0-1023 are reserved by the operating system, so the minimum value of
the port is set to 1024.

§ If not possible to connect with chosen port, choose another one.

4. Click OK.

@ It is necessary to restart the distributed processing control center if parameters were
changed.

To use computer as a Client of distributed processing, perform the following actions:
1. Set the Distributed processing server checkbox off.
2. Set on the Distributed processing client checkbox.

3. Inputin the Server name or IP address or click the _... | button and choose computer
name or IP-address from the list used as a Server.

@ The list of last computers, used as a Server, are kept in the system. The i} button allows

to clear the file list;

4. Input port number which was specified during the Server adjustment in the Port
for incoming connections field.

5. Click OK.

@ It is necessary to restart the distributed processing control center if parameters were
changed.

The system also provides an opportunity only to use local computer for distributed
processing tasks with using several cores of one computer, i.e. using computer as a
Server and Client at the same time. Perform the following actions to do this:

1. Set on the Distributed processing server checkbox.

2. Set free port in the Port for incoming connections field.
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@ If not possible to connect with chosen port, choose another one.

3. Seton the Distributed processing client checkbox. Server name and port number
are set automatically.

ﬁ Ports in the range 0-1023 are reserved by the operating system, so the minimum value of
the port is set to 1024.

? If not possible to connect with chosen port, choose another one.

4. Click OK.
? It is necessary to restart the distributed processing control center if parameters were

changed.

12.4. Distributed processing management

The Monitor for distributed processing window is used for condition monitoring of
distributed processing.

Also the menu item Start monitor of right-click menu of the distributed processing icon
and the Service » Distributed processing » Monitor menu items.

% Tasks could be created both by Server and Client.

. If the Server (and database) are disconnected for any reason, the further distributed processing
= management is not available (when trying to run the Monitor for distributed processing window
at the Client workstation, the appropriate informational message appears).

(3 tror S

.' 8_' \ Could not connect to server. Probably server is not running.

Fig. 124. The informational message
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' ™y
S Meonitor for distributed processing [ =HEC éj
PCs | Taskslist | Statistics
(»] )]
ID | PCname | Max tasks | Core quantity |!AM, GI| Current tasks | MaxMT tasks | Status |  Version |

b oockc Jo o 7 o [

Fig. 125. Monitor for distributed processing

The Monitor for distributed processing window contains the following tabs: PCs,
Tasks list and Statistics.

In the Monitor for distributed processing window displays information about tasks
queue and Clients computers using. The window also allows to manage tasks pro-
cessing.

é The window refresh automatically each several seconds.

12.4.1. Computers

The PCs tab contains toolbar and table of computers, which are currently in the network
and configured with the same Server.

% The Serveris displayed in this list only in if it also takes part in the processing being also a Client.
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' ™y
& Monitor for distributed processing E@Iﬂ

PCs Tasks list Statistics

> ) (2] (&)

ID | PCname | Max tasks | Core quantity |!AM, GI| Current tasks | MaxMT tasks | Status |  Version |

b oockc Jo o 7 o [

Fig. 126. The PCs tab
The table contains following parameters for each computer:
§ Points sorting in columns of the list is performed by mouse click on the column header.
The & button allows to set columns visibility.
* The Computer ID;

* PC Name - shows network computer name;

» Max tasks — the maximum quantity of simultaneously running tasks on Client;

@ The Max tasks number by default is equal to the number of CPU’s cores of a workstation
(but doesn’t exceed the number available according to the license).

If the capacity of the network connecting workstations equipped with hard disk drives (HDD)
does not exceed 1 Gb/s, the recommended total Max tasks for all workstations is no more
than 16.
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» Core quantity — the total quantity of Client CPU’s cores;

* The Client's RAM;

» Last update time — the time of the last connection between Server and Client;

» Current tasks — tasks number of distributed processing, which currently performed
by Client;

* Max MT tasks — the maximum quantity of simultaneously running tasks on Client in
MultiThreading mode;

<

A\

MultiThreading — in computer architecture, multithreading is the ability of a central processing
unit (CPU) (or a single core in a multi-core processor) to provide multiple threads of execution
concurrently, supported by the operating system.

This approach differs from multiprocessing. In a multithreaded application, the threads share
the resources of a single or multiple cores, which include the computing units, the CPU
caches, and the translation lookaside buffer (TLB).

Where multiprocessing systems include multiple complete processing units in one or more
cores, multithreading aims to increase utilization of a single core by using thread-level paral-
lelism, as well as instruction-level parallelism. As the two techniques are complementary,
they are sometimes combined in systems with multiple multithreading CPUs and with CPUs
with multiple multithreading cores.

When setting this option, it is needed to take into account the Client’s specifications i.e. RAM
and the number of processor cores. In most cases, the recommended Max MT tasks value
for a workstation having a multicore processor and 8 GB RAM is 1. The recommended Max
MT tasks value for a workstation with 16 GB RAM is 2, etc.

» The permission Status for the selected computers to execute new tasks;

O

— allowed;

— forbidden.

? When current task complete, Client go to sleep mode and doesn’t start new tasks temporary.

» IP-address — |IP-address of the computer;

* Version — the PHOTOMOD build number for control of compatibility.

7

7

It is recommended to use the same RHOTOMOD build on all computers working with the
same Synchronization folder.

To perform actions with multiple computers, select them in the table using Shift and Ctrl keys.
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Table 19. The PC tab toolbar

Buttons Function
> allow selected computers to execute new tasks (if forbidden)
] forbid selected computer to execute new tasks When current task complete, Client go

to sleep mode and doesn’t start new tasks temporary

= to select which video adapter, from among those available, will be used by the selected
computer (client) to increase its own performance during distributed processing (if this
functionality is provided for the executing operation, see below)

to open the Num tasks entry window to set Max tasks and Max MT tasks quantity
(see below)

p- 4 to open the Display options window to set the visibility of the columns in the table of
computers (see below)

To set Max tasks and Max MT tasks quantity for the selected workstation, select this
computer in the table of computers and click the |~ button of the PCs tab toolbar. The
Num tasks entry window opens:

S MNum tasks entry I. ? &J

| Enter maximum number of tasks for selected computers 4

4|r

| Enter maximum number of MT tasks for selected computers 1 =

Ok ] | Cancel

Fig. 127. The Num tasks entry window

* [optional] Enter maximum number of tasks for selected computers or clear an
appropriate checkbox, if this parameter does not need to be changed;

* [optional] Enter maximum number of MT tasks for selected computers or clear
an appropriate checkbox, if this parameter does not need to be changed;

Click OK. If no workstations were selected above, changes will be applied to all of them.

( & Question Li:hjﬁ

'-o-' No computer selected! Changes will be applied to all. Continue?

[ Yes ] | MNo

Fig. 128. The question window
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The system allows to set visibility of the columns in the table of computers. To do this
click the g button of the PCs tab toolbar. The Display options window opens. Clear
an appropriate checkboxes if needed, and click OK.

& Display options [ 2 ihI
Available fields
All

V| Core quantity
Current GPU, GB

| Current tasks
GPU devices, GB

V| ID

IP address

Last update time

Max MT tasks

Max tasks

PC name

RAM, GB

Status

Yersion

< S S S S S

[ CK l | Cancel |

Fig. 129. The Display options window
Using video adapter resources

When performing certain operations, the system may increase its performance by using
the resources of this workstation’s video adapter. For this, when configuring a certain
operation, set the Use GPU checkbox in the appropriate window and select the preferred
video adapter from the list of available devices.

The use of video adapter resources is provided in the following cases:

* Dense DEM generation using SGM method (see the appropriate section in the “DTM
Generation” User Manual);

» Point cloud classification (see the appropriate section in the “Neural processing of
LIDAR data”);

» Automatic measurement of tie point coordinates (in some cases, when processing
aerial data; see “Feature based correlator” and “UAS” sections in the “Aerial triangu-
lation” User Manual).

If the distributed processing mode is also used to perform these operations, select video
adapters in the Monitor for Distributed Processing window, individually for each
computer used as a distributed processing client.
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To choose a video adapter to use for a certain workstation, select the preferred computer
in the Computers tab in the Monitor for Distributed Processing window and click
£~. Select GPU in the window that opens and click OK. The list of available devices in
each case depends on the configuration of the selected workstation.

by B

7

7

(& Sclect GPU R

@ Intel(R) HD Graphics 2500 ; 1.2

[ Ok ] | Cancel |

Fig. 130. The Select GPU window

Regardless of the settings specified in the video adapter selection window, the resources of
this device will be used in calculations only if this function is available for the executing operation
(and if the user has set the Use GPU checkbox in the appropriate settings window).

If the computer used to configure the operation options (server) is also used as one of the clients,
the selection of the video adapter used by it is also carried out through the Monitor for Distrib-
uted Processing, regardless of which device was selected in the drop-down list in the settings
window of the operation itself (this choice is taken into account only if the operation is performed
in normal mode, without the distributed data processing mode)..

In the case of distributed processing, if the user has set the Use GPU checkbox in the appropriate
window of the executing operation settings, the video adapter resources of each client (if there
is one or more on the computer) will be involved, even if the user does not select a video adapter
for this workstation manually. The computer will use a device with the greatest memory by default.

It should be considered that the performance of a video adapter as an extra device for compu-
tations is not directly dependent on its memory amount but is influenced by the algorithms used
and features of the system architecture. Modern graphic adapters of no more than 4-6 GB are
recommended. If there is a choice, first of all, NVidia video adapters are preferable.

The user can change the device used directly during the calculation process without interrupting
the operation. If the user manually selects the preferred device, then it will be the one that will
further be used by the workstation during the next distributed processing sessions (as long as
the current distributed processing database is in use). Deleting the database and creating a
new database will return to the default settings.

The intensity of GPU usage can be monitored using various free software. Windows 10 users
can monitor GPU activity through the Windows Task Manager (Performance Tab).

12.4.2. Tasks list

The Tasks list tab contains toolbar and table with information about tasks.
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' ™y
& Monitor for distributed processing E@g

Taskslist | Statistics

(][] (] ][] [-] @) D] (@ = 7 [X]

Name Progress Status Elapsed time MT Executor
Searching features (2/2) B 1% 00:00:00 0 Doc-PC

Fig. 131. The Tasks list tab
The table consists of columns with following information:

§ Points sorting in columns of the list is performed by mouse click on the column header.

The & button allows to set columns visibility.

* The task name;

* The task progress;

» The Status of the task:
o & —waiting;
o £2% — unknown error;
o & — stopped;

o Ak — paused;
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(0]

— performed;

o | —restarted;

o 4% — complete;

o ixf — failed — displayed in case of complete part or resource connection error;

o & —not complete — displayed in case of tasks didn’t complete because of Client
was disconnected during the task processing, Server was disconnected or task
was canceled.

» Started — the data and time are displayed for started task;
* Elapsed time;
» Task ID — unique identifier for each task;

» Session ID — unique identifier for each communication session between the Server
and the Client;

» Computer ID;
* Maker — shows network computer name;
* Maker ID — is a unique PHOTOMOD session ID;

» MT - this parameter estimates if this task is processed in the MultiThreading mode;

? 1- this task is processed in the MultiThreading mode, 0 — this task is not processed in the
MultiThreading mode.

+ Update time is the time of the latest log entry creation;

 Priority — priority of the tasks (integer, the larger the number, the higher the priority,
the tasks of higher priority are performed in the first place);

? To change the Priority of the performed task, double click the appropriate cell of this column.

§ To sort out performed tasks by priority, click the " icon to the right of the Priority column
name.

» Executor — for started task — the name of Client computer, which executes it;

+ Created at — the date and time of posting task;

203



PHOTOMOD 8.1 General information about the system (Windows x64)

* Profile — active Client profile at the time of posting of tasks. This profile must be
network and connected to other Clients in order that they have been able to execute

the tasks;

* The task description.

If during the task execution an error occurs on any of network computers, it’s highlighted
in red in the list. In this case attempts will be made to perform the same tasks on other
computers. The task will remain in the queue with a failed state until it is deleted
manually, if no computer in network is able to execute this task.

Table 20. The Tasks list tab toolbar

Buttons

Function

>

to start selected tasks sequentially

to pause selected tasks

oh

to stop selected tasks

[

to set on the auto run tasks — automatic distribution of tasks in the queue (according to
priority) between the Clients and launch of the tasks

1+

to increase priority of selected tasks by 1

to decrease priority of selected tasks by 1

to show logs for selected tasks (see below)

to perform logs export (see below)

to enable/disable logs saving mode while deleting tasks

to remove selected tasks from the queue

to remove complete tasks from the queue

to clear the queue of tasks

¥ = = =D D6 "

to open the Display options window to set the visibility of the columns in the table with
information about tasks (see below)

The system allows to set visibility of the columns in the table with information about
tasks. To do this click the g button of the Tasks list tab toolbar. The Display options
window opens. Clear an appropriate checkboxes if needed, and click OK.
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& Display options @Iéj

Available fields i

] A

[T Created at

[7] Dependency ID

[7] Description

Elapsed time

Executor

[7] Group ID

[ 1D

MT

[ Maker

[7] MakerID
Mame

[ Priarity

[ Profile

[¥] Proaress

m

[ OK ][ Cancel ]

Fig. 132. The Display options window

To show logs for selected tasks, select this tasks in the table above and click the &3
button of the Tasks list tab toolbar. The Session logs window opens:

& Session logs:7114 [ = |6 éj
@ IT] Message SessionID g lev lodule nam i
| 3743774 Finished: Loading project. Time spent: 0:00:00.1. 7114 3 Progress 77
[1]o . . 20
3743780 Began: Searching features for 5 images. 7114 3 Progress 171
. . 290
3743781 Began: Creating pyramids.... 7114 3 Progress 171
3743801 Finished: Creating pyramids.... Time spent: 0:00:00.9. 7114 3 Progress igg_
L 29.0
3743802 Began: Processing image 46, 7114 3 Progress 171
s - 29.0
3743804 Began: Partial image processing. 7114 3 Progress 1741
29.0
3743839 Total features found: 17564 7114 3 1741
- o - ] 29.0
3743840 Finished: Partial image processing. Time spent: 0:00:12.9, 7114 3 Progress 171
3743841 Finished: Processing image 46. Time spent: 0:00:13.1. 7114 3 Progress igg
. 290/ =
3743842 Began: Processing image 47. 7114 3 Progress 171
s - 29.0
3743844 Began: Partial image processing. 7114 3 Progress 171
29.0
3743879 Total features found: 17638 7114 3 1741
. . . . 29.0
3743880 Finished: Partial image processing. Time spent: 0:00:12.7. 7114 3 Progress 1741
3743881 Finished: Processing image 47. Time spent: 0:00:12.9. 7114 3 Progress igg
L 29.0
3743882 Began: Processing image 48. 7114 3 Progress 1741
- . 29.0
3743884 Began: Partial image processing. 7114 3 Progress 171 -
1 T | +

Fig. 133. The Session logs window
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The Session logs window contains the table with messages about tasks performance
and the toolbar, allowing to enable/disable the visibility of the messages categories.

The table consists of columns with following information:

@ Points sorting in columns of the list is performed by mouse click on the column header.

* ID — unique identifier for each message;
+ the message text;
» Session ID — unique identifier for each session;

* Msg level — message significance level (the greater this value, the less important
the message is);

* Module name - the used module of the PHOTOMOD system;
* Log time — the time of message creation;
* Msg type — message category.

The buttons of the Session logs window toolbar allows to enable/disable the visibility
of an appropriate messages categories. The number of messages in the each category
is displayed to the right of the corresponding button.

Table 21. The Session logs window toolbar

Buttons Function

A to enable/disable the visibility of the error messages

! to enable/disable the visibility of the warnings

i to enable/disable the visibility of the information messages

=) to enable/disable the visibility of all the abovementioned message types

5vS to enable/disable the visibility of all messages, including low-severity system messages

@ Low-severity system message logs (') may be required for user-developer interactions during
debugging.

To export the logs of the selected tasks perform the following:

1. [optional] select necessary tasks in the table together with task info (otherwise, logs
of all the tasks from this table will be exported);

2. click the [} button of the Tasks list tab toolbar. The Log export window opens;
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i ot

Output folder

& Log export L 2 ﬂh_]
Lo

Export selected records

[ Ok ][ Cancel ]

Fig. 134. The Log export window

3. press the _.. | button to specify the Output folder;

4. [optional] clear the Export selected records checkbox to export logs of all the
tasks from the table in the Tasks list tab;

5. To save logs in the chosen folder, click OK. Task logs are text files with *.10g ex-
tensions. If it is needed to export logs for more than one task, an archive of logs
with *.tar.gz extensions will be saved in the chosen folder.

12.4.3. Statistics

The Statistics tab contains the table with statistics of the current task session.

& Monitor for distributed processing = | B ||
PCs Tasks list Statistics
Sessions v
Tittle Value
Started at 29 May 2024 17:14:23
Finish time 29 May 2024 17:15:12
Elapsed time 00:00:48.721103
Tasks total 2
Tasks finished 0
Tasks failed 0
Tasks runnin g 2
Tasks paused 0
Tasks stopped 0
Tasks waiting 0
Active agents 1
Total number of co... 4
Total progre: |2

Fig. 135. The Statistics tab
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The table consists of strings with following information:
+ Start time;

* Finish time;

+ Elapsed time;

+ Tasks total;

« Tasks finished (£%);

« Tasks failed (£%);

+ Tasks runned (| );

» Tasks paused (iit);

« Tasks stopped (i);

+ Tasks waiting (3£);

+ Active agents — the number of Clients in the PCs tab;
- Total core quantity (on all PCs);

» Total progress.
13. Additional features of the system

13.1. “Service” menu

Table 22. Brief description of the Service menu

Menu Function
Explorer to open the Explorer module to view resources
system
GIS Panorama to run the GIS Panorama Mini (this software is not

included with the PHOTOMOD but can be installed
separately)

Distributed Processing contains menu items to run, test and setup distrib-
uted processing

Working coordinate system to choose working coordinate system (see the Pro-
ject creation User Manual)

Recalc working area to refresh 2D-window and fit displayed area depend-
ing on load data
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Menu

Function

GeoCalculator

to launch the GeoCalculator program that is used
for coordinates transformation form one reference
system to another

Autodetect Gauss-Krueger zone

to detect the Gauss-Krueger zone automatically for
the selected object, provided that any Global coordin-
ate system is used

CSV converter

to launch the CSV converter to transform points
coordinates in CSV and TXT files and also for other
transformations for CSV files

Show in Google Maps

to display area on images in the GoogleMaps ser-
vice (Internet connection required); it is possible
only for projects in geodetic coordinate systems or
if the coordinate system could be transformed to
geodetic

Show in Yandex Maps

to display area on images in the YandexMaps ser-
vice (Internet connection required); it is possible
only for projects in geodetic coordinate systems or
if the coordinate system could be transformed to
geodetic

Load atlas to load the World map to a new vector or raster
layer (see Section 13.4)

Save scene to save visible part of images in active 2D-window
as a raster image with specified size and quality

Parameters to open the window to set the general parameters

of the system

Customize hotkeys

to adjust hotkeys using in the system, edit, delete
or create new hotkeys

Customize fast commads

to use so called shortcut commands, the custom
button combinations for quick access to various
functions when working with the layers such as
Vectors, DEM, Raster, Grid, or TIN

Save options

to save projects parameters and use it automatically
when restart the system

Activate mouse driver

to turn on/off defined mouse driver

Mouse setup

to setup or connect mice, including special mice,
hand wheels and foot pedals, and also to macros
setup

Prepare ADS data

to convert source ADS data and prepare it to use
in the system (see the Project creation User Manual)

Last log

to display the last log of system actions

7

If the GIS Panorama executable file is not found, an appropriate system message will appear.
The software description and URL hyperlink (for download) are indicated in this message.
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[ . Question I,&,r

Panorama executable file not found

IUse following link in arder to dowload Panorama software
Edit path to executable file in settings?

Yes Mo

L A

Click Yes to go to path settings (see the “Paths settings” chapter of the “General system’s
parameters” User Manual.

13.2. Editing of active layer

The system provides possibility to edit objects of active layer.

The following menu items of the Edit » Active layer menu are used:

Save (Ctrl+S) — allows to save active layer;

Save as (Ctrl+Shift+S) — allows to save active layer with a new name;
Close (Ctrl+Q) — allows to close active layer;

Layer information (Ctrl+l) — allows to display information about active layer;
Show/hide active layer (H);

Show/hide labels in active layer (Ctri+H).

Menu items and hotkeys could be used for any active layer.

The system provides possibility to edit objects on layer, and editing of marker position.
To do this use the Edit menu. Detailed description see in the Vectorization User
Manual.

Table 23. Brief description of the 'Edit’ menu

Menu items Function
Group selection contains menu items to choose mode of vector ob-
ject selection
Snapping contains menu items for processing in the snapping
mode
Vectors create mode menu items to change a mode of vector objects

creation to work in the following vectors creation
modes: creating mode of point objects, unclosed
polylines, polygons, as well as polylines and poly-
gons as smooth lines

Curve transforms menu items to create and edit smooth curve lines
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Menu items

Function

3 Undo (Ctrl+Z)

to cancel the last operation of vector objects editing
on a layer (as well as several operations with DEMs)

Undo log

to open the Undo log containing a list of recent
editing operations

 Redo (Ctrl+Shift+Z)

to redo the last undone operation

[ Points editing mode

to automatically move common vertices at once

"2, Streamline mode (Y)

to enable orthogonal mode of linear objects input

[ Snap-to-ground mode (T)

to enable snap-to-ground mode

[*:, Orthogonal mode (A)

to enable orthogonal mode of linear objects input

[ Orthogonal mode in coordinate system

to enable orthogonal mode of linear objects input in
additional coordinate system

£ Add coord system

to create additional (user) coordinate system as a
helping vectorization tool

Edit coord system

to change default axes direction of additional coordin-
ate system

L= Delete coord system

to delete additional coordinate system

Alignment mode

turns the alignment mode on

Scale when align

to scale vector objects during their transformation
in the alignment mode

Rotation mode

turns the fast vector objects transformation mode
on

Select vertices when marker moves over them

to select a vertex, located in marker area on a dis-
tance specified in the Swath field (Service » Set-
tings » Vectors)

Move marker to selected vertex

to move marker to the selected vertex automatically
(see the “Settings of vector objects display” chapter
of the “General system’s parameters” User Manual)

Sync markers

to turn on/off synchronous marker moving in all
opened 2D-windows

fi% Copy marker to clipboard (Ctrl+Alt+-)

to copy position of marker in 2D-window to clipboard

f#, Paste marker from clipboard (Alt+Shift+-)

to move marker to position in 2D-window copied to
clipboard

Cancel selection

to unselect all objects in active 2D-window

Invert selection

to invert objects selection in active 2D-window

Select all (CtrI+A)

to select all objects in active 2D-window

Highlight selected objects

to highlight vector objects selected in 2D-window

Active layer

contains menu items to work with current active
layer

Show/hide labels in all layers (Ctrl+Shift+H)

to change visibility of labels in all layers

Toggle Raster layer visibility in Stereopair win-
dow

to show/hide the Raster layer when working in the
stereopair window and duplicates the ® button in
the Layer Manager.
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@ For ease of use of the Toggle Raster layer visibility in Stereopair window function when
working with vector objects in the stereopair window, it is advisable to set an appropriate hotkey.

13.3. Objects selection modes

Press and hold Shift key and drag a rectangle by mouse to select an object or the object
partition (a DEM area, for example). To unselect objects press Esc.

To change selecting mode for vector objects the system provides the Edit » Group
selection menu items:

Rectangle — to select vector objects inside a rectangle;

Polygon — to select vector objects inside arbitrary polygon;

« [l Normal — during vector objects selection previously selected objects will be unse-
lected;

] Add to selection — each newly selected object (objects group) is added to a group
of selected objects;

Subtract from selection — allows to unselect selected object (objects group);

« If Invert selection — allows to invert selected objects (objects group);

[ Fully inside — allows to select objects that hit the selection area;

[ Partly inside — allows to select objects in which one or more segments intersects
a border of selection area;

L], At least one point inside — allows to select objects in which at least one vertices
are in the selection area;

@ The Tools panel partially duplicates menu items Edit > Group selection.

? Tools for group selection of vector objects are available both in 2D and in 3D windows.

The Vectors » Selection menu contains the following items used to sequentially select
vector objects and their vertices:

+ Select previous object (Ctrl+<) — allows to select an object, previous to selected;
+ Select next object (Ctrl+<) — allows to select an object, next to selected;

+ Select previous line vertex (<) — allows to select a polyline vertex located before
the selected one; sequence of vertices is displayed when you select a vector object;
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» Select next line vertex (<) — allows to select a polyline vertex located after the se-
lected one; sequence of vertices is displayed when you select a vector object;

Table 24. Brief description of the 'Tools’ toolbar

Button

Function

to select vector objects inside a rectangle

to select vector objects inside arbitrary polygon

IF| during vector objects selection previously selected objects will be unselected

] each newly selected object (objects group) is added to a group of selected objects
to unselect selected object (objects group)

| to invert selected objects (objects group)

[e] to select objects that hit the selection area

HE to select objects in which one or more segments intersects a border of selection area
L to select objects in which at least one vertices are in the selection area

= turns the alignment mode on

8 to scale vector objects during their transformation in the alignment mode

] turns the fast vector objects transformation mode on

ey to copy position of marker in 2D-window to clipboard

g to move marker to position in 2D-window copied to clipboard

an to paste vector objects from clipboard to active vector layer into marker position

é Vector objects are pasted to the point of marker position at the time of copying objects to the

clipboard. If the marker is not moved between the copy and paste operations, objects are located

in the same coordinates as the original; otherwise they shift on a vector that connects marker
positions during copy and paste operations.

13.4. Loading atlas

The system allows to load the World atlas as vector or raster layer.

To load the atlas do the following:

1. Choose Service > Load atlas. The Load atlas window opens.
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. Load atlas ﬁ
Available layers
Layer Type
4 All layers
4 World maps
World countries Vector
Matural Earth I 1:50m Raster

Coordinate system
) Reproject

@ Asis (latitude-Jongitude WGS-84)
Set as working C5

Fig. 136. Parameters of the atlas loading

2. Inthe Available layers set on the following checkboxes to load atlas:
* World countries — to load vector layer;

* Natural Earth Il 1:50 m — to load raster layer.

@ To load one atlas layer with default parameters. double-click on its name.

? In the Lite-version of the system only Natural Earth 1l 1:50 m raster layer could be loaded.

3. Inthe Coordinate system section choose type of loading:
* Reproject —to load atlas in chosen coordinate system, e.g. Spherical Mercator.
* As is (latitude-longitude WGS-84).

4. [optional] To use chosen coordinate system as working coordinate system, set the
Set as working CS checkbox on.
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5. Click OK. Chosen layers loads to the project and displayed in 2D-window.

ﬁ Internet connection is required to load atlas. Loading speed depends on connection speed
and computer capacity.

ﬁ To display vector and raster layers of atlas at the same time in 2D-window, the vector layer
should be above raster in the Layer manager.

141

Block scheme
Otifs B @EDIVEAK - @

] [ =]/ @l[ao] (e

ViGS 84 Latuce Longtude

Fig. 137. Atlas view in 2D-window

Vector layer contains polygons — countries borders.

To obtain information about country border, select polygon and choose Window > Ob-
jects attributes.

FE=@he s

Fig. 138. Selected boarder
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r’ Object attnbutes @1

DOEEE 2D
Marme Value

it
"LabelRank" 2
"FeatureCla" Adm-0 country
"SOVEREIGMT"  Australia
"SOV_A3" AUl
"ADMO_DIF" 0.000
"LEVEL" 2,000
"TYPE" Country
"ADMIN" Australia
"ADMO_A3" AUS
"GEOU_DIF" 0.000
"NAME" Australia
"ABEREV" Auz.
"POSTAL" Al

"MAME_FORMA" Commonwealth of Australia
"MNAME_SORT"  Australia
"MAP_COLOR"  7.000

"POP_EST" 21262641.000
"GDP_MD_EST"  800200.000
"FIPS_10_" 0.000
"150_A2" Al

"1S0_A3" AlS
"ISO_MN3" 36.000

Fig. 139. Information about border

13.5. CSV converter

The CSV converter allows to perform the following transformations:
» coordinates transformation from one CS to another in CSV and TXT files;
+ split one big file for several files with defined number of lines in each file;

+ transformation of exterior orientation parameters from one CS to another in CSV and
TXT files.

To transform points coordinates or exterior orientation parameters from one CS to an-
other perform the following:

1. Choose Service > CSV converter. The CSV converter window opens. It allows to
specify input and output parameters.
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. C5V converter

Files | Input format Conversion I Qutput format |

Input files
Delete
Clear
Qutput files
@ Single file

. B | Jg

(") split into parts containing given number of lines each
Output folder

Maximum lines per output file {10000

QK ] [ Cancel

Fig. 140. Input and output parameters
2. Toadd CSV or TXT files, click the Add button in the Input files section. The Add
files window opens.

3. Choose files with *.csv or *.txt extension with points coordinates in source co-
ordinate system and click the Open button. Data loads to the program.

4. In the Output files section choose Single file.
5. Click the _.. | button and choose in Windows file system a folder for output file.

6. Move to the Input format tab and set parameters of input file.
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( ‘ C5V converter @1

Files Input formart | Conversion I COutput format |

C:/Users/guk/Desktop MpuMepel dafinos ana PHOTOMODasaaaa. csv

Line template A -

Start import from line 1 = Preview maximum 10 + lines

Automatically validate template

Field separators Decimal separator Misc
Comma [ Tabulation Space @ Point only [ utrs
[ semicolon  [] Others ) Pointorcomma || Parse®'"

Available fields

X Name Kappa

Y Omega

Z Phi
| Preview file: C:\Users\guk\Desktop M pumepk: datinos ans PHOTOMOD \asaaaa. csv @

X ¥ z * *
1 (CODE MNAME TYPE USED_TIE AUTO ME|
2 *105 CenAsytoLan 1 0 3
3 123 Cenzyrowan 1 0 3
4 *129 CenAsytoLan 1 0 4
5 133 Ceazyrowan 1 0 3
6 134 CeAzyrowian 1 0 3
7 7103 *136 Cerzytowas 1 0 3
8 7106 144 Cenzyrowan 1 0 3
9 7107 *153 CenAsytoLan 1 0 3
10 7011 16 Cenzyrowan 1 0 2
4| n }
[ oK ] [ Cancel

Fig. 141. Setup of input parameters

7. The Line template field displays the list of fields, contained in each line of imported
file:

* Name — object’s name;

e Xn, Yn, Zn, where n — integer number, coordinates of the first and subsequent
vertices of the object;

* * —missed field during import.

All objects are saved using the same template. Each line of a file contains the same
number of fields, that equals to number of fields in template. Lines which does not
correspond to the template, are skipped.

In order to setup active template, perform one of the following actions:
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10.

1.

12.

13.

+ drag a field name from the Available fields list to the Preview file table column.
After that the template in the Line template field is changes. In order to cancel
field selection, double click the column of the Preview file table;

» change the template manually in the Line template field. At that column types
in the Preview file table are changed automatically.

The 1} button is used to return to default template Name X Y Z.

The |%] button is used to compare the Line template field with data shown in the
Preview file table.

% The active template corresponds only to lines shown in the Preview file table.

The & button is used to replace specified field names by field values taken from
the first line of the Line template table.

[optional] The Automatically validate template checkbox is set on by default that
allows to select current template automatically. In order to configure the template
for file containing lines with different columns number, set off the Automatically
validate template checkbox and configure the template in the Line template field
manually.

[optional] To specify a line from to start data import, define the value of the Start
import from line parameter.

[optional] To display necessary number of lines in the Preview file table, set the
Preview maximum parameter. Default number of lines is 10.

In the Available fields section select necessary field name and drag it to the table
column. To cancel the selection of the field name double click the column header.

In the Field separators section set on one or multiple checkboxes to specify possible
fields delimiter symbol: comma, space, tab, semicolon or other delimiters. Default
settings are comma and space.

In the Decimal separator section setup the following parameters:
* Point only — to use point only as a decimal separator in coordinates;

* Point or comma — to use both point and comma as a decimal separator in co-
ordinates.

ﬁ If the Field separator is selected as a comma, it is not recommended to specify the
Decimal separator as a comma, since objects with incorrect coordinates will be created
after export operation.

219



PHOTOMOD 8.1 General information about the system (Windows x64)

14. In the Misc section set the following checkboxes:

* UTF-8 - is used to recognize text in Unicode coding;

Unicode — symbols encoding format that allows to provide symbols of almost all written
languages.

* Parse °’’ —is used to recognize records of projection centers or GCP.

15. The Preview file table contains data of imported file. Fields type according to the
template, located in the Line template field, are automatically assigned to the table
columns.

@ The * symbols marks columns with data which is not imported.

16. Move to the Conversion tab and set the Convert coordinate system checkbox
on.

( . C5V converter ﬁﬁ

| Files | Input format | Conversion | Cutput format |

Convert coordinate system
Input coordinate system

WGS 84 Latitude-Longitude (Warld EPSG GeogCs code 4327 reserved for use with ProjCs's. ) @

Orientation: left, geo-referencing: global coordinate system

Output coordinate system

WGS 84 Latitude-Longitude (Waorld EPSG GeogCs code 4327 reserved for use with ProjCs's. ) @

Orientation: left, geo-referencing: global coordinate system

oK ] l Cancel

Fig. 142. Choosing of input and output coordinate system
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17. Click the Select.. button in the Input coordinate system section to choose input
CS with one of the following ways:

* From DB - from international or Russian coordinate system database (see’Co-
ordinate systems databases’ in the Project creation’ User Manual);

* From file — allows to select coordinate system from *. x-ref-systenmfiles, located
out of active profile resources;

* From resource — from files with *.x-ref-system extension, located in active
profile resources, for example, to select coordinate system from another project
of active profile.

ﬁ The system also allows to select coordinate system from a list of recently used coordinate
systems.

* From GeoCalculator — from the list of GeoCalculator program database (see
the “Coordinate Systems” chapter in “The GeoCalculator program” User manual).

é The GeoCalculator program allows to edit coordinate systems, to create new ones, to
perform import and export of coordinate systems (see the “The GeoCalculator program”
User Manual).

18. [optional] When choosing coordinate system from database the Coordinate system
database opens, which contains the list of coordinate systems. To perform fast
search for coordinate system in the list, input the whole coordinate system name
or its part to the Find input filed.

. Coordinate systems database Internaticnal @
Find (]

S MName Mote i

1 AGDE6 f AMG zone 48 Australia - 102deg East to 108deg East. EP5G

2 AGDEE / AMG zone 49 Australia - 108deq East to 114deg East. EP5G

3 AGDES / AMG zone 50 Australia - 114deg East to 120deg East. EP5G

4 AGDEE / AMG zone 51 Australia - 120deq East to 126deg East. EP5G

5 AGDES / AMG zone 52 Australia - 126deg East to 132deg East. EP5G

6 AGDEE / AMG zone 53 Australia - 132deq East to 138deg East. EP5G

7 AGDES / AMG zone 54 Australia - 138deg East to 144deg East. Papua Mew Guinea...

g AGDE6 f AMG zone 55 Australia - 144deq East to 150deg East. Papua New Guinea...

9 AGDEE / AMG zone 56 Australia - 150deq East to 156deg East. EPSG

10 AGDG6 / AMG zone 57 Australia - 156deg East to 162deg East. EP5G

11 AGDE6 / AMG zone 58 Australia - 162deq East to 168deg East. EP5G

12 AGDE6 Australia; Papua Mew Guinea EPSG a

[ OK l | Cancel

Fig. 143. Coordinate systems database window
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19. [optional] To choose geoid, click the @ button. Select proper type of geoid usage:

* No geoid;

+ EGM 96.

iy
iy

The system allows to use the EGM2008 geoid. See installation instruction in the User
Manual. After installation the geoid is displayed in the list.

PHOTOMOD GeoCalculator provides for creating a user height system (geoid) with
preset parameters. PHOTOMOD system allows to use previously created custom ver-
tical datum (geoid). See instructions in the “Creating custom height system” chapter of
“The GeoCalculator program” User Manual.

20. Click the Select button in the Output coordinate system section and define
parameters of output CS in the same way.

21. Move to the Output format tab and set parameters of output file.

i ™
. CSV converter Iﬁ
| Files I Input format Conversion | Output format |
Line template
Mame, X, Y,Z -
[ First line with field names
Available fields 5 Used fields
X Mame
»
Y X
z < oy
Mame < |Z
Omega ;I:I-.
Phi
Kappa &
Decimal separataor Enclose in quotes Field separataor
@ Point 1 Auto @ Comma (O Tabulation
(7) Comma @ Al text fields (© space (O Semicolon
() Al fields ) Other
oK ] [ Cancel

Fig. 144. Setup of output parameters
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22.

23.

24.

25.

26.

27.

28.

29.

30.

The Line template field displays the list of fields, contained in each line of imported
file: To clear the field, click the flf button.

[optional] In order to export a line from the Line template field, set the First line
with field names checkbox on.

[optional] In order to change number of decimal places in coordinates to be exported,
set the Maximum decimal places: checkbox on and input needed value.

In the Available fields list select required field name and click the Add selected
field button = or click the Add all fields button ==, to transfer all field names. After
that all or selected field names are moved to the Used fields list.

@ To cancel field name selection click the Delete selected field button < or click the Delete
all fields button == button to cancel moving all field names. To move selected field to the
list bottom, click the dk button, and to move selected field to the list top click the 4 button.

In the Decimal separator section select point or comma to be used to separate
coordinates.

[optional] In order to limit required parts of exported list of coordinates by quotes,
in the Enclose in quotes section choose one of the following options:

» Auto — allows to limit by quotes the fields, which are located in the file to be ex-
ported;

+ All text fields — allows to limit by quotes only the fields, which contain text inform-
ation;

+ All fields — allows to limit by quotes each field, which is located in the exported
file.

In the Field separator section choose, what is used to separate fields: comma,
space, tab, semicolon or other delimiters.

c If the field separator is selected as a comma, it is not recommended to specify the decimal
separator as a comma, since objects with incorrect coordinates will be created after
transformation.

Click the Start button. The transformation results are saved to an output file. Click
OK.

Click the Close button to close the CSV converter window.

Perform the following to split one big file to several separate files:

1.

Choose Service » CSV converter. The CSV converter window opens.
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2. To add CSV or TXT files, click the Add button in the Input files section. The Add
files window opens.

3. Chose file with *.csv or *.txt extension. Click the Open button. Data is loaded to
the program.

4. In the Output files section choose Split into parts containing given number of
lines each.

5. Click the _.. |button and choose in the Windows file system a folder for output files.
6. Define the Maximum lines per output file.

7. Click the Start button. Several files with defined number of lines are created. Click
OK.

13.6. Hotkeys and custom menus

The system allows to use default hotkeys to apply system functions (including the custom
menus). The system also allows to edit (or create) hotkeys and their custom combina-
tions. The list of hotkeys available in the system by default is described in the “Hotkeys”
User Manual.

Custom menus are customizable drop-down menus displayed in separate panels, called
by hotkeys or their combinations. Commands located in the user menu can also be run
using a hotkey.

For example, the (Ctrl+O, D) explanation for the Load DEM... (Ctrl+O, D) menu item
(see Terrain » DEM) means that to go to the Open DEM command, you need to take
two actions:

1. Using the Ctrl+O hotkey combination, open the user menu, which contains com-
mands for loading layers of various types:
30 window

Load DEM

Load grid
Load LAS
% Load TIN

4
il  Load georeferenced images from resources
&

=" Load vectors

2. Use the D hotkey to choose the Open DEM command.

The system provides two user menus by default
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» A user menu that groups commands for loading various types of layers (Ctrl+O, see
above);

+ Auser menu that groups commands for creating new layers of various types (Ctrl+N):
Create contours from TIN
Create DEM from TIN
Create grid layer
t-f:-, Create TIM from peints and breaklines
Create vector layer

Create vector layer with classifier

QA The user-friendly system allows you to use together with hotkeys so called shortcut commands,
the custom button combinations for quick access to various functions when working with the
layers such as Vectors, DEM, Raster, Grid, or TIN.

These buttons are placed in the right part of the 2D-window toolbar and available for a user
when a layer of one of the abovementioned types is downloaded and editable (.#). Shortcut
commands have functionality similar to hotkeys’ and can be also customized.

It is possible to save the settings of hot keys and user menus as files with *.xml exten-
sion:

» To save the current settings, click Save;

» To import the previously saved hotkey configuration and / or user menu settings, click
Open.

13.6.1. Hotkeys management
In order to create or hotkeys combination perform the following actions:

1. Choose Service » Customize hotkeys. The Customize hotkeys window opens.
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. Customize hotkeys

==

Hot keys Custom menus

Commands All assigned hotkeys
Hotkeys Command &
PR P 2 20 multi-snapping |E|
* Project = ) )
4 Block » 3 30 multi-snapping
Add 5tr|p_ I 4 Snap to points
Delete strip
Strip properties B 5 Snap to midpoints
Invert strips order
Selected strips to block start 6 Snap to lines
Selected strips to block end _
Move selected strips up L Snap to coordinates
Mowve selected str.lps.du:uwn 8 Perpendicular snap
Make selected strips irregular
Make selected strips regular « Select previous line vertex
Add images from files
Add images from resources = Select next line vertex
Add images from resource folder =
A Orthomode
Command: Delete strip
HD'H(E'?'S .:Ij.l. m i | i, PN [T SPE USRI JEP——— r
Delete [] sort by command names
COpen ] [ Save ] [F‘.euert to default] (4 ] [ Cancel

Fig. 145. The Customize hotkeys window

The Hotkeys tab of the Customize hotkeys window is divided in two sections:

* In Commands section, the list of system menu items with their hotkeys is dis-

played;
<

The list of system menu entries in the Commands section can vary depending on the

program’s features or program module (see PHOTOMOD GeoMosaic program).

7

The

The structure of the command directory duplicates the structure of the system menu.
icon on the left marks either the menus themselves and their nested subsections

or commands that have already been assigned hotkeys.

To display the hotkeys assigned to the corresponding command, click this icon (see the

illustration above).

« The All assigned hotkeys section displays a table with all existing hotkeys in
one column and command names in another.
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@ The table is sorted by Hotkeys names by default. To sort by command names — set
the appropriate checkbox.

2. The hotkeys editing (or creation) is performed in the Commands section. Find the
command without assigned hotkeys and select it using the left mouse button. The
command name (and, optionally, hotkey name) are displayed near the Command:
label.

@ A search field (@#h) is provided to search both the hotkeys combinations names or the
commands names.

3. Press key or key combination to assign them chosen command. The key (shortcut)
is displayed in Hotkeys field.

@ Up to three modifiers could be used in a shortcut at the same time: Ctrl, Alt, Shift.

4. Click the Add button to add the shortcut.

% There are more than one shortcuts could be assigned to command.

5. [optional] If such a key (key combination) is already used somewhere, the following
dialog box opens:

i . Question L&J1

{ - ) Ctrl+Alt+R is already assigned to Report on relative orientation
' Reassign the hotkeys?

Yes ] | Mo

Fig. 146. The dialog box
To reassign hotkeys, click Yes.
6. Click OK. Restart all opened modules of the system to apply changes.

The system allows you to edit not only commands, but also the assigned hotkeys. To
do this, select the hotkey combination itself, instead of the relevant command.

To delete the selected hotkey combination, click Delete. To change a hotkey combina-
tion, click Replace (first specify new hotkeys in the Hotkeys field).
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13.6.2. Custom menus management

Perform the following actions to create a new custom menu:

1.

Choose Service » Customize hotkeys. The Customize hotkeys window opens.
Open the Custom menus tab.

s '
. Customize hotkeys &J
Hot keys Custom menus

Menus Commands

4 | Create new menu 4 >
» Ctrl+ N * Project =
= Ctrl+ 0 » Block =
» Onentation =
» Grid =
> Terrain »
» Vectors »
» Rasters »
» Edit =
> Service »
> Windows >
* Help »
Exit

Create new menu

Hotkeys
Cpen ] [ Save l [F‘.euertto defﬁult] [ QK ] [ Cancel

Fig. 147. The Customize hotkeys window, Custom menus tab
The Custom menus tab is divided in two sections:

* The list of custom menus with their hotkeys is displayed in the Menus section;

@ The menu name corresponds to a hotkey (or combination of hotkeys) that is used to
call the menu.

@ Any key or key combination can be used to create a user menu. However, within the

menu itself, the command added to it can be called only by one hotkey corresponding
to a letter of the Latin alphabet (A — Z).

» The list of available system operations is displayed in the Commands section.
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@ The structure of the command directory duplicates the structure of the PHOTOMOD
menu.

2. Inthe Menus section select the Create new menu item by clicking the left mouse
button;
3. Place marker to the Hotkeys field and click left mouse button;

4. Press key or shortcut key to assign them to the new . They are displayed in Hotkeys
field.

@ Up to three modifiers could be used in a shortcut at the same time: Ctrl, Alt, Shift.

5. Click the appropriate button to Add the new custom menu to the list. The empty
custom menu, without . label, is displayed in the Menus section;

6. To add menu items to created custom menu — select the created menu by clicking
the left mouse button. Find and select the needed command in the Commands
section. Click the € button. The command will be assigned to the chosen menu;

When adding a command to the menu, one of the keys corresponding to the letter of the
Latin alphabet is automatically linked to it. The linking is done in the order of addition (the
first added command is linked to the A key, etc.).

7. [optional] To change a key linked to the added menu item, left-click this item. Select
a key (letter) from the drop-down list corresponding to the Second key field. Click
Replace;

8. Repeat 6 and 7 steps to add more menu items to created custom menu;
9. Click OK. Restart all opened modules of the system to apply changes.

The custom menu editing is performed the same way.

Appendix A. Format and path of project files

Each system project is stored in a folder with definite structure for project files.
ﬁ It is not recommended to change system files using standard OS Windows tools. In case of
changes, deleted or added folder, run the automatic recovery storage in the Control Panel
module.

Project folder contains the following files and folders:

» backup folder —is used to store backup files of block scheme, orientation parameters,
adjustment and so on;
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* Cache folder — is used to store cached file of block scheme (*.x-1ini-files);

» Cameras folder — is used to store parameters of project cameras (*.x-cam-files);

o backup folder — is used to store backup files of camera parameters.

» Data folder — is used to store project data:

o backup folder — is used to store backup files of vector objects;

O

O

classifier folder — is used to store files of vector objects classifier (*.x-ct-files);

dem folder — is used to store DEM-files;

& After DEM creation is created the dem_name.x-dem file and the dem_name with the file,

containing the DEM itself, with *.demtif extension. This file is used to read data from it.

When an *.x-den file is deleted, its folder is also automatically deleted. Otherwise, if the
folder is deleted, the *.x-denm file remains in the active profile resources.

‘ In every abovementioned case, deletion of a folder containing a *.demtif file causes the

DEM deletion.

mosaic folder — is used to store orthorectificied files (*.x-mos-files);

[optional] sheets folder — is used to store sheets files of created orthoimages;

* L]

*

x-data-files contains vector objects;

.cx-data-files contains co-editing vector objects;

.X-data.meta-files contains general information about vector layer (e.g., limits);
.X-grid-files contains regular nodes grid;

.X-grid.meta-files contains general information about grid layer;

.X-tin-files contains triangulation irregular network (TIN);

o *,x-tin.meta-files contains general information about triangulation irregular network
(TIN) layer;

* Images folder — is used to store project images (e.g. *.tiff, *.bmp files);

* Locks folder — is used to provide possibility to process project with more than one
operator at the same time (*. Llock-files);
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* ProjOptions folder — is used to store project parameters files: When you create a
project, in the ProjOptions folder is created a PHOTOMOD .COMPUTER _NAME.x-
ini file to store the set of project parameters;

o backup folder — is used to store backup files of project parameters;
» Temp folder — is used to store temporary files;

+ * . x-ref-system file contains data about project coordinate system.

Appendix B. The PHOTOMODS8.VAR configuration folder

At the stage of system first configuration is automatically created the PHOTOMOD®8.VAR
folder. This folder is used to store configuration, temporary and other system files.

Only one PHOTOMODS. VAR folder creates, even for several installed copies of the
system.

é It is not recommended to place the configuration folder in the net, because it leads to slowing
of system’s work.

PHOTOMODS8.VAR folder contains the following files and folders:

» AutoSave folder — is used to store autosaved data (see the “Settings of auto-save”
chapter in “General system’s parameters” User Manual);

» Config folder — is used to store files of general parameters of all profiles;

% It is possible to return to default parameters in case of changing configuration file. To do this,
remove a configuration file in the PHOTOMODS. VAR folder and restart the system. Default
configuration file are copied from the PHOTOMODS8.VAR\Config system files folder.

% Both global settings and settings for the local profile is loaded at startup of the system and

saved when you exit. Local project settings is loaded when loading a project and saved when

project closing. In case of working without projects, settings are stored in the PHOTO-
MOD8.Var\Profiles\[profile_name]\VoidProjOptions.x-ini file.

» Logs folder — is used to store log-files for all profiles;

 Profiles folder — is used to store all parameters for each profile separately. The list
of local and network profiles is also stored in the folder. It is the same list as in the
Control Panel module. Configuration file with resource structure and path to local/net-
work folder is also stored in folder of each profile;

§ New subfolder creates for each profile.
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* Tmp folder — is used to store temporary files;
* UserData folder — is used to store data out of resources system;

 policy.x-ini file — contains general information about configuration parameters (active
profile name, name and path to centralized management folder and so on).

B.1. Log cleanup settings

The PHOTOMODS.VAR folder contains the Logs folder that is intended to store log
files common for all the profiles. To spare the disk space, the function of automatic de-
leting of deprecated activity logs is provided.

é To open the PHOTOMODS8.VAR\Logs folder in Windows explorer, choose Show log folder in
the right-click menu of the System Monitor module (the &3 icon in the Windows system tray).

To specify log cleanup settings do the following:

1. Choose Log cleanup settings in the right-click menu of the System Monitor module
(the & icon in the Windows system tray). The Cleanup log folder window opens:

Cleanup log folder [&J

Auto deanup
Enable check and deanup

(e

23:00:00

Cleanup logs older then 7 5 days
Last deanup: 0000-01-01T00:00:00Z
Status: Stopped
Found log files: ]
Deleted files: ]

Cleanup now ] Stop

MNote: The working deanup process will continue to work
even when the dialog is dosed

| oK | | Cancel |

Fig. B.1. The Cleanup log folder window

2. In order to automatically delete log files routinely, set the Auto cleanup checkbox.
The system allows to enable check and cleanup:

* every day;

+ every certain days (set by the user manually);
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+ every week (a day chosen by the user);
» every month (a date set by the user).

The system also allows to specify reasonable cleanup time. After customizing, the
system will cleanup logs older than the user-specified number of days.

In the window, user can see also the last cleanup date and current status of the
cleanup process. To stop a process that is running, click the Stop button. For an
unscheduled start of the log cleanup process, that was previously stopped, click
the Cleanup now button.

c If user close the Cleanup log folder window when cleanup process is running, without

stopping it, the cleanup process will continue to work even when the dialog is closed.

To confirm the settings and the log folder cleanup schedule, as well as to close the
Cleanup log folder window, click OK.

Appendix C. Network pre-configuration for connecting nodes
to the server

& This operation is required when using distributed task processing using several computers

connected via a local network. It is not required when PHOTOMOD UAS is used on a single
workstation.

& Network pre-configuration for connecting nodes to the server is described for the Windows 7

operation system. For more information, contact the Racurs Company Technical Support service.

C.1. Requirements to connection with permission for remote start
of applications

In order to connect nodes to the server in case of required remote start of applications
on the nodes, make the following pre-configurations:

Allow remote access to WMI on each client participating in distributed processing;

Set permissions to access COM applications on each client participating in distributed
processing;

Set permissions for folder archiving and recovery on each client participating in dis-

tributed processing;

It is recommended to disable Firewall on all clients.

g Firewall is a software to protect computers from network attacks.
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» Assign a unique network name to each client (including a local one) (the computer’s
network name is displayed in Control panel » System > Computer name);

Configure shared access to the PHOTOMODS. Var configuration folder;

é It is strongly recommended to place the PHOTOMODS. Var into the network share.

C.2. Allow remote access to WMI

To allow remote access to WMI, perform the following:

‘A WMI (Windows Management Instrumentation) is the technology for centralized control of Win-

dows-based infrastructure. WMI is installed on all computers with Microsoft operation systems
(Windows 2000, Windows XP, Windows 2003, Windows Vista, and Windows 8.1).

1. Inthe Start menu, right click the Computer icon and select Manage. The Computer

management window opens.

A Computer Management

File Action View Help

= |E = HE

A Computer Management (Local| plame
i B
4 [} System Tools 71 System Tools
@ Task Scheduler

=3 Storage -
> @ Event Viewer ‘:J‘ g o More Actions
T Services and Applications

Actions
Computer Management (L., &

> g2 Shared Folders
- &/ Local Users and Groups,
3 "’57' Performance
iy Device Manager
=3 Storage
= Disk Management
=4 Services and Applications

Fig. C.1. The “Computer management” window

In the folder tree in the left part of the window, select Services and Applications »
WMI Control.
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"
A Computer Management

File Action View Help

= 5B BE

A Computer Management (Local
4 [rj Systemn Tools
[ ® Task Scheduler
» @] Event Viewer
» | Shared Folders
> ,k,- Local Users and Groups
» (8 Performance
= Device Manager
4 23 Storage
= Disk Management
4 :d:?; Services and Applications
%% Services
5 WMI Control

it Instr ion (WMI)

Configures and controls the Windows Management Instrumentation (WMI) service,

WMI Contral -

More Actions

Fig. C.2. The “WMI Control” menu item

The WMI Control Properties window opens.

3. Right clicking the WMI Control open the context menu and choose Properties.
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General | Backup/Restore | Securty | Advanced 1

> Thiz dialog allows you to get general information about the

55 computer.

\Successfully Connected to: <local computers

Processor : Intel(R) Core{TM) i7-4820K CPU @ 3.70GHz
Operating System : Microsoft Windows 7 Utimate

05 Version : 6.1.7601

\Service Pack : 1.0

WM Version : 7601.17514

WMl location : C\Windows'system32'wbem

[ ok [ cancel || ol

Fig. C.3. General computer information

4. Proceed to the Security tab.

| General I Backup./Restore | Security |M\ranced

MNamespace navigation allows you to set namespace specific security.
@)1 Root

Fig. C.4. The Security tab of the WMI Control Properties window

5. Click the + button against the Root folder, then click the CIMV2 folder.
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|Gene|a| | Backup."F{estore| Security |Mvanced

Mamespace navigation allows you to set namespace specific securty.

=41 Root o
Ll'—l aspnet
i
Ll'—' Cli
E-| ) DEFAULT
UJ directory
F-10 IntelNCS2
u_l Irrtemp
UJ Microsoft
#-1) MSAPPS12
L)) nap
u_| Palicy
®-1J) RSOP
E-[J) SECURITY T
L‘I_| SecurityCenter
Lll_| SecurityCenter?

110 SenvieeMadel

m

Security

[ ok [ cancel || ol

Fig. C.5. Chosen CIMV2 folder

6. Click the Security button. The Security for ROOT\CIMV2 window opens.

Security

I:3I'(JLI|:J Or user names:
S LOCAL SERVICE
S*J NETWORK SERVICE
-SLAnMuHucmampbl (student-3\AamrHicTpaTope)

’ Add... ” Remaowve ]

Pemizsions for Mpoweawie
MpOBEpKY Allowy

Execute Methods

Full Write 0
Partial Write 0
Provider Write

Enable Account

For special permissions or advanced settings,
click Advanced. Advanced

Leam about access cortrol and permissions

Lm. | »

ODoooo|f

[ OK ” Cancel ] Aoply

Fig. C.6. The Security for ROOT\CIMV2 window

7. In the Group or user names section, click the Add button. The Select Users,
Computers, Service accounts, or Groups window opens.
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Select this object type:

Users, Groups, or Builtin security principals

From this location:

racurs local Locations. ..

Enter the object names to select (examples):

Check Names

Fig. C.7. The user selection window

8. Inthe Enter the object names to select input field, enter the username on whose
behalf the clients will start (this user is to be entered in PHOTOMOD Remote Starter
Tool, in the Edit keyring window, the Keyring column).

Q‘ Entering usernames, use one of the following templates:

* EnteredName (example: First name Surname);

ObjectName (example: Computerl);

* UserName (example: Userl);

ObjectName@omainName (example: Userl@omainl);

ObjectName\DomainName (example: Domainl\Userl).

Select this object type:

Users, Groups, or Builtin security principals

From this location:

racurs local Locations. ..

Enter the object names to select (examples):

racursphotomod Check Names

ok ) (G )

Fig. C.8. Entering a new user name

9. Click OK. The new user is to be displayed in the Group or user names section.
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Security for ROOTVCIM

Securty

GI‘OLID ar User Names:

52 Mpowenume nposeprcy

52, LOCAL SERVICE

.‘33" NETWORK SERVICE

3,, Photormod {photomod @racurs local)
-';'JAUJ'-‘IHHHCTDETOFII:I (TP-Goneman \ AQMUHMC TR TOPE!)

l Add... H Remove ]

Pemissions for
ADMUHWCTPETOPEI Allow Dery

Execute Methods

Full Write

Partial Write

Pravider Write

Enable Account i

For special pemmissions or advanced settings,
click Advanced.

Leam about access control and pemissions

[ ok ][ camcel | = 2cply

Fig. C.9. A new users is displayed in the “Groups and users” section

10. Select the new user in the Group or user names section. In the Permission for
<new user> section against all the options from the list, set Allow checkboxes.

ﬁ It is strongly encouraged to set the Allow checkbox for the Remote Enable option. Other-
wise remote access to WMI is impossible.
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sty forrooncinZ S e

Security

Group or user names;

S!‘ Mpoweoume nposepicy

BJJ LOCAL SERVICE

2 NETWORK SERVICE

1 Photomod {photomod @racurs local)
.S!‘ADMHHHCTpEITOpr (TP-Goneman \ AgMUHUCTRa TopE!)

’ Add... ] [ Remove ]
Pemissions for
ALMUHWCTPETOPEI Alow Dery
Enable Account 0 i
Remote Enable 0
Read Security A L
Edit Security B (5

1

Special permissions
For special permissions or advanced settings, m
click Advanced. van

Leam about access control and pemissions

[ ok ][ cancel || ool

Fig. C.10. Allowances for a new user

11. Click the Advanced button. The Additional security parameters for CIMV2 window
opens.

Fermissions | Auditing | Ohwiner

To view or edit details for a pemission entry, select the entry and then click Edit.

Pemission entries:

Type MName Permission Inherted From Apply To

Allow ApuHucTpaTopel (stude...  Special Parent Cbject This namespace and sub...
Allow NETWORK SERVICE Special Parent Cbject This namespace and sub...
Allow LOCAL SERVICE Special Parent Cbject This namespace and sub...
Allow Mpoweaume nposepky Special Parent Cbject This namespace and sub...
[ Add... ] [ Edit... Remave

Include inheritable pemissions from this object’s parent

Managing permission entries

[ ok || cancel || fpply

Fig. C.11. Setup of additional security parameters for CIMV2
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12. Doubile click the line with the new user. The Permission Entry for CIMV2 window
opens.

| . Permission Enh'nyTC_ u
Object

This permission is inherited from the parent object. Make changes
here to override the inherited permissions,

Mame: | Elgess An ATODb Change...

Apply to: This namespace and subnamespaces

Permissions: Allow Deny
Execute Methods [}
Full Write [}
Partial Write [}
Provider Write [}
Enable Account [}
Remote Enable [}
Read Security [}
Edit Security [}

Apply these permissions to objects andjor Clear all

containers within this container only

Managing permissions

[ OK ][ Cancel ]

Fig. C.12. Allowance for CIMV2

13. In the Apply to drop-down list, select This namespace and subnamespaces.

| . Permission Enh'nyTC_ u
Object

This permission is inherited from the parent object. Make changes
here to override the inherited permissions,

Mame: | Elgess An ATODb Change...

Apply to: This namespace and subnamespaces

Permissions: Allow Deny
Execute Methods [}
Full Write
Partial Write
Provider Write
Enable Account
Remote Enable
Read Security
Edit Security [}

Apply these permissions to objects andjor Clear all
containers within this container only

Managing permissions

[ OK ][ Cancel ]

Fig. C.13. Allowance element configuration/setup/customization

14. Click OK. This space and name subspace is displayed in the Apply to column.
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Pemmissions | Auditing | Owner

Ta view or edit details for a pemission entry, select the entry and then click Edit.

Permission entries:

Type Name Permission Inherted From Apply To

Allow ApgravHucTpatopel (stude..  Special Parent Object This namespace and sub...

Allow NETWORK SERVICE Special Parent Object This namespace and sub...

Allow LOCAL SERVICE Special Parent Object This namespace and sub...

Allow MMpoweaume npoBepiy Special Parent Object This namespace and sub...
’ Add... ] ’ Edit.... Remove

Include inhertable permissions from this object’s parent

Managing permission entries

’ oK ] [ Cancel Apply

Fig. C.14. Applying allowance settings

15. In the Additional security parameters for CIMV2 window, click the Apply button
and then OK.

16. In the ROOT\CIMV2 security window, click the Apply button and then OK.

17. In the Properties: WMI Control window, click OK. Remote access to WMI is con-
figured.

C.3. Permission for remote access to COM applications

Permission for remote access to COM applications allows you to connect, start pro-
cesses, and run tasks non-stop.

é To configure remote access to COM applications, you need to have admimistrator’s rights.

To allow remote access to COM applications, perform the following:

QA COM (Component Object Model) is a binary-interface standard for software components by
Microsoft. It is used to enable inter-process communication object creation in a large range of
programming languages.

1. Enter dcomcnfg in the search field of the Start menu and press Enter. The Com-
ponent services window opens.
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. File Action View Window Help

&= B ECHE LDIE

[Z1 Consele Root - Actions
> |+ Component Services J
s @ Event Viewer (Local) Computers
» G4 Services (Local)

Compenent Services
More Actions

Fig. C.15. The Component services window

2. Inthe folder tree, select Component services » Computers. In the central window
area the My computer icon appears.
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: 3
i Component Services EIM
%. File Action View Window Help - [
5| B XE cBE LIESE
[Z1 Console Root . L Actions

Py Cpmponent Services Lo Computers -
> || Computers My .
> @ Event Viewer (Local) Computer Moare Actions ’

» L5 Services (Local)

Fig. C.16. The My computer icon displayed in the Component services window

3. Rightclicking the My computer icon open the context menu and select Properties.

The My Computer Properties window opens.
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r bl
My Computer Properties @lﬂ

[ Defaut Protocols I COM Security [ MSDTC
General | Options I Default Properties ‘

yAy Name: STUDENTS

Description:

Leam mare about setting these properties.

Fig. C.17. The My Computer Properties window

4. Open the COM Security tab.

General Options Default Properties
Default Protocols COM Securty M3DTC

Access Pemmissions

You may edit who is allowed default access to applications. You may
also set limits on applications that determine their own permissions.

Caution: Modifying access permissions can affect the ability
of applications to start, connect, function and./or un
securely.

[ Edtlmts.. | [ EdiDefaut.. |

Launch and Activation Permissions
You may edit who is allowed by defautt to launch applications or
activate objects. You may also set imits on applications that
detemine their own permissions.

Caution: Modifying launch and activation permissions can
affect the abilty of applications to start, connect, function
and.or run securely.

[ Edtums. | [ Edi Defaut..

Leam more about setting these properties.

Fig. C.18. COM Security setup
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In the Access permissions section, click the Edit limits button. The Access

5.
permissions window opens.
'Access Permission - - M‘
Security Limits
Group or user names:
52, Bes
.!-"RJ MonesoEaTeny XypHanos NpoWssoaMTENEHOCTH (student-...
.!-"RJ Monezosatenn DCOM (student-3\Monesosatenn DCOM)
QlaHoHRe O |
Add... ] [ Remave ]
Permissions for AHOHWMHGIA
BXOO Alow Dery
Local Access [} [}
Remote Access [} [}
Leam about access control and permissions
[ ok ][ canca |
Fig. C.19. The Access permissions window
6. Inthe Groups and user names section, click ANONYMOUS ACCESS.
7. Inthe Permissions for ANONYMOUS ACCESS group section, set Allow check-

boxes against Local access and Remote access options.

Access Permission

Security Limits
Group or user names:
52, Bes
.!-"RJ MonesoEaTeny XypHanos NpoWssoaMTENEHOCTH (student-...
.!-"RJ Monezosatenn DCOM (student-3\Monesosatenn DCOM)

F! A AHOHWMHEIN BXD0,

Add... ] [ Remave ]
Permissions for AHOHWMHGIA
BXOO Alow Dery
Local Access [}
O

Remote Access

Leam about access control and permissions

[ ok ][ canca |

4

Fig. C.20. Local and remote access allowances
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8. Click OK.

9. Inthe COM security tab in the Launch and activation permissions, click the Edit
limits button. The Launch and activation permission window opens.

r hl
Launch and Activation Permission @Iﬂ
Securty Limits

Group or user names:
-'-;"JAUMMHHCTDETDDI:I (student-$"AgrnHucTpaTope)

5{ Monbs0BaTENM XyPHANOE NPOMSE0 BMTENEHOCTY (student-...
Q?J MNonezosatenn DCOM (student-3MNonssosatenn DCOM)

[ Add... ] [ Remove ]
Pemissions for Bce Allow Deny
Local Launch 0
Remote Launch 0 0
Local Activation ]
Remote Activation 0 0

Leam about access control and permissions
|

I [ ok J[Cancel]l

Fig. C.21. Start and activation allowance

10. Click the Add button. The Select: Users, Computers, Service accounts, or
Groups window opens.

’ée!ect Users, Com
Select this object type:
Users, Groups, or Builtin security principals
From this location:

Enter the object names to select (examples):

Check Names

Fig. C.22. User selection window

11. In the Enter the object names input field, enter the username for whom remote
access to WMI was previously allowed.
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Q Entering usernames, use one of the following templates:

* EnteredName (example: First name Surname);

ObjectName (example: Computerl);

* UserName (example: Userl);

ObjectName@omainName (example: Userl@omainl);

ObjectName\DomainName (example: Domainl\Userl).

J—
Select Users, Compute : = Accounts, or Group

Select this object type:

Users, Groups, or Builtin security principals

From this location:

racurs local Locations. ..

Enter the object names to select (examples):

racursphotomod Check Names

==

Fig. C.23. Username example

12. Click OK.

13. In the Allowances for the Photomod group, set Allow checkboxes against all
the options from the list.

14. Click OK.

15. In the Properties: My computer window, COM Security tab, click the Apply button.
The access to COM applications is configured.

C.4. Permission for data archiving
To set permission for data archiving, perform the following:

1. Enter local security policy in the Start menu search field and press Enter. The
Local security policy window opens.
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File Action View Help
= E X

i’. Security Settings MName Description
> [ Account Policies

= o :g)\ccount Policies Password and account lockout pelicies
> g Local Policies

| Windows Firewall with Advanced Sec
“| Metwork List Manager Policies
Public Key Policies

‘& Local Policies Auditing, user rights and security options pelici...
| Windows Firewall with Advanced Security  Windows Firewall with Advanced Security

“| Metwork List Manager Policies Network name, icon and location group policies,
Software Restriction Policies fPUbllc Key Pol?m.es o

| Application Control Policies _| Software Restriction Policies

. g 1P Security Policies on Local Compute | Application Control Policies Application Control Policies
. [ Advanced Audit Policy Configuration @ IP Security Policies on Local Computer Internet Protocel Security (IPsec) Administratio...

-
-

| Advanced Audit Policy Configuration Advanced Audit Policy Configuration

Fig. C.24. Local security policy

2. In the left part of the window in the folder tree, select Security settings > Local
policies > User rights assignment.
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File
ol AR

Actien  View Help

X = H=

=5 Security Settings
B ty Setting

>

4

o

4 Account Policies

4 Local Policies

>[4 Audit Policy

> |4 User Rights Assignment

>[4 Security Options

| Windows Firewall with Advanced Seci
| Metwork List Manager Policies

| Public Key Policies

| Software Restriction Policies

| Application Control Policies

> ‘g IP Security Policies on Local Compute

>

| Advanced Audit Policy Cenfiguration

4

[Tl | 3

Policy

[ Access Credential Manager as a trusted caller
12| Access this computer from the network

[ Act as part of the operating system

L) Add workstations to domain

L) Adjust memory quotas for a process

Lzio| Allow log on lecally

12| Allow log on through Remote Desktop Services
l:is) Back up files and directories

1212 Bypass traverse checking

Lz Change the system time

liz| Change the time zone

[ Create a pagefile

lzio| Create a token object

L) Create global ebjects

lzio| Create permanent shared objects

lzie| Create symbelic links

L) Debug programs

12| Deny access to this computer from the network
liis) Deny log on as a batch job

lziz| Deny log on as a service

L) Deny log on locally

12| Deny log on through Remote Desktop Services

Fnahle comnuter and ncer accounts tn he trusted for delena..

Security Setting

Boe, AgMmuHucTpatopel,...

LOCAL SERVICE,MNETWO...
locTh, ASMUHNCTRETOP L.,
AgpuHnctpatopel, MNoenk..,
Agrannuctpatopel, Onep...
Bee, LOCAL SERVICE,NE...
LOCAL SERVICE, AamnH..,
LOCAL SERVICE, AgpwH...

AaruHUCTpaTopsl

LOCAL SERVICE,MNETWO...

AgpnHuCTpaTepEl
AgMUHUCTPaTOPBI
locTe

locTe

»

m

Fig. C.25. Assignment of user rights

3. Right click Back up files and directories and select Properties. The Back up
files and directories Properties window opens.
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Local Security Setting | Explain

Back up files and directories

ApMUHWCTPETOREI
CnepaTopkl apamea

Add User or Group... Remove

[ ok ][ canced ][ aeply

Fig. C.26. File and folder archiving access right setup

4. Click the Add user or group button. The Select: Users, Computers, Service
accounts, or Groups window opens.

Select this object type:

Users, Groups, or Builtin security principals

From thig location:

Enter the object names to select (examples):

Check Names

Fig. C.27. The user selection window

5. Inthe Enter the object names input field, enter the username for whom you want
to set permission to archive data.
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Select this object type:

Users, Groups, or Builtin security principals

From this location:

racurs local Locations. ..

Enter the object names to select (examples):

racurs“photomod Check Mames

) (o)

Fig. C.28. Username example

6. Click OK.

Back up files and di i
Local Security Setting | Explain

Back up files and directories

= L

AgMUHWCTPETOPEI
CnepaTopkl apamea
racursphotomod

Add User or Group... Remove

[ ok ][ canea ][ apply

Fig. C.29. Photomod user access to file and folder archiving

7. Click OK. Access to file and folder archiving is allowed to the selected user.

8. Inthe Local security policy window, right click Restore files and directories and
select Properties. The Restore files and directories Properties window opens.
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r hl
Restore files and directories Properties M
Local Security Setting | Explain

Restore files and directories

EI:A%

kg

AgMuHuCTpaTopel
Onepatopbl apx1ea

Add User or Group... Remove

[ ok ][ cancel || 2epk

ol

L

Fig. C.30. Access rights to file and folder recovery

9. Click the Add user or group button. The Select: Users, Computers, Service
accounts, or Groups window opens.

Select this object type:

Users, Groups, or Builtin security principals Object Types...
From this location:

Enter the object names to select (examples):

Check Names

Fig. C.31. The user selection window

10. In the Enter the object names input field, enter the username for whom you want
to set permission to recover files and folders.
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Select this object type:

Users, Groups, or Builtin security principals

From this location:

racurs local Locations. ..

Enter the object names to select (examples):

racurs“photomod Check Mames

) (o)

Fig. C.32. Username example

11. Click OK.

Ceoitctea: Bocar bait %] 0B g @g

>N

MapameTp nokaneHoi GesonacHocT™ | D bACHeHWE |

BoccTaHoBneHWe ©ainos 1 KaTanoros

=R>

RACURS \photomod
AgMUHWCTDETOPLI
OnepaTopsl apsvea

[ [pfiaenTs NoNLS0BATENA MK FRYTNY... J Yoanus

] [ CmeHa ] [ MprreHnTe ]

Fig. C.33. Photomod user access to file and folder recovery

12. Click OK. Access to file and folder recovery is allowed to the selected user.

13. In the Local security policy window, right click Replace a process level token

and select Properties. The Replace a process level token Properties window
opens.
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Replace a process level token Properties ?

Local Security Setting | Explain

Replace a process level token

E\:&#

LOCAL SERVICE
NETWORK SERVICE

Add User or Group... ] [ Remove

[ ok ][ Cancel || 2epk

Fig. C.34. Replace a process level token

14. Click the Add user or group button. The Select: Users, Computers, Service
accounts, or Groups window opens.

Select this object type:

Users, Groups, or Builtin security principals

From this location:

racurs local Locations. ..

Enter the object names to select (examples):

Check Names

Fig. C.35. The user selection window

15. In the Enter the object names input field, enter the username for whom you want
to set permission to recover files and folders.
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Select this object type:

Users, Groups, or Builtin security principals

From this location:

racurs local Locations. ..

Enter the object names to select (examples):

racurs“photomod Check Mames

) (o)

Fig. C.36. Username example

16. Click OK.

Replace a process level token Properties ? B

Local Security Setting | Explain

} Replace a process level token
E | 4

LOCAL SERVICE
NETWORK SERVICE
racurs'photomod

Add User or Group... ] [ Remove

[ ok ][ Cancel || ook

Fig. C.37. Setting up access rights to launch remote processes

17. Click OK. Upon doing that, the selected user is given permission to start remote
processes.

C.5. Shared access setup

To setup shared access to a folder, perform the following:
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1. Right click the folder for which you want to setup shared access, open the context
menu, and select Properties. The Properties: PHOTOMODS8.Var window opens.

| | PHOTOMODG HPC.Var

General |Sharing I Security I Previous Versions | Customize

] PHOTOMODE HPC Var
Type: File folder { Var)
Location: Ch I
Size: 522 KB (544 884 bytes)

Size on disk: 1,12 MB (1 175 552 bytes)
Cortains: 111 Files, 17 Folders

Created: 31 pHeapn 2018 r., 5:55:06

Atributes: | Read-anly (Only applies to files in folder)

[ ok ][ cancel || pply

Fig. C.38. General tab

2. Go to the Access tab.

[ | PHOTOMODG HPCVa

| General | Sharing |Security I Previous Versions | Customize

Metwork File and Folder Sharing

PHOTOMODE HPC Var
Mot Shared

Network Path:
Mot Shared I

Advanced Sharing

Set custom permissions, create multiple shares, and set other
advanced sharing options.

I&J:\d\ranced Sharing...

[ ok ][ cancel || pply

Fig. C.39. Access to shared files and folders
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3. Inthe Advanced shared access setup section, click the Advanced setup button.
The Advanced shared access setup window opens.

Advanced Sharin

[ Share this folder

Settings

Share name:

Add Remove

Limnit the number of simultansous users bo:

Comments:

Permissions Caching

[ 0K J’ Cancel ] Apply

Fig. C.40. Shared access setup

4. Set the Open shared access to this folder checkbox.

Advanced Sharin

Share this folder
Settings

Share name:

PHCOTOMODS HPC. Var

Add Remove
Limit the number of simultanecus users to: 20 =
Comments:
Permissions ] ’ Caching l
[ QK ] ’ Cancel ] ’ Apply l
&

Fig. C.41. Open shared access to this folder

5. Click the Apply button.
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Share this folder

Settings
Share name:

PHOTOMODS HPC. Var

Add Remove
Limit the number of simultanecus users to: 20 =
Comments:
Permissions ] ’ Caching l
[ QK ] ’ Cancel ] ’ Apply l

Fig. C.42. Applying shared access to a folder

6. Delete spaces in the folder name in the Shared resource name input field.

7. Click OK. Shared access is configured.

{ | PHOTOMODG HPC.Vz

| General | Sharing |Sec|.|n'ty I Previous Versions I Customize

Metwork: File and Folder Sharing
PHOTOMODE HPC Var
Shared

Network Path:
‘WSTUDENT-9WPHOTOMODE HPC Mar I

Advanced Sharing
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Fig. C.43. Saving shared access configuration
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